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1	 Benvenuti
Grazie per aver scelto TRAKTOR!

In quanto proprietario legale di questo software stai contribuendo al suo sostenime to ed 
alla creazione di futuri aggiornamenti.

TRAKTOR PRO e TRAKTOR SCRATCH PRO introducono un nuovo livello di usabilità e 
creatività nel mondo del software per DJ. Questo manuale ti indicherà come utilizzare 
TRAKTOR e tutte le sue funzionalità.

Ci auguriamo che ti divertirai ad utilizzare TRAKTOR e che esso potrà stimolare la tua 
creatività come DJ.

Sinceramente vostro,

Il Team NATIVE INSTRUMENTS
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2	 Requisiti di Sistema
Per i requisiti di Sistema e informazioni sulla compatibilità con le ultime versioni dei vari 
sistemi operativi, siete pregati di consultare il nostro sito internet su:

www.native-instruments.com/traktor

http://www.native-instruments.com/traktor
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3	 Installazione
Questo capitolo fornisce una semplice spiegazione passo passo su come installare 
TRAKTOR sul tuo computer.

3.1	 Installazione del Software

3.1.1	 Installazione Windows (XP oppure Vista)
Una volta inserito il CD-ROM di TRAKTOR nel computer, clicca due volte sull'icona "Il mio 
computer" (XP) o "Computer" (Vista) sul tuo desktop, e clicca due volte sull'icona TRAKTOR 
CD per accedere al contenuto del CD.

Ora clicca due volte sul file installer "Traktor Setup.exe". Si aprirà una finestra e 
l'installazione di TRAKTOR avrà inizio.

Il programma di setup ti guiderà attraverso il resto della procedura di installazione. Sei 
pregato di seguire le istruzioni su schermo.

Nota che all'inizio dell'installazione ti verrà chiesto se intendi effettuare una installazi-
one Completa o Custom. Se non sei sicuro riguardo ad alcune opzioni Custom, seleziona 
l'opzione Complete per essere certo che tutti i componenti vengano installati correttamente.

Se intendi utilizzare il dispositivo AUDIO 8 DJ con TRAKTOR, assicurati di selezionare Yes 
quando ti verrà chiesto se intendi installare il driver.

3.1.2	 Installazione Mac OS X
Una volta inserito il CD'ROM nel Computer, sul desktop apparirà l'icona TRAKTOR CD. 
Clicca due volte per accedere al contenuto del CD, poi due volte su "Traktor Installer".

Si aprirà una finestra ed inizierà l'installazione di TRAKTOR. Il programma di setup ti 
guiderà attraverso il resto della procedura di installazione. Sei pregato di seguire le istru-
zioni su schermo.

! 
Sei pregato di fare sempre 
riferimento al file "Readme" 

contenuto nel cd di installazione per 
informazioni dell'ultima ora che potreb-
bero non essere disponibili nel manuale 
stampato.

%
Selezionando l'installazione 
completa, verranno automatica-

mente installati anche i driver per Audio 
8 DJ. Puoi anche deselezionare Audio 8 
DJ scegliendo l'installazione custom.
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3.2	 Installazione del Driver Audio

E' necessario installare il driver per il tuo dispositivo audio prima di utilizzarlo con 
TRAKTOR. Questa sezione spiega come installare in driver per il dispositivo audio NATIVE 
INSTRUMENTS AUDIO 8 DJ.

(Se possiedi una scheda audio prodotta da un altra marca, sei pregato di fare riferimento 
alla sua documentazione per informazioni riguardo l'installazione del driver).

3.2.1	 Installazione Windows

Installazione su Windows Vista
1.	 Una volta che l'installer di TRAKTOR ha terminato l'installazione, connetti AUDIO 8 

DJ ad una porta USB libera sul tuo computer.

2.	 Windows identificherà AUDIO 8 DJ ed inizierà il processo di installazione finale.

3.	 Seleziona "No" se Windows ti chiede di ricercare un driver su Internet.

4.	 Se vedi una finestra dal pannello Controllo Acconto Utente di Vista che dice che 
Windows necessita di un permesso per continuare clicca su "Continua".

5.	 Durante l'installazione apparirà una schermata contenente il messaggio che il driver 
non ha superato il Logo Testing di Windows; ciò non comporta alcun problema, clicca 
semplicemente su "Continua comunque" per procedere con l'installazione.

6.	 Sei pregato di notare che dal momento che verranno installati componenti multipli del 
driver, vedrai l'intera sequenza dell'installer ripetersi due volte: non è un errore, limitati 
a seguire le istruzioni per ultimare l'installazione.

Installazione Windows XP
►► Una volta che l'installer di TRAKTOR ha terminato l'installazione, connetti AUDIO 8 

DJ ad una porta USB libera sul tuo computer.

►► Windows identificherà AUDIO 8 DJ ed inizierà il processo di installazione finale.

►► Seleziona "No" se Windows ti chiede di ricercare un driver su Internet.

! 
Non è possibile installare AUDIO 
8 DJ su di una porta USB 1.1, 

è necessaria una porta USB 2.0.
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►► Durante l'installazione apparirà una schermata contenente il messaggio che il driver 
non ha superato il Logo Testing di Windows; ciò non comporta alcun problema, clicca 
semplicemente su "Continua comunque" per procedere con l'installazione.

►► Sei pregato di notare che dal momento che verranno installati componenti multipli del 
driver, vedrai l'intera sequenza dell'installer ripetersi due volte: non è un errore, limi-
tati a seguire le istruzioni per ultimare l'installazione.

3.2.2	 Installazione Mac OS X
►► Una volta che l'installer di TRAKTOR ha ultimato l'installazione, connetti semplice-

mente AUDIO 8 DJ ad una porta USB libera sul tuo computer e dovrebbe già essere 
pronta all'uso, non è richiesta alcuna installazione.

►► Puoi accertarti che il dispositivo appaia regolarmente all'interno di Preferenze di Sistema. 
Se il driver è installato, dovresti essere in grado di vedere un Pannello delle Preferenze 
"NI USB AUDIO". Aprendo quest'ultimo, nel pannello potrai osservare il tuo dispositivo.

3.3	 Disinstallazione di TRAKTOR

3.3.1	 Windows
Per disinstallare TRAKTOR dal tuo computer con Windows XP, di fai come segue:

►► Vai su Avvio > Pannello di Controllo > Installazione Applicazioni.

►► Trova "Native Instruments Traktor" all'interno della lista.

►► Clicca su "Rimuovi" e segui le istruzioni su schermo.

Per disinstallare TRAKTOR dal tuo computer con Windows Vista, di fai come segue:

►► Vai su Avvio > Pannello di Controllo > Programmi.

►► Trova "Native Instruments Traktor" all'interno della lista.

►► Clicca su "Rimuovi" e segui le istruzioni su schermo.
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3.3.2	 Mac OS X
Per disinstallare TRAKTOR dal tuo Macintosh, puoi semplicemente eliminare i seguenti 
file dal tuo Mac (il simbolo ~ si riferisce al nome della directory del tuo utente):

►► Macintosh HD/Applicazioni/Traktor

►► Macintosh HD/Librerie/Preferenze/com.native-instruments.Traktor Pro.plist

►► Macintosh HD/Utenti/~/Librerie/Preferenze/com.native-instruments.Traktor Pro.plist

►► Macintosh HD/Utenti/~/Musica/Traktor
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4	 Primi passi con TRAKTOR
Questo capitolo ti aiuterà ad iniziare ad usare TRAKTOR, specialmente sei un novizio.

4.1	 Avvio del Software

Windows:
Clicca su "Avvio > Programmi > Native Instruments > Traktor" e clicca sulla icona di  
programma di TRAKTOR.

Mac OS X:
Vai nella cartella Macintosh HD > Applicazioni > Traktor" e lì troverai l'icona del programma 
di TRAKTOR. Clicca due volte l'icona per avviare il programma.
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4.2	 Autorizzazione del Prodotto 

Prima di potere utilizzare TRAKTOR senza alcuna limitazione e' necessario registrarti ed 
attivare il software con il SERVICE CENTER di NATIVE INSTRUMENTS.

Fino a che TRAKTOR non sarà stato attivato, vedrai questa schermata ad ogni suo avvio.

►► Seleziona Run Demo per avviare TRAKTOR in modalità Demo. Puoi controllare se sei 
in modalità Demo dal rispettivo simbolo grafico che rappresenta il Demo Mode 
all'interno dell'Header di TRAKTOR.

►► Clicca su Acquista se stai utilizzando la versione demo di TRAKTOR ed intendi ac-
quistare il software online. Il tuo Browser di Internet si avvierà da solo e ti porterà 
automaticamente allo Shop Online di NATIVE INSTRUMENTS sul nostro sito internet.

►► Scegli Attiva per iniziare la procedura di registrazione ed attivazione usando il NI 
SERVICE CENTER. TRAKTOR si chiuderà automaticamente prima che il SERVICE 
CENTER venga lanciato. Sei pregato di seguire le istruzioni su schermo per regis-
trarti ed attivare il software. Se hai bisogno di aiuto per questa procedura sei pregato 
di consultare la guida a parte "Guida all'installazione" inclusa nel tuo pacchetto di 
TRAKTOR. 
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4.3	 Setup Wizard

Una volta riavviato TRAKTOR n seguito ad un processo di attivazione andato a buon fine 
o durante l'avvio di TRAKTOR in modalità Demo, apparirà il "Setup Wizard". Esso offre 
utili opzioni per la configurazione iniziale di TRAKTOR. 

Il Wizard offre differenti opzioni di setup per gli utenti di TRAKTOR PRO (descritte all'interno 
della sezione 4.3.1 Configurazione di TRAKTOR PRO) e per gli utenti di TRAKTOR 
SCRATCH PRO (descritte all'interno della sezione 4.3.2	 Configurazione di TRAKTOR 
SCRATCH PRO).

►► Avviando TRAKTOR in Modalità Demo, la prima schermata del "Setup Wizard" ti chie-
derà di selezionare la demo di TRAKTOR PRO o di TRAKTOR SCRATCH PRO.

►► Per le copie autorizzate di TRAKTOR la schermata di "Setup Wizard" apparirà solo 
durante il primo avvio di TRAKTOR. Una volta impostato il setup iniziale, il Wizard non 
apparirà più automaticamente.

►► Puoi riavviare il Wizard in ogni momento tramite la voce Help del Menu Applicazione. 
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4.3.1	 Configurazione di TRAKTOR PRO
In seguito alla registrazione del software tramite un numero di serie di TRAKTOR PRO o 
scegliendo la modalità demo di TRAKTOR PRO, il "Setup Wizard" offre le opzioni detta-
gliatamente descritte qui di seguito.

►► Built In Sound Card

►► External Audio Interface

►► External Mixer

TRAKTOR PRO con Scheda Audio Interna
Questa configurazione ti permette di utilizzare TRAKTOR PRO sul tuo computer senza 
il bisogno di alcun hardware aggiuntivo. In ogni caso, sii consapevole che con la scheda 
audio interna non sarà possibile effettuare il preascolto delle tracce.

Configurazione Hardware
1.	 Accertati che gli altoparlanti del tuo computer siano accesi e che il controllo di volume 

del tuo sistema operativo sia impostato su di un valore ragionevole

2.	 Come opzione aggiuntiva puoi connettere le cuffie alla rispettiva uscita del tuo computer.
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Configurazione Software
1.	 Nel "Setup Wizard" seleziona l'opzione Built In Sound Card.

2.	 Conferma la tua selezione premendo il tasto OK. Questa operazione apre la pagina 
Audio Setup delle Preferenze.

	

3.	 Scorri la lista Audio Device e seleziona la tua scheda audio interna. Se stai utilizzando 
un Macintosh, seleziona l'opzione "Ingresso Interno".. 

4.	 Il tuo computer sceglierà un valore di latenza in maniera automatica. Se così non av-
viene, scegli un valore di latenza tra 30 e 50 ms ed una frequenza di campionamento 
di 44100 Hz. 

5.	 Chiudi le Preferenze cliccando il pulsante Close.

TRAKTOR PRO con Dispositivo Audio Esterno.
Per un utilizzo professionale di TRAKTOR PRO è necessario un dispositivo audio esterno 
con almeno due uscite audio stereo. L'uscita stereo aggiuntiva ti permette di effettuare il 
preascolto delle tracce dalle tue cuffie mentre la traccia principale è in riproduzione dalle 
uscite principali del tuo PA. 
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Configurazione Hardware
1.	 Prima di avviare TRAKTOR PRO, accertati che il tuo dispositivo audio esterno sia in-

stallato in maniera corretta, collegato al tuo computer e funzionante.

2.	 Collega le uscite primarie della scheda audio esterna al sistema di amplificazione che 
alimenta i tuoi altoparlanti.

3.	 Collega le tue cuffie alle uscite secondarie della scheda audio esterna. Se stai utiliz-
zando AUDIO DJ 8, si consiglia di collegare le cuffie al jack cuffia e di assicurarsi di 
impostare sul dispositivo il tasto cuffie su OUT 7-8 tramite il pulsante SOURCE situato 
sul pannello frontale.
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Configurazione Software
1.	 Nel "Setup Wizard" seleziona l'opzione External  Audio Interface.

2.	 Conferma la tua selezione premendo il tasto OK. Questa operazione apre la pagina 
Audio Setup delle Preferenze.

	

3.	 Scorri la lista Audio Device per selezionare la scheda audio esterna. 

4.	 Imposta la latenza e la frequenza di campionamento su un valore compatibile con il 
tuo sistema. Per incominciare consigliamo di usare valori di latenza tra i 10-15 ms. In 
seguito potrai provare a ridurre questo valore per migliorare il modo in cui l'applicazione 
risponde, ma ricorda che riducendo questo valore eccessivamente il tuo computer 
potrebbe non essere in grado di gestire il carico di calcoli e potrebbe iniziare a sentirsi 
una distorsione del segnale audio. Se ciò dovesse accadere, devi impostare nuova-
mente un valore un poco più alto. Per incominciare dovresti impostare la frequenza 
di campionamento su 44100 Hz.

5.	 Apri la pagina Output Routing per assegnare le uscite di TRAKTOR PRO alle uscite 
fisiche della tua scheda audio.

	



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 17  

6.	 Verifica che la modalità Internal Mixer Mode sia selezionata.

7.	 Se non accade automaticamente, assegna le uscite Monitor alle uscite secondarie 
della scheda audio esterna collegata alle cuffie e le uscite Master alle uscite principali 
della scheda audio esterna collegata al sistema di amplificazione. In questo esempio, 
abbiamo impostato le uscite monitor su 7-8 così da poter ascoltare in cuffia l'uscita 
dell'AUDIO DJ 8.

8.	 Chiudi le Preferenze cliccando il pulsante Close.

TRAKTOR PRO con Mixer Esterno
Per utilizzare TRAKTOR PRO con un mixer esterno, hai bisogno di una scheda audio es-
terna provvista di almeno due uscite audio stereo. Per mixare con quattro deck è richiesta 
una interfaccia audio dotata di 4 uscite stereo come ad esempio AUDIO 8 DJ.

In questo modo, l'uscita di ognuno dei deck di TRAKTOR viene assegnata ad una uscita 
separata della scheda audio esterna, ognuna delle quali è collegata ad un diverso canale 
in ingresso del mixer. Il mixaggio ed il preascolto in questa configurazione vengono effet-
tuati interamente tramite mixer.
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Configurazione Hardware
1.	 Prima di avviare TRAKTOR PRO, accertati che il tuo dispositivo audio esterno sia in-

stallato in maniera corretta, collegato al tuo computer e funzionante.

2.	 Collega le uscite della tua scheda audio esterna agli ingressi del mixer. Ogni uscita 
stereo dell'interfaccia audio esterna viene collegata ad un ingresso stereo del mixer.

3.	 Collega le tue cuffie al mixer e le uscite del mixer all'amplificatore collegato alle tue casse.

	

Configurazione Software
1.	 Nel "Setup Wizard" seleziona l'opzione External Mixer.

2.	 Conferma la tua selezione premendo il tasto OK. Questa operazione apre la pagina 
Audio Setup delle Preferenze.

3.	 Scorri la lista Audio Device per selezionare la scheda audio esterna. 

% 
Per ora utilizza un'impostazione 
moderata. Puoi cambiarla in 

seguito e testare di che tipo di perfor-
mance è capace il tuo sistema.
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4.	 Imposta la latenza e la frequenza di campionamento su un valore compatibile con il 
tuo sistema. Per incominciare consigliamo di usare valori di latenza tra i 10-15 ms. In 
seguito potrai provare a ridurre questo valore per migliorare il modo in cui l'applicazione 
risponde, ma ricorda che riducendo questo valore eccessivamente il tuo computer 
potrebbe non essere in grado di gestire il carico di calcoli e potrebbe iniziare a sentirsi 
una distorsione del segnale audio. Se ciò dovesse accadere, devi impostare nuova-
mente un valore un poco più alto. Per incominciare dovresti impostare la frequenza 
di campionamento su 44100 Hz.

5.	 Apri la pagina Output Routing per assegnare le uscite di TRAKTOR PRO alle uscite 
fisiche della tua scheda audio.
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6.	 Verifica che la modalità Internal Mixer Mode sia selezionata.

7.	 Assegna i Out Channel A, B, C, e D alle uscite della scheda audio esterna collegate 
al mixer.

8.	 Chiudi le Preferenze cliccando il pulsante Close.

4.3.2	 Configurazione di TRAKTOR SCRATCH PRO
In seguito alla registrazione del software tramite un numero di serie di TRAKTOR SCRATCH 
PRO o scegliendo la modalità demo di TRAKTOR SCRATCH PRO, il software si avvierà con 
una configurazione di default adatta per l'uso del timecode di TRAKTOR con i dischi o i CD.

Configurazione TRAKTOR SCRATCH PRO
La configurazione di TRAKTOR SCRATCH PRO ti provvede di tutto il necessario per su-
onare con due giradischi o due CD.

Configurazione Hardware
1.	 Prima di avviare TRAKTOR PRO, accertati che la tua AUDIO 8 DJ (o il tuo mixer che 

certifica il supporto di TRAKTOR SCRATCH) sia installato in maniera corretta, collegato 
al tuo computer e funzionante.

2.	 Collega le uscite e gli ingressi di AUDIO 8 DJ al mixer e ai giradischi-lettori CD con i 
cavi Multicore come descritto nel capitolo 13	 (Funzionalità TRAKTOR SCRATCH 
PRO). Se stai utilizzando un mixer supportato da TRAKTOR SCRATCH PRO, dovresti 
collegarlo al tuo computer ed ai tuoi giradischi/CD Player come descritto nel manuale 
del mixer.

3.	 Collega le tue cuffie al mixer e le uscite del mixer all'amplificatore collegato alle tue 
casse.

% 
Assegnare i Deck C/D, Out 
Preview e Out Send sono fun-

zioni opzionali che dipendono dal tuo 
setup hardware.
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Configurazione Software
1.	 Utilizzando TRAKTOR SCRATCH PRO in Modalità Demo, seleziona l'opzione TRAKTOR 

SCRATCH PRO Setup nel "Setup Wizard".

2.	 Conferma la tua selezione premendo il tasto OK. Questa operazione apre la pagina 
Audio Setup delle Preferenze.

	

3.	 Verifica che AUDIO 8 DJ o il tuo mixer che che certifica il supporto di TRAKTOR 
SCRATCH PRO sia selezionato nel campo Audio Device. Se cosi non dovesse essere, 
selezionalo dal menu a scorrimento.

4.	 Imposta la latenza e la frequenza di campionamento su un valore compatibile con il 
tuo sistema. Per incominciare consigliamo di usare valori di latenza tra i 10-15 ms. In 
seguito potrai provare a ridurre questo valore per migliorare il modo in cui l'applicazione 
risponde, ma ricorda che riducendo questo valore eccessivamente il tuo computer 
potrebbe non essere in grado di gestire il carico di calcoli e potrebbe iniziare a sentirsi 
una distorsione del segnale audio. Se ciò dovesse accadere, devi impostare nuova-
mente un valore un poco più alto. Per incominciare dovresti impostare la frequenza 
di campionamento su 44100 Hz.

5. 	 Apri la pagina Output Routing per assegnare le uscite di TRAKTOR SCRATCH PRO 
alle uscite fisiche di AUDIO 8 DJ o del tuo mixer che certifica il supporto di TRAKTOR 
SCRATCH PRO.

6.	 Verifica che la modalità Internal Mixer Mode sia selezionata.

7.	 Se non accade automaticamente, assegna i Out Channel A, B, C, e D a tutte le uscite 
di AUDIO 8 DJ che sono collegate al mixer, o rispettivamente assegna questi canali 
alle uscite del tuo mixer che certifica il supporto di TRAKTOR SCRATCH PRO.

8.	 Apri la pagina Input Routing e verifica che i canali in ingresso siano assegnati 
correttamente.

9.	 Chiudi le Preferenze cliccando il pulsante Close.
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4.4	 Giro di Prova su TRAKTOR

Ora la scheda audio è configurata e TRAKTOR è attivo e funzionante, è ora di un giro di 
prova. Per fare ciò, usiamo le Tracce Demo fornite con TRAKTOR.

Incominciamo caricando le tracce nel Deck A e B ed avviandone l'esecuzione.

1.	 Clicca e tieni premuta una Traccia Demo nella Browser List e trascinala nel Deck A. La 
traccia selezionata verrà caricata del Deck A e la forma d'onda apparirà nella rispettiva 
finestra di visualizzazione.

2.	 Clicca e tieni premuto una seconda traccia Demo nella Browser List e trascinala nel 
Deck B.

3.	 Avvia i Deck cliccando Play/Pause o se stai usando TRAKTOR SCRATCH PRO avvia il 
tuo disco o CD contenente il Timecode.

4.	 La forma d'onda inizia a muoversi da destra a sinistra. Se ciò non fosse, verifica se hai 
selezionato il dispositivo audio corretto e se hai assegnato correttamente le uscite ai 
canali dell'interfaccia audio. Se stai utilizzando TRAKTOR SCRATCH PRO, assicurati 
che il grafico del Timecode (Scope) sia corretto.

5.	 Una volta che la forma d'onda si muove, dovresti essere in grado di ascoltare la musica 
attraverso gli altoparlanti. Altrimenti, accertati che il Master Level stia indicando qual-
che attività. Se così non fosse, controlla i fader ed i potenziometri del mixer interno 
o di quello esterno.

6.	 Se il Master Level indica un segnale di uscita ma tuttora non esce alcun suono dai 
tuoi altoparlanti, controlla che il tuo sistema di amplificazione sia collegato in maniera 
corretta ed acceso. Alcuni dispositivi audio hanno dei LED di monitoraggio che pos-
sono fornire ulteriore aiuto nel risalire alla causa della mancanza di suono.

7.	 Una volta che sia possibile sentire il suono, sposta il Crossfader a sinistra ed a destra 
per passare  da una traccia all'altra.

8.	 Per effettuare il preascolto delle tracce quando il mixer interno è in uso, clicca sul Cue 
Button nella sezione Mixer del Deck. Utilizzando un mixer esterno, il preascolto viene 
selezionato da lì.



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 23  

9.	 Molto probabilmente le due tracce hanno un tempo diverso e sarà necessario sincron-
izzarne il tempo ed il beat. Puoi osservare l'attuale sfasamento del beat nel Phase 
Meter al di sopra della forma d'onda di entrambi i Deck.

10.	 Clicca il pulsante Sync per una sincronizzazione automatica o usa il Pitch Fader (sul 
software o sul deck hardware) per una sincronizzazione manuale, come faresti con un 
vero giradischi o lettore CD.
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5	 Interfaccia Utente
Questo capitolo non fornisce solamente una panoramica sull'interfaccia utente grafica di 
TRAKTOR, ma inizierà anche a chiarire alcune delle caratteristiche di base dell'applicazione.   

5.1	 Panoramica

1.	 Menu Applicazione

2.	 Header

3.	 Global Section

4.	 Decks

5.	 Mixer

6.	 Crossfader

7.	 Browser
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5.2	 Menu Applicazione

Il Menu Applicazione ti dà accesso a funzioni di base ed alle informazioni sul software.

File (Windows)
►► Preferences: apre la finestra delle Preferenze di Traktor.

►► Audio Setup: Apre il sotto menu dele Schede Audio delle Preferenze.

►► MIDI Setup: Apre il sotto menu delle preferenze delle Interfacce MIDI.

►► Exit: Chiude il programma. Se l'audio viene riprodotto dall'uscita Master, sarà 
necessario confermare l'avviso di chiusura prima di poter terminare l'applicazione.

Traktor (Mac)
About: Apre una finestra di informazioni che indica il numero della versione, il tipo di 
licenza, il numero di serie ed i credits. Clicca sulla finestra per chiuderla.

Preferences: apre la finestra delle Preferenze di Traktor.

Visualizza
►► Layouts: Ti permette di scegliere uno dei Layout disponibili.

►► Schermo Intero: Passa alla Modalità a Schermo Intero.

Help
►► Launch Service Center: Apre il NI Service Center per scaricare aggiornamenti e 

registrare i tuoi prodotti.

►► Open Manual: Apre il manuale utente di TRAKTOR.

►► Visit TRAKTOR on the web: Apre la sezione del sito di NATIVE INSTRUMENTS 
dedicata a TRAKTOR..

►► About TRAKTOR: Apre una finestra di informazioni che indica il numero della versione, 
il tipo di licenza, il numero di serie ed i credits. Clicca sulla finestra per chiuderla.

! 
Il Menu Applicazione non 
è visibile  in modalità  a 

Schermo Intero, di conseguenza è 
possibile accedere a tutte le finestre 
di File e Visualizzazione direttamente 
dall'interfaccia grafica di TRAKTOR. In 
ogni caso il menu Help è accessibile sol-
amente attraverso il Menu Appplicazione.

!
Clicca sulla pulsante evidenziato 
della modalità a Schermo Intero 

per tornare alla modalità finestra.

% 
E' anche possibile aprire la fin-
estra About cliccando sul logo 

	 di Traktor.
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5.3	 Header

La sezione Header fornisce informazioni di stato ed icone che ti consentono un rapido 
accesso alle funzioni di base di TRAKTOR. 

1.	 Logo di TRAKTOR: Apre la Finestra About.

2.	 Indicatore MIDI: Indica eventuali messaggi MIDI in ingresso. L'icona si illuminerà in caso 
di ricezione di dati. 

3.	 Indicatore Audio: Indica lo stato della tua scheda audio (blu: la scheda audio è collegata 
e funzionante; rosso: non è rilevata alcuna scheda audio o essa non funziona corret-
tamente.)

4.	 CPU Meter: Indica che percentuale di CPU è disposizione del motore audio interno di 
TRAKTOR. Più alta la percentuale, più sarà probabile che si verifichino click dell'audio, 
soprattutto al di sopra dell'80%.

5.	 Clock: Indica il tempo del clock di sistema.

6.	 Master Out: Indica il livello dell'uscita principale. Il picco del meter diventerà rosso se 
si verificherà un clip del o se il Limiter interno comprimerà il segnale (deve essere 
attivato dalle Preferenze). 

7.	 Indicatore Batteria: Indica quanta energia è rimasta alla tua batteria. Questa icona 
diventerà blu quando si utilizza energia elettrica dal trasformatore, rossa quando si 
usa la batteria. 

8.	 Indicatore di Recording: Indica lo stato del registratore audio di Traktor. Se l'icona è 
rossa, Traktor sta registrando.

9.	 Layout Selector: Fornisce accesso diretto ai Layout di schermo configurati dal Layout 
Manager (vedi capitolo 16.1.2 - Layout Manager e 14.11 - Layout Manager).

10.	 Maximize Browser Button: Espande la finestra del browser fino a farle occupare lo scher-
mo intero.
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11.	 Preferences Button: Apre il menu delle Preferenze di Traktor (vedi capitolo 14 - 
Preferenze).

12.	 Full Screen Button: Abilita e disabilita la Modalità a Schermo Intero.

13.	 NI Logo: Apre la finestra About.

5.4	 Global Section

La Global Section fornisce cinque pannelli distinti. Ogni pannello viene descritto detta-
gliatamente qui di seguito.

5.4.1	 Master Panel

1.	 Master Volume: Controlla il Livello dell'uscita Master.

2.	 Mouse Mode Selection: 

►► Snap: la posizione di lettura del brano si sposta alla battuta più vicina nel Waveform 
Display. 

►► Quant: Si sposta con precisione fra Hotcue e Hotloop per mixare in tempo reale.

►► CD Mode: avvia la riproduzione di un breve Loop Stutter mentre il Deck è in 
pausa. Simula il comportamento del Cue dei comuni CD Player da Dj. 

3.	 Headphones Mix: Controlla il bilanciamento del mix in cuffia tra segnale Master e di 
Preascolto.

4.	 Headphones Volume: Controlla il volume del Monitor Output per le tue cuffie.

!
La selezione del Mouse Mode 
non è disponibile in TRAKTOR 

DUO e TRAKTOR LE.
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5.	 Opzioni Audio Globali:

►► LFO Reset: Fa ripartire la LFO per tutti gli effetti basati su LFO.

►► Cruise: attiva la riproduzione automatica di una playlist intera (Autoplay)..

►► Tick: attiva o disattiva un Beat Tick che simula un metronomo. Attiva il pulsante 
Cue del rispettivo canale per ascoltare il Beat Tick.

5.4.2	 Pannello FX 1/ FX 2
Ognuno dei due Pannelli di Effetti rappresenta uno degli slot di effetti di Traktor.  
La Modalità Chained colloca fino a tre ingressi fx in serie permettendoti combinazioni 
interessanti. La Modalità Avanzata abilita un solo effetto ma con più parametri per un 
controllo più in profondità.   

Chained Mode:

1.	 Dry/Wet Control: Controlla il rapporto fra segnale audio pulito e segnale processato. 

2.	 Effect Selector: Apre il menu a scorrimento degli effetti definiti nelle Preferenze di 
TRAKTOR. 

3.	 Knob Effect Amount: Ognuno dei potenziometri controlla la profondità dei singoli parametri. 

4.	 Snapshot: Salva le impostazioni degli effetti attuali come default. Le impostazioni di 
ognuno degli effetti vengono richiamate singolarmente.

5.	 Pulsanti Effect On: Attiva e disattiva i singoli effetti.

! 
LFO Reset non è disponi-
bile in TRAKTOR DUO. LFO 

Reset e Cruise non sono disponibili in
TRAKTOR LE.

! 
Solo un effetto per effect unit in 
modalità chained è disponibile    

	 si TRAKTOR LE.
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Advanced:

1.	 Dry/Wet Control: Controlla il rapporto fra segnale audio pulito e segnale processato.

2.	 Effect Selector: Apre il menu a scorrimento degli effetti definiti nelle Preferenze di 
TRAKTOR.

3.	 Knob Effect Parameter: Controlla i vari parametri dell'effetto selezionato. 

4.	 Snapshot: Salva le impostazioni degli effetti attuali come default.

5.	 Effect On: Attiva o disattiva in maniera globale l'effetto selezionato.

6.	 Effect Parameter Reset: Ripristina tutti i parametri degli effetti alle impostazioni di default.

7.	 Pulsanti Effect 1/2: Controlla quale parametro verrà modificato in maniera dipendente 
dall'effetto. 

! 
Gli Advanced Controls non sono 
disponibili in TRAKTOR DUO e  

	 TRAKTOR LE.
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5.4.3	 Master Clock

1.	 Master Clock Tick: attiva o disattiva un Beat Tick: un metronomo audio sincronizzato al 
Master Clock.   

2.	 Mode:

►► Manual: assegna la sorgente di tempo in maniera manuale al Master Clock o al Deck.

►► Auto: Seleziona automaticamente uno dei Deck come sorgente di tempo. Il Master 
Clock si sincronizza automaticamente al Master Deck.

3.	 Tempo Display: Indica il tempo attuale e lo sfasamento rispetto al Master Clock. 

4.	 Tap: Imposta manualmente il Master Tempo tramite il tap della battuta.

5.	 Master Clock Pitch Bend: Rallenta o velocizza momentaneamente il Master Tempo.

6.	 Master Tempo Adjust: Aumenta (+) e diminuisce (-) il Master Tempo.

7.	 MIDI Clock Reset: Effettua il reset di tutte le periferiche collegate come slave al MIDI Clock.

8.	 MIDI Clock Send: Attiva o disattiva il MIDI Clock per la sincronizzazione esterna.

!
Il Master Clock non è dis-
ponibile in TRAKTOR DUO e  

	 TRAKTOR LE.
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5.4.4	 Recorder

1.	 Rec On/Off: Avvia ed arresta la registrazione.

2.	 Broadcasting On/Off: Avvia ed arresta la trasmissione. 

3.	 Gain: Controlla il volume dell'ingresso del registratore.

4.	 Recorder Display: Indica la lunghezza e le dimensioni del file della registrazione.

5.	 Rec Meter: Indica il livello del segnale in registrazione.

6.	 Delete: Elimina la registrazione corrente.

7.	 Cut: Taglia la registrazione corrente ed inizia un nuovo file senza interruzione.

!
Il Recorder non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.
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5.5	 Decks

1.	 Track Cover Icon: Indica la copertina della traccia caricata.

2.	 Track Info: Mostra informazioni sulla traccia caricata. E' possibile personalizzare le in-
formazioni visualizzate in Preferenze > Layout Manager > Deck Details > Deck Header.

3.	 Sync Controls: 

►► Sync Button: sincronizza la traccia in riproduzione alla attuale riferimento del 
tempo (un'altro Deck o il Master Clock).

►► Master Button: definisce questo Deck come Master per la sincronizzazione.

►► Phase Meter: Indica lo sfasamento del beat della traccia in esecuzione rispetto al 
Master Deck o ai tick del Master Clock. Il Phase Meter deve essere centrato per 
indicare corrispondere al beat.

►► Pitch Bend Buttons: rallentano o velocizzano temporaneamente la traccia in ripro-
duzione.

% 
Questa immagine mostra 
tutti gli elementi del Deck. 

Dipendentemente dal layout alcuni di 
essi potrebbero essere nascosti o visibili, 
per es. gli Scratch Panels in TRAKTOR 
SCRATCH PRO.

Sincronizzato

Phase spostata
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4.	 Waveform: 

►► Rappresenta visivamente una porzione della traccia in riproduzione. La gradazione 
di colore più chiara rappresenta le alte frequenze mentre una gradazione più 
scura rappresenta quelle basse. 

►► Utilizza il tasto “+” o “-” per ingrandire o rimpicciolire la visuale.

5.	 Skip to Start: Sposta la posizione di riproduzione all'inizio della traccia caricata.

6.	 Stripe:

►► Indica la forma d'onda della traccia caricata in maniera completa, compresi i Cue 
Point ed i Loop.

►► La parte della traccia copiata nella cache necessaria per effettuare spostamenti 
senza interruzioni viene visualizzata con delle strisce gialle al di sopra e al di 
sotto della Stripe.

7.	 Input Selector: Seleziona la modalità di ingresso per il Deck in questione. Utilizzalo per 
cambiare fra Internal Playback, Scratch Control o External Input. 

8.	 Pitch Fader: Sposta il fader verso l'alto o verso il basso per rallentare o velocizzare il 
tempo della traccia attualmente in esecuzione.

9.	 Key Lock: Attiva o disattiva la funzione Key Lock.

10.	 Pitch Adjust: Velocizza e rallenta il tempo della traccia in maniera incrementale. E' pos-
sibile determinare la sensibilità degli scatti tramite click destro/ctrl click del mouse.

11.	 Transport Controls: Controllo di Playback e Current Cue Point. Vedi i capitoli 5.5.1 
(Controlli Trasporto) e 6.4 (Controlli Trasporto).

12.	 Loop Controls: Imposta i loop automatici e manuali. Vedi i capitoli 5.5.2 (Controlli Loop) 
e 6.5 (Controlli Loop).

13.	 Open/Close Advanced Panel: Apre e chiude i Pannelli dei controlli avanzati. Vedi i capitoli 
5.5.3 (Advanced Panels) e 6.7 (Advanced Panels).
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5.5.1	 Controlli di trasporto

1.	 Play/Pause: 

►► Avvia o arresta la riproduzione.

►► L'arresto non imposta un Current Cue Point se la riproduzione viene messa in 
pausa.

2.	 Cue:

►► Durante il playback, un click sposta  la lettura al Current Cue Point.

►► Su un Deck in pausa, un click imposta un nuovo Current Cue Point alla posizione 
attuale. La traccia verrà riprodotta dal Cue Point finché viene tenuto premuto il 
pulsante. Una volta rilasciato, la traccia torna indietro sul Current Cue Point.

3.	 Cue Play/Pause:

►► Durante il playback, riporta la traccia al Current Cue Point senza arrestare il  
playback. 

►► Su di un Deck in pausa, un click imposta un nuovo Current Cue Point ed avvia il 
playback al rilascio del pulsante.
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5.5.2	 Controlli Loop

1.	 Loop Size Control:

►► Imposta gli Auto Loops e cambia le dimensioni del loop.

►► La dimensione del loop prescelta viene evidenziata in giallo.

►► Usa i pulsanti Arrow su ognuna delle parti finali del range del loop per ottenere 
valori maggiori o minori. I pulsanti Arrow lampeggiano se non è visibile la 
lunghezza attuale.

2.	 Loop In Button

►► Imposta manualmente un Loop In Cue Point.

►► E' anche possibile utilizzare il Loop In Button per impostare un Current Cue Point 
al volo durante il playback.

►► La pressione di In mentre un loop è attivo seleziona l Move Mode "Loop In" 
(vedi sotto).

3.	 Loop Out Button

►► Imposta manualmente un Loop Out Point e attiva il loop

►► La pressione di Out mentre un loop è attivo seleziona il Move Mode "Loop Out" 
(vedi sotto).

►► La pressione di In e Out mentre il loop è attivo seleziona il Move Mode "Loop" per 
spostare il loop nella sua interezza.

4.	 Loop Active Button: Questo pulsante indica che un loop è attivo e in riproduzione. Può 
servire per disattivare il loop. Se acceso mentre nessun loop sta girando, verrà attivato 
il prossimo loop precedentemente salvato incontrato durante il playback.
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5.5.3	 Advanced Panels
Per aprire gli Advanced Panels, clicca sulla piccola freccia che punta verso il basso al di 
sotto del Pitch Fader. 

Ci sono tre pannelli avanzati. Selezionali cliccando sui pulsanti Move, Cue o Grid sul lato 
sinistro.

Loop Move e Beat Jump Panel (Move):

1.	 Mode Selector: Cambia fra Modalità Beat Jump, Loop In e Loop Out.

2.	 Amount Controls: Seleziona le dimensioni degli step in beat. La freccia gialla indica le 
dimensioni selezionate. Usa i pulsanti a forma di freccia per scorrere attraverso le 
dimensioni di spostamento predefinite, Clicca su di un valore per sceglierlo.

3.	 Pulsanti Move: Sposta il parametro definito nel Mode Selector in avanti o all'indietro di 
un numero di beat definito dagli Amount Controls.

4.	 Loop Button:

►► Questo pulsante sceglie una dimensione di step basata sulla dimensione attuale 
del loop per effettuare il movimento.

►► Se la modalità Loop Mode è attiva, il loop verrà spostato indietro o in avanti  
esattamente di una volta pari alla sua lunghezza. 

►► Con Loop In o Loop Out selezionato, il loop verrà ridimensionato raddoppiando o 
dimezzando la lunghezza del loop corrente.

5.	 Fine Button: Seleziona una dimensione di step più piccola per lo spostamento.

! 
Il loop Move non è disponibile 
in TRAKTOR LE.
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Cue Point Panel e Loop Management Panel (Cue):

1.	 Next/Previous: Questi servono per spostarsi al precedente o seguente Stored Cue Point 
all'interno della traccia. 

2.	 Cue Position Display: Indica la posizione del Cue/Loop selezionato in mm:ss:ms.

3.	 Cue Name Display: Il Display indica il nome del Cue/Loop Point selezionato. Clicca 
all'interno del campo per modificare il nome. Clicca sulla freccia rivolta verso il basso 
per selezionare un'altro Cue/Loop In Point.

4.	 Cue Type Selector: Clicca sulla freccia rivolta verso il basso per selezionare il tipo di Cue 
Point. I tipi disponibili sono descritti nel capitolo 6.7.3 (Tipi di Cue Point).

5.	 Delete: Elimina i Cue/Loop Point selezionati.

6.	 Store:

►► Salva i Current Cue Point e li assegna al primo pulsante Hotcue libero.

►► E' possibile salvare fino a 32 cue point per traccia. 

7.	 Pulsanti Hotcue:

►► Questi danno accesso diretto fino ad un numero di 8 Cue/Loop In Point per traccia.

►► Il colore dello sfondo corrisponde al tipi di Cue Point selezionato.

8.	 Map: questo pulsante abilita la Modalità Hotcue Mapping. Se attiva, premendo un pul-
sante Hotcue il Cue/Loop In Point visualizzato viene assegnato a quel pulsante. Questo 
funziona solamente per i Cue/Loop Point salvati.

!
I Cue Point e Loop Management 
Panel non sono disponibili in  

	 TRAKTOR LE.
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Beatgrid Panel: (Grid):

1.	 Regola i Beatmarker Buttons:

►► Questi pulsanti regolano la posizione del Beatmarker. Di conseguenza l'intero 
Beatgrid slitta a sinistra o a destra.

►► Usa questa opzione per spostare il Beatmarker al punto iniziale desiderato.

2.	 Lock Beatgrid: Blocca la Beatgrid (tutti i pulsanti nel Grid Panel vengono disabilitati).

3.	 Pulsanti BPM Adjust:

►► Questi pulsanti cambiano i BPM di una traccia. Come risultato, la Beatgrid si 
espande o si ritira.

►► Usa questa funzione per fare corrispondere la griglia alle battute della traccia.

4.	 Auto Grid: Clicca su questo pulsante per impostare un Beatmarker al Current Cue Point.

5.	 Tempo Display: indica il tempo della traccia caricata in BPM.

6.	 ÷2 / x2: clicca su di essi per dimezzare/raddoppiare il tempo.

7.	 Tap: Imposta il tempo basato sulla velocità alla quale viene effettuata la pressione del 
pulsante. Il tempo verrà impostato dopo il quarto tap.

   
Restringi Beatgrid

 
Espandi Beatgrid
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5.6	 Mixer

1.	 Equalizer:

►► Fornisce un EQ a tre bande (default) per regolare il contenuto delle frequenze 
della traccia in playback.

►► Un click sui piccoli pulsanti vicino ai knobs elimina completamente (kill) le  
rispettive frequenze.

►► Per altri tipi di EQ, vai in Preferences > Mixer EQ Selection.

2.	 Channel Fader

►► Controlla il volume del canale.

►► I Channel Level Meters indicano il livello pre fader del segnale del Deck regolabile 
tramite  il Gain Knob.
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 3.	 Filter

►► Questo knob permette di controllare il filtro bipolare del rispettivo canale.

►► Abilita il filtro cliccando il piccolo pulsante vicino al knob.

►► La posizione centrale è quella neutrale. Ruotalo verso sinistra per un filtro passa 
bassi e a destra per un passa alti.

4.	 Key Lock:

►► Permette di controllare l'intonazione della traccia. Ruotalo a destra per alzare 
l'intonazione, a sinistra per abbassarla.

►► Abilita il Key Lock cliccando il piccolo pulsante vicino al knob.

5.	 Effect Assign Button: Clicca su 1 o 2 per assegnare un canale allo Effect Slot 1 o 2.

6.	 Gain: Regola il gain di una traccia. Utilizzalo per fare corrispondere i livelli delle tracce 
prima di mixarli con i fader.

7.	 Cue Button:

►► Permette di effettuare il preascolto di una traccia tramite il Mixer interno di Traktor.

►► Se Tick è attivato, clicca il pulsante Cue per rendere udibile il tick che segue il 
beat su quel deck. 

8 .	 Pan Button: Controlla il bilanciamento fra il canale sinistro e quello destro.

9.	 Automatic Crossfade Buttons:

►► Il click di questi pulsanti sposta il Crossfader a destra o a sinistra.

►► Clicca ancora per fermare la transizione.

10.	 Incremental Crossfade Buttons: Ogni click di questi pulsanti muove il Crossfader a sinistra 
o a destra di uno scatto.

11.	 Deck Assign Buttons: Assegna i Deck al Crossfader. I pulsanti per il Deck assegnato si 
accendono.

12.	 Crossfader: Sposta il Crossfader a sinistra o a destra per effettuare transizioni fra i Deck.

!
Il Key non è regolabile in 
TRAKTOR LE.

! 
I Canali non sono assegnabili ai 
singoli Effect Slot in TRAKTOR 

DUO e Traktor LE.
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5.7	 Browser

1.	 Preview Player: Clicca l'icona Preview Player del Browser List per caricare una traccia 
all'interno del Preview Player. Oppure, puoi anche trascinare una traccia sopra di essa.

2.	 Favorites: Favorites dà accesso diretto alle cartelle o alle Playlist. Trascina una cartella 
o una Playlist su uno dei 10 spazi dedicati ai Favorites per assegnarli.

3.	 Browser List:

►► Mostra le tracce a seconda della sorgente selezionata (cartella, playlist, risultati 
ricerca o in base ai tag).

►► Click destro/Control Click sull'header per attivare o disattivare le colonne.

►► Trascina le colonne a sinistra o a destra per riordinarle.

4.	 Track Info: Mostra il titolo e l'artista della traccia attualmente selezionata.

5.	 Search Field: Offre una ricerca in tempo reale basata sui tag delle tracce nella 
collezione. Ulteriori informazioni nel capitolo 7.2 Trovare le tracce (Search),

!
La funzione Favorite non è dis-
ponibile in TRAKTOR LE.
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6.	 Browser Tree:

►► Track Collection: contiene tutte le Tracce importate nella tua Collection. Esse 
vengono automaticamente ordinate in base ad Artista, Release, Label o Genere.

►► Playlists: contiene tutte le tue playlist di TRAKTOR.

►► Explorer: sfoglia il tuo disco fisso alla ricerca di tracce. Questo può tornare utile 
per trovare tracce che non sono ancora state importate.

►► Audio Recordings: contiene tutte le registrazioni effettuate con il Traktor Audio 
Recorder.

►► iTunes: fornisce diretto accesso alla tua libreria iTunes, incluse tutte le playlist.

►► History: contiene la cronologia delle playlist. Queste ultime vengono salvate auto-
maticamente da Traktor dopo ogni sessione. Puoi trovare la cronologia delle 
Playlists di sessioni precedenti in Documenti/Native Instruments/traktor/History.

7.	 Cover View: Visualizza la copertina della traccia attualmente selezionata nella 
Browser List.

8.	 Status Bar/Error Messages: Visualizza il progresso dell'analisi, messaggi di errore e lo 
stato complessivo di TRAKTOR.

!
La Funzione History non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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6	 Utilizzo dei Deck
TRAKTOR È provvisto di fino a 4 Deck. Puoi scegliere tra la modalità 2 o 4 Deck nelle 
preferenze.

I Deck di Traktor ti offrono funzioni più che sufficienti per una DJ performance professionale.

6.1	 Caricamento delle Tracce

Per caricare una traccia in un Deck:

1.	 Seleziona la traccia nella Browser List con le frecce su e giù

2.	 Premi Ctrl e Freccia a sinistra/Destra per caricare la traccia selezionata nel Deck A 
o B oppure

3.	 Trascina una traccia dalla Browser List sul Deck desiderato oppure

4.	 Control Click/tasto Destro sulla traccia e seleziona Load Track in Deck A/B/C/D.

6.2	 L'Heading del Deck

Il Deck Header mostra informazioni riguardo la traccia caricata. 

►► Se utilizzi i Deck a dimensione intera potrai osservare tre colonne pronte all'utilizzo. 

►► E' possibile personalizzare le informazioni visualizzate a tuo piacere in Preferenze > 
Layout Manager > Deck Details > Deck Header. (Utilizzando la visualizzazione Mini 
dei Deck sarà visibile solo la prima fila).

!
Solo due deck sono dis-
ponibili in TRAKTOR DUO e 

	 TRAKTOR LE.

% 
TRAKTOR offre dei Mini Deck 
per un pratico utilizzo su scher-

mi più piccoli. Un Mini Deck mostra solo 
due righe nell'Header e non contiene al-
cun Waveform Display.

Per attivare i Mini Decks vai su: 
Preferences > Layout Manager > Deck 
Style ed imposta le dimensioni dei Deck 
su Mini.

!
Questa opzione di personaliz-
zazione non è disponibile in 

TRAKTOR DUO e Traktor LE.
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6.3	 Il Waveform Display e la Stripe View.

La Waveform e lo Stripe sono rappresentazioni visive della traccia caricata. La Waveform 
è visibile istantaneamente, mentre la Stripe viene visualizzata solo una volta che la trac-
cia è già stata analizzata. Una volta che la traccia è stata analizzata, la Stripe apparirà 
istantaneamente al caricamento della traccia. Per saperne di più sull'analisi consulta il 
capitolo 7.8.2 (Analisi).

6.3.1	 Waveform
Il Waveform Display fornisce una rappresentazione dettagliata delle informazioni di 
transienti ontenuti nella traccia caricata.

►► Puoi ingrandirlo e rimpicciolirlo cliccando su “+” e “-“ vicino alla Waveform.

►► Colori più chiari rappresentano un contenuto di alte frequenze, colori più scuri basse 
frequenze.

►► Il comportamento del trascinamento della Waveform con il mouse dipende dallo Snap 
Mode, che viene attivato nel Master Panel della Global Section. Ulteriori informazioni 
sui Mouse Modes nel capitolo 11 (Controllo Mouse per Fader e Knob).

6.3.2	 Stripe
La visualizzazione Stripe di permette una visione d'insieme della traccia. Inoltre indica la 
posizione di playback attuale come anche quella di tutti i Cue Point e dei Loop.

►► Una volta raggiunto il Track End Warning Time (avvertimento di fine traccia) 
predefinito, lampeggia in rosso (Preferences > Global View Options > Decks).

►► Il comportamento del click del mouse all'interno dello Stripe Display dipende dal Quant 
Mode. Questa modalità viene scelta nel Master Panel della Global Section. Ulteriori 
informazioni sui Mouse Modes nel capitolo 11 (Controllo Mouse per Fader e Knob).	

!
La modalità Mouse Mode 
Selection non è disponibile in 

	 TRAKTOR LE.

% 
E' possibile impostare le dimen-
sioni della cache per i Deck di 

TRAKTOR in: Preferences > Loading > 
Deck Cache Size. Per saperne di più 
consulta il capitolo 14.4 (Loading).
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Le barre gialle al di sopra ed al di sotto della Stripe indicano in quanta parte la traccia è 
già stata caricata nella cache. Spostamenti effettuati all'interno di parti della traccia già 
presenti nella cache avvengono senza interruzioni.

►► Le barre lampeggiano mentre TRAKTOR scrive porzioni della traccia nella cache.  

►► Una volta che la traccia è stata completamente caricata nella cache le barre  
smetteranno di lampeggiare.   

6.4	 Controlli di Trasporto

I Controlli di Trasporto sono i pulsanti principali utilizzati per avviare la riproduzione delle 
tracce con TRAKTOR.

6.4.1	 Play
►► Clicca su Play/Pause per avviare o fermare la riproduzione.

6.4.2	 Cue
Questo pulsante ha molteplici funzioni, a seconda dello stato di playback della traccia.

►► Su un Deck in pausa, un click su Cue imposta un nuovo Current Cue Point alla 
posizione attuale. In modalità Snap questo Cue Point si sposta sulla battuta più vici-
na alla posizione in riproduzione.

►► Se la traccia è in pausa e in cue al Current Cue Point, clicca e tieni premuto il pulsante 
Cue per effettuare il preascolto alla posizione di Cue. Rilascia Cue per tornare al 
Current Cue Point.

►► Un click su Cue durante il playback riporta la posizione di riproduzione indietro al 
Current Cue Point precedente ed arresta il playback.
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6.4.3	 Cup (Cue-Play)
Questo pulsante si comporta in maniera simile a Cue, ma interrompe la riproduzione fino 
a che lo si tiene premuto. 

►► Su di un Deck in pausa, un click su Cup imposta un Current Cue Point ed avvia il 
playback al rilascio del pulsante.

►► Un click su Cup durante il playback riporta la posizione corrente di riproduzione indi-
etro al Current Cue Point precedente e mette in pausa il playback. Rilascia il pulsante 
per riprendere il playback. 

6.5	 Controlli del Loop.

I principali controlli di loop offrono funzioni necessarie per un utilizzo creativo dei loop 
nel tuo mix. 

6.5.1	 Auto Looping
►► Clicca un numero all'interno del Loop Size Control per impostare un loop. I numeri 

rappresentano la lunghezza del loop in battute.

►► Selezionando una dimensione del loop, il pulsante in questione ed il pulsante Loop 
Active si accenderanno in giallo. Se inattive, le presenti icone sono grigie.

►► Per interrompere la riproduzione in loop, clicca sulla lunghezza attuale del loop o sul 
pulsante Loop Active. 

►► Per cambiare al volo le dimensioni di un loop attivo, clicca su un'altra lunghezza nel 
Loop Size Control. 

►► Usa i pulsanti Arrow su ognuna delle parti finali del Loop Size Control per visualizzare 
valori maggiori o minori. I pulsanti Arrow lampeggiano se la lunghezza attuale è fuori 
portata.

% 
Per ulteriori opzioni per lavorare 
con i Loop, come salvataggio 

e modifica dei loop, consulta il capitolo 
16.5 (Transport).



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 47  

6.5.2	 Looping Manuale
►► Clicca sul pulsante Loop In per impostare l'inizio del loop.

►► Clicca sul pulsante Loop Out per impostare la fine del loop. La tua traccia inizierà a 
riprodurre la lunghezza specificata in loop Il Loop Active Button si accenderà in 
seguito alla scelta del tuo Loop Out Point.

►► Per interrompere la riproduzione in loop, clicca sul pulsante Loop Active evidenziato. 

6.6	 Controlli del Tempo

TRAKTOR fornisce un Pitch Fader con un range configurabile, una coppia di 
pulsanti Pitch Bend ed anche una vasta gamma di funzioni di sincronizzazione. Queste 
funzioni ti danno un controllo sui tuoi mix superiore a quanto possibile fino ad ora.

6.6.1	 Controlli del Tempo Manuali

Pitch
Spostando il Pitch Fader verso l'alto o il basso si rallenterà o velocizzerà il tempo della 
traccia. Il Pitch Fader di Traktor offre le stesse funzioni di un pitch fader presente su ogni 
CD Player o giradischi standard.

►► Per regolare il tempo in scatti, usa i pulsanti “+” o “-”

►► Oppure, puoi utilizzare la rotella di scorrimento del mouse per spostare il Pitch fader 
verso l'alto o il basso.

►► E' possibile aggiustare la sensibilità dei pulsanti “+” o “-” della rotella di scorrimento 
del mouse cliccando col tasto destro o con Ctrl sui pulsanti  “+” o “-” e selezionando 
una delle opzioni di sensibilità.
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Pulsanti Pitch Bend.
I pulsanti di Pitch Bend servono quando due tracce sono in riproduzione allo stesso tempo, 
ma leggermente sfasate. Questo equivale ad un tocco gentile al vinile per rallentarlo o 
velocizzarlo quando le tracce sono leggermente fuori sync.

►► Clicca la freccia a sinistra per rallentare leggermente la traccia, clicca la freccia a 
destra per velocizzarla. Tenendo premuto il pulsante Pitch Bend si continuerà a  
velocizzare o rallentare la traccia fino a che il pulsante viene tenuto premuto.

6.6.2 	 Phase Meter
Il Phase Meter vale da riferimento visivo per la sincronizzazione della traccia. Esso ti 
permette di osservare se una traccia è sincronizzata o meno al Master Deck o al Master Clock.

►► Se le Fasi di due tracce sono sincronizzate, il meter rimane al centro. 

►► Se la fase di una delle tracce è leggermente spostata all'indietro, apparirà una striscia 
gialla alla sinistra dell'indicatore centrale.

►► Se la fase di una delle tracce è leggermente spostata in avanti, apparirà una striscia 
gialla alla destra dell'indicatore centrale.

►► E' possibile attivare o disattivare in maniera globale il Phase Meter in: 
Preferences > Layout Manager > Deck Details > Pitch Controls

►► Sposta manualmente la Phase cliccando all'interno del Phase Meter e trascinandolo 
verso l'indicatore centrale. E' possibile ottenere lo stesso risultato ruotando la rotella 
del mouse.
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6.6.3	 Sincronizzazione del Beat
La sincronizzazione automatica del beat è una delle funzioni principali di TRAKTOR. 
E' sufficiente un solo click!

Pulsante Sync
Il pulsante Sync ti offre il modo più veloce per sincronizzare il beat.

Clicca su Sync per sincronizzare automaticamente il tempo e la fase della traccia in ripro-
duzione:

►► al Master Deck

►► al Master Clock, se non vi è alcun Deck impostato come Master Deck.

Master Deck
Il Master Deck fornisce il tempo di riferimento al quale gli altri deck si possono sincronizzare.

►► TRAKTOR imposta automaticamente il Master Deck a seconda di quale traccia  
possiede il tempo più lungo di playback ininterrotto.

►► E' possibile cambiare il Master Deck cliccando il pulsante Master su di un altro Deck. 

►► Se TRAKTOR non imposta il Master Deck in maniera automatica, abilita la modalità 
automatica all'interno del Master Clock Panel della Global Section (vedi capitolo  
4.3 Master Clock). 

Passando da Master Clock a Manual Mode, è necessario selezionare il Master Deck visto 
che ciò non accadrà più in maniera automatica.

►► Il Master Clock definirà il tempo di riferimento nel caso non sia impostato alcun Master 
Deck.

Master button per un Master Deck.

& 
Master Deck Automatico!
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6.6.4	 Key Lock
TRAKTOR ti permette di cambiare il tempo di una traccia mantenendo l'intonazione 
originale; evitando quindi l'effetto "Mickey Mouse".

►► Clicca il pulsante Lock Key sul lato destro della Stripe per riprodurre la traccia con la 
sua intonazione originale.

►► Clicca il piccolo pulsante vicino al Key Knob per attivare il Key Lock Mode senza 
cambiare i'intonazione attuale.

►► Entrambi i pulsanti sono accesi quando il Key Lock è attivo.

6.7	 Advanced Panels

Gli Advanced Panels ti consentono ulteriori modifiche e funzioni di salvataggio per Loop 
e Cue Point, Hotcue, Beatjump e per aggiungere Beatgrid alle tue tracce.

►► Per aprire gli Advanced Panels, clicca il pulsante al di sotto del pulsante Active.

►► Oppure, attiva gli Advanced Panels in: Preferences > Layout Manager > Deck Details 
> Deck Style.

►► Una volta che il pannello è aperto, i pulsanti contraddistinti come Move, Cue e Grid 
danno ognuno accesso ad uno dei tre sotto pannelli disponibili.

6.7.1	 Beatjump e Loop Move Panel (Pannello Spostamento)

Il Beatjump e Loop Move Panel (Spostamento) ti permettono di modificare un loop 
impostato in precedenza. Puoi spostare i punti di loop all'interno di una traccia di un  
numero predefinito di battute. 

►► I quattro modi disponibili sono descritti qui di seguito. Utilizza il Mode Selector per 
cambiare modalità.

!
La Funzione Key Lock non è 
disponibile in TRAKTOR DUO 

	 e TRAKTOR LE.

! 
Non è possibile aprire gli 
Advanced Panels in Modalità 

	 Mini Deck.

% 
Con Quant attivo nel Master 
Panel, tutti gli spostamenti 

sono assolutamente senza interruzioni. 

!
I Beat Jump ed il Loop Move 
Panel non sono disponibili in 

	 TRAKTOR LE.
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►► L'Amount Control ha effetto su tutti i modi. Utilizza quest'ultimo per impostare le di-
mensioni del beatjump o del loopjump. La freccia gialla al di sotto di uno dei valori 
indica le dimensioni selezionate. Usa i pulsanti a sinistra e a destra per scorrere at-
traverso le dimensioni di spostamento predefinite.	

Beatjump Mode
La modalità Beatjump ti permette di spostarti in avanti o all'indietro all'interno della traccia.

►► Usa l'Amount Control per selezionare la dimensione dello spostamento.   

►► Clicca i pulsanti Move per spostarti in avanti o all'indietro in base le dimensioni 
selezionate.

►► Se i pulsanti Fine sono attivi, puoi spostarti di una quantità più precisa. Inoltre, 
scegliere xFNE ti permette di effettuare un Beatjump ancora più preciso. 	

Loop Mode
Loop Mode ti permette di spostare l'intero loop.

1.	 Usa l'Amount Control per selezionare la dimensione dello spostamento. 

2.	 Clicca i pulsanti Move per spostare il loop in base allo spostamento selezionato.

►► Se Loop è attivo, il loop verrà spostato di una intera lunghezza. L'Amount Control 
passa automaticamente a Loop cliccando il pulsante Loop.

►► Tramite il pulsante Fine, puoi spostare il Loop di una quantità più precisa. Inoltre, 
scegliendo xFNE puoi effettuare uno spostamento ancora più preciso. 
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Loop In Mode
La modalità Loop In ti permette di impostare il Loop In Point.

1.	 Seleziona una dimensione di movimento dall'Amount Control

2.	 Usa i pulsanti Move per spostare il Loop In Point in base allo spostamento selezionato.

►► Se Loop è attivo, è possibile dimezzare o raddoppiare  la lunghezza del loop tramite 
l'utilizzo dei pulsanti Move.

►► Tramite il pulsante Fine, puoi modificare la dimensione del Loop muovendo il Loop 
In Point di un preciso valore. L'Amount Control passa automaticamente alla 
modalità Fine. Usa xFNE per effettuare modifiche ancora più precise. 	

Loop Out Mode
La modalità Loop Out ti permette di impostare il Loop Out Point.

1.	 Seleziona una dimensione di movimento utilizzando l'Amount Control.

2.	 Clicca i pulsanti Move per spostare il Loop Out Point in base allo spostamento 
selezionato.   

►► Se Loop è attivo, è possibile dimezzare o raddoppiare  la lunghezza del loop tramite 
l'utilizzo dei pulsanti Move.

►► Tramite il Fine Button, puoi modificare la dimensione del Loop spostando il Loop 
Out Point di un preciso valore. L'Amount Control passa automaticamente alla mo-
dalità Fine. Usa xFNE per effettuare modifiche ancora più precise.	
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6.7.2	 Cue Point e Loop Management Panel (Cue Panel)

Il Cue Point ed il Loop Management Panel (Cue) ti permettono di salvare ed assegnare sia 
i Cue Point che i Loop.

Utilizzando Cue Point salvati, puoi specificare delle posizioni precise all'interno delle tue 
tracce; ad esempio, inizio della parte vocale, parte strumentale, break. Per salvare un Cue 
Point, procedi come segue:

1.	 Imposta il Cue Point utilizzando il pulsante Cue nei Controlli di Trasporto.

2.	 Clicca su Store.

►► Utilizza i pulsanti Next/Previous Cue Point per spostarti da un Cue Point salvato 
all'altro.

►► Il Cue Position Display indica la posizione del Cue Point salvato all'interno 
della traccia.

►► Puoi assegnare un nome ad un Cue Point all'interno del Cue Name Display. Lo si 
può osservare alla destra del Cue Point Display. Clicca il display per evidenziare 
il nome, poi procedi a rinominarlo. 

►► Puoi spostarti direttamente su di un Cue Point salvato usando il menu a  
scorrimento alla destra del Cue Name Display, o utilizzando uno dei pulsanti Hotcue.

►► Si possono assegnare azioni speciali ad un Cue Point cambiando la sua tipologia 
tramite il Cue Type Selector. 	

Sono disponibili i seguenti tipi di Cue Point:
►► Cue (Cue Point Standard)

►► In (Cue Point in Fade In)

►► Out (Cue Point in Fade Out)

►► Load (Carica Cue Point)

►► Grid (Beatmarker)

►► Loop (Loop In Point)

% 
Il Cue Point corrente è sempre 
il punto d'inizio per lavorare con 

i cue point e per salvare i loop.

!
I Cue Point e Loop Management 
Panel non sono disponibili in  

	 TRAKTOR LE.

% 
Puoi salvare fino a 32 Cue point 
e Loop.
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6.7.3	 Tipi di Cue Point
Questa sezione provvede una descrizione dettagliata delle varie tipologie di Cue Point.

Fade In/Fade Out Cue Point
I Fade In e Fade Out Cue Point vengono utilizzati per il Cue/Play automatico di due tracce. 
Affinché possa funzionare, devi avere in precedenza impostato un Fade In Cue Point in 
un deck e un Fade Out Cue Point nell'altro.

►► In aggiunta, devi abilitare questa opzione in : Preferences > Loading > Loading.

Come funzionano:

1.	 Carica una traccia nel Deck A:

2.	 Scorri verso la fine della traccia.

3.	 Clicca Cue per spostare il Cue Point su questa posizione.

4.	 Clicca Store per convertire il Cue Point in un Cue Point salvato.

5.	 Scorri il Cue Type Selector e scegli Out dal menu.

6.	 Apparirà un Fade Out Point rosso all'interno del Waveform Display e nella Stripe.

7.	 Carica una traccia nel Deck B:

8.	 Imposta un Cue Point salvato all'inizio della traccia cliccando Store.

9.	 Scorri il Cue Type Selector e scegli In dal menu.

10.	 Apparirà un Fade In Point rosso all'interno del Waveform Display e nella Stripe.

11.	 Clicca il pulsante Cruise nella Global Section per attivare la modalità Autoplay.

12.	 Avvia la riproduzione della traccia nel Deck A poco prima del Fade Out Cue Point.

13.	 Quando il Fade Out Cue Point nel Deck A incontra la posizione di play, la traccia nel 
Deck B inizierà a suonare automaticamente dal Fade In Cue Point.

!
I tipi di Cue Point non sono dis-
ponibili in TRAKTOR LE.

Fade In

Fade Out
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Load  Cue Point
Una traccia con un Load Cue Point effettuerà il Cue in quel punto nonappena caricata, 
risparmiandoti dal dover impostare manualmente il cue.

►► Se desideri utilizzare i Load Cue Point devi abilitare la funzione Initially Cue to Load 
Marker in Preferences > Loading > Loading.

Beatmarker
Un Beatmarker imposta il punto di avvio di una Beatgrid. Questo è un Cue Point speciale a 
partire dal quale viene creata una griglia spaziata di riferimento. TRAKTOR utilizza queste 
griglie per sincronizzare le tue tracce. Sei pregato di consultare il capitolo 6.7.5 Beatgrid 
Panel (Grid Panel) per una spiegazione dettagliata dei Beatmarker e dei Beatgrid.

Loop Salvati
Il procedimento del salvataggio  dei Loop è fondamentalmente uguale a quello del 
salvataggio dei Cue Point.

1.	 Imposta un Loop dal Loop Panel (vedi capitolo 6.5 Controlli Loop).

2.	 Clicca su Store.

3.	 Gli indicatori del Loop diventano Loop In e Loop Out Point di colore verde ed il loop 
è ora salvato.

4.	 E' possibile accedere ai Loop salvati nello stesso modo dei Cue Point salvati.

Eliminare un Cue Point o un Loop salvato.
Se desideri eliminare un Cue Point o un Loop salvato in modo permanente, fai come segue:

1.	 Seleziona il Cue Point o il Loop dal menu a scorrimento o utilizzando i pulsanti 
Next/Previous.

2.	 Clicca su Delete (non è possibile annullare l'operazione).

3.	 Il Cue Point o il Loop In questione  ora è stato eliminato.

Load

Grid

Loop In

Loop Out
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6.7.4	 Hotcue e Hotcue Mapping
In TRAKTOR puoi assegnare ognuno dei Cue Point o Loop salvati ad uno degli 8 pulsanti 
Hotcue. Questo ti permette un accesso istantaneo ai tuoi Cue Point e Loop più importanti.

►► Salvando un Cue Point, lo si assegna istantaneamente al primo Hotcue disponibile. 
Clicca una seconda volta su Store per duplicare l'Hotcue.

►► Se desideri cambiare l'assegnazione, clicca sull'Hotcue assegnato e poi su Map, 
infine sul nuovo Hotcue.

►► Per eliminare un Cue/Loop In Point: seleziona il Cue/Loop In Point e clicca sull'icona 
Wastebin. Questo elimina il Cue/Loop Point in modo permanente.	

Come utilizzare gli Hotcue:
Il comportamento dei pulsanti Hotcue dipende dallo stato di playback della traccia.

►► Se il Deck sta suonando, clicca sul pulsante Hotcue per saltare al Cue/Loop In Point 
assegnato continuando la riproduzione.

►► Quando il Deck è in pausa, i pulsanti Hotcue si comportano nello stesso modo del 
pulsante Cue nel Transport Panel, cioè cliccandolo si sposta la posizione di play al 
Cue/Loop Point assegnato. Tenendo premuto il pulsante Hot Cue il playback continuerà 
fino al suo rilascio. In seguito al rilascio la posizione del playback torna indietro al Cue/
Loop Point e rimane in pausa. 	

% 
Questa funzione ti permette di 
salvare Cue Point e Loop in or-

dine non cronologico.

!
Hotcue e Hotcue mapping non 
sono disponibili in TRAKTOR LE.

 Fade In/Out

 Cue

 Load Loop

% 
Attiva Quant nel Master Panel 
per ottenere un Hot Cue 

Jumping assolutamente naturale.
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6.7.5	 Beatgrid Panel (Grid Panel)

Il Beatgrid è la base per creare loop perfetti. I Beatgrid si comportano da riferimento visivo 
per il DJ, indicando per una traccia una struttura del tempo visibile.

Il Beatgrid Panel (Grid) ti da controllo sul Beatmarker, Beatgrid e i BPM salvati per la 
traccia in questione.

Lavorare con i Beatgrid.
Per assicurarti che tutti i controlli di Tempo, Loop e Move funzionino senza sorprese,  
è necessario verificare i Beatgrid per le tue tracce.

1.	 Analizza una traccia (vedi capitolo 7.8.2 Analisi) e caricala in un Deck.

2.	 Clicca su “+” nel Waveform Display per ottenere una visuale più precisa.

3.	 Controlla il Beatmarker all'inizio della traccia. Se non risiede direttamente in battuta, 
usa i pulsanti Move Beatmarker per correggere l'errore. Oppure, puoi impostare  
manualmente un Beatmarker alla posizione che intendi utilizzando il Cue Panel.  
Per impostare un Auto Beatmarker, clicca sul pulsante Auto.

4.	 Sposta lentamente la traccia in avanti dal Beatmarker e controlla che la Beatgrid 
risieda correttamente sul Beat. In Snap Mode, puoi cliccare sulla Waveform per  
controllare in maniera acustica la posizione della Grid. Accendi Tick nel Master Panel 
(Global Section) per aiutarti in maniera acustica ad allineare la Beatgrid durante il 
playback. Usa i pulsanti Widen e Tighten Beatgrid per effettuare aggiustamenti più 
precisi. Ulteriori opzioni per effettuare aggiustamenti sono disponibili tramite i  
pulsanti "x2" e "/2" ed il pulsante Tap. Clicca due volte sul Tempo Display per inserire 
manualmente il tempo. 

5.	 Continua fino a che arrivi alla fine della traccia. Una volta che il Beatgrid risiede 
correttamente lungo tutta la traccia, clicca sul pulsante Lock Beatgrid ed ecco fatto 
- è stato definito un tempo esatto per la traccia in questione.

% 
Click del mouse sposta il 
Beatmarker di piccoli scatti, 

tasto destro/ctrl click di scatti più ampi.

	

% 
Click sinistro cambia la Griglia 
in piccoli scatti, tasto destro/

ctrl click in scatti più ampi.

% 
Se non vi è nessun Beatmarker 
impostato,  abilita Place 

AutoGrid-Marker in: Preferences > File 
Management > File Management > 
Analyze BPM Range. 
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Immagini Esemplificative

La Beatgrid è troppo stretta, devi allargarla.

La Beatgrid è troppo larga, devi restringerla.

Questo è un'esempio di Beatgrid perfetta.

Auto Beatmarker
TRAKTOR imposta automaticamente un Beatmarker sulla prima bass drum rilevata durante 
l'analisi. Quindi analizzando le tue tracce una prima Beatgrid viene costruita in base al 
tempo rilevato da TRAKTOR.

►► Clicca sul pulsante Auto per ricostruire la Beatgrid.

Beatmarker Manuale
Oppure, puoi impostare manualmente un Beatmarker alla posizione che preferisci  
utilizzando il Cue Panel.

1.	 Individua all'interno della traccia un movimento in battere adatto e sposta la posizione 
di play esattamente su di esso.

2.	 Clicca il pulsante Cue (Controlli Trasporto).

3.	 Nel Cue Panel scegli Store e poi il tipo di Cue, Grid.

4.	 Clicca due volte nel Cue Name Display per dare un nome al Beatmarker.

% 
Usa lo Snap Mode per posizion-
are il marker esattamente sul 

beat. Se il beat non è rilevato in maniera 
corretta, disattiva Snap Mode.
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Eliminare i Beatmarker.
E' possibile eliminare un Beatmarker dal Cue Panel. 

1.	 Naviga fino al Beatmarker utilizzando i pulsanti Next/Previous Cue Point, il menu a 
scorrimento vicino al Cue Name Display o cliccando il Gridmarker bianco nella Stripe.

2.	 Clicca il pulsante Delete per eliminare definitivamente il Beatmarker. 

Bloccare la Beatgrid.
Se Beatmarker e Beatgrid sono impostati, puoi bloccare il risultato ottenuto cliccando 
il pulsante Lock.

►► Dopo aver cliccato Lock tutti i pulsanti del Grid Panel vengono disattivati.

►► Il tempo salvato (BPM) viene bloccato e non lo si può cambiare a meno di sbloccarlo 
cliccando nuovamente il pulsante Lock.

►► Tutte le tracce con una Beatgrid bloccata sono contraddistinte dall'icona Lock 
nel Browser.

Tick (Beatgrid udibile)
Il Tick è fondamentalmente un metronomo impiegato per ottenere un feedback udibile 
riguardo la posizione della Beatgrid relativa alle battute della traccia.

►► Clicca il pulsante Cue.

►► Clicca sul pulsante Tick nel Master Panel.

►► Clicca nuovamente il pulsante Tick per disattivarlo.

% 
In External Mixer Mode sarà 
necessario in più attivare il pul-

sante Cue nell'Internal Mixer per poter 
ascoltare il Tick.
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7	 Utilizzare il Browser
Il design del Track Browser è in primo luogo pensato per aiutarti a gestire velocemente  
i tuoi brani tramite l'utilizzo delle Playlist.

7.1	 Importazione Tracce e Playlist

E' probabile che tu sia già in possesso di playlist di qualche tipo relative ai brani presenti 
nel tuo computer. Questo capitolo descriverà come importarle nella Collection di TRAKTOR. 

7.1.1	 Formati di File Musicali Compatibili
TRAKTOR SUPPORTA I SEGUENTI FORMATI DI FILE DI MUSICA:

►► MP3

►► AAC (M4A)

►► WAV

►► AIFF

►► WMA

►► FLAC

►► OGG Vorbis

! 
E' necessario installare Windows 
Media Player per poter utiliz-

zare file WMA in TRAKTOR.

! 
La riproduzione di file musicali 
protetti via DRM non è possi-

bile in TRAKTOR. Questo ha effetto sulle 
tracce AAC acquistate nell'iTunes Store. 
Per esempio, questo potrebbe essere il 
caso della musica acquistata nel iTunes 
Store.
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7.1.2	 Importare Cartelle di Musica
TRAKTOR è provvisto di una funzione di importazione di facile utilizzo per tutte le tracce 
presenti sul tuo disco fisso.

1.	 Click destro/ctrl click sulla icona della Collection nel Browser Tree.

2.	 Scegli Import Music Folders dal menu.

Questo procedimento importa tutti i file musicali contenuti nella cartella "Musica"  
del tuo sistema operativo.

Se hai archiviato le tue tracce in altre cartelle o su supporti di archiviazione dati esterni, puoi 
aggiungere queste cartelle alla lista delle cartelle di Musica di TRAKTOR facendo come segue:

1.	 Apri Preferences > File Management > Data Location.

2.	 Clicca su Add al di sotto della finestra di destra.

3.	 Sfoglia le tue cartelle di Musica.

4.	 Conferma con OK.

5.	 Ripeti l'operazione per aggiungere tutte le tue cartelle di Musica.

7.1.3	 Riprodurre Tracce gestite da iTunes
Se hai organizzato le tue tracce all'interno dell'applicazione iTunes, il browser di TRAKTOR 
ti fornisce un accesso diretto sia alla tua libreria iTunes che alle Playlist. 

1.	 Clicca sull'icona iTunes nel Browser Tree.

2.	 Sfoglia la Libreria e le Playlist come faresti con iTunes.

3.	 Carica una traccia nel Deck come faresti da una normale Playlist di TRAKTOR.

Note
Il Tree Node di iTunes è una rappresentazione di sola lettura della tua libreria iTunes e 
delle tue playlist. In questa visuale, non sono disponibili tutte le funzioni di editing. 

L'esecuzione di un brano dal Node di iTunes avvierà in maniera automatica la sua impor-
tazione nella Collection di TRAKTOR.

! 
Sottocartelle vengono incluse 
automaticamente nello scan e 

non è necessario aggiungerle alla lista.
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7.1.4	 Importare una selezione di tracce da iTunes
1.	 Clicca sull'icona iTunes nel Browser Tree.

2.	 Seleziona la traccia da importare nella Collection delle tracce.

3.	 Trascina la selezione sull'icona della Collection.

4.	 Oppure, click destro/ctrl click sulla selezione e scegli Add to Collection.

7.1.5	 Importazione di una playlist di iTunes
►► Clicca sull'icona iTunes nel Browser Tree.

►► Seleziona la playlist da importare.

►► Trascina la playlist sull'icona del Playlist Tree.

►► Oppure, click destro/ctrl click sulla selezione e scegli Import  to Playlists.

7.1.6	 Metodi di Importazione Alternativi
TRAKTOR ti offre altri metodi per importare singoli brani e cartelle speciali che non fanno 
parte della struttura tipica della cartella Musica.

►► Trascina una traccia o una cartella dal Finder del Mac o dall'Explorer di Windows 
sull'icona Collection all'interno del Browser Tree di TRAKTOR.

►► Trascina un brano o una cartella dall'icona dell'Explorer di TRAKTOR. Questa icona 
rappresenta tutti i supporti di archiviazione dati collegati al tuo computer. 

►► Puoi anche usare il click destro/ctrl click sulla traccia o cartella all'interno  
dell'icona di TRAKTOR Explorer e scegliere Add to Collection.

!
Ogni traccia riprodotta in 
un Deck verrà aggiunta alla  

	 Collection.



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 63  

7.2	 Ricerca Tracce (Search)

Inserendo del testo all'interno del Search Field (campo di ricerca), la lista visualizzata  
viene ristretta dinamicamente alle voci contenenti il testo digitato. Nota gli Hotkey seguenti:

7.2.1	 Filtro delle Playlist
1.	 Clicca sul Search Field o premi Ctrnl/Cmd ed F 

2.	 Digita alcuni caratteri relativi agli attributi della traccia (ad es. le prime lettere del titolo).

3.	 Mentre digiti, i risultati della ricerca al lato destro vengono ristretti alle tracce conte-
nenti la stringa di ricerca inserita.

4.	 Premendo TAB si ritorna al controllo Hotkey necessario per scorrere la lista dei risultati.

Note
►► Premendo il tasto Invio dopo aver inserito la stringa estende la ricerca all'intera 

Collection di tracce.

►► Premendo ESC si ripulisce la stringa e si esce dalla modalità di inserimento del testo.

►► Ognuna delle singole Playlist manterrà valori di ricerca indipendenti fino a che sa-
ranno ripuliti dalla rispettiva casella di ricerca.

7.2.2	 Raffinare una Ricerca
Puoi restringere la ricerca ad un sottogruppo di campi di metadata selezionando una delle 
opzioni dalla Refine list. 

1.	 Digita una parola all'interno del Search Field.

2.	 Clicca il pulsante Refine (lente di ingrandimento) dietro al Search Field e seleziona un 
campo dal menu a scorrimento. 

3.	 La lista è di conseguenza ristretta fino a indicare solamente brani in accordo ai criteri 
selezionati dal menu a scorrimento. 

!
Gli Hotkey non funzionano du-
rante la ricerca.
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7.2.3	 Ricerca di Tracce Simili
Nella Browser List, potrai notare che alcuni campi di metadata hanno una piccola icona a 
forma di Lente di Ingrandimento. Magnifying Glass icon. Cliccala per ricercare tracce che 
condividono la categoria di quello specifico campo di metadata.

►► Nella Browser List, clicca la Lente di Ingrandimento vicino al nome artista.

►► TRAKTOR cercherà tutti i brani che condividono le stesse informazioni all'interno 
del campo Artist.

►► Per allargare la ricerca all'intera Collection, click destro/ctrl click sulla lente 
di ingrandimento.

7.2.4	 Ricerca nelle Playlist
Puoi richiamare una lista di tutte le playlist contenenti una certa traccia.

►► Nella Browser List, click destro/ctrl click e seleziona Show in Playlists.

►► Viene visualizzata una lista di tutte le playlist contenenti questa traccia. 

►► Clicca su di una voce per scegliere una Playlist. Le voci vengono quindi visualizzate 
nella Browser List.

7.3	 Lavorare con le Playlist

Le Playlist sono un efficace metodo di organizzare i tuoi brani mentre ti prepari per un set. 
Fondamentalmente, la Playlist offre un mezzo di raggruppare le tracce in un determinato 
ordine con molti vantaggi rispetto alle classiche borse dei dischi. 

►► Una traccia può essere contenuta in molteplici playlist. 

►► Una playlist può venire rapidamente riorganizzata o ripristinata al suo stato originario. 

►► Ulteriori vantaggi sono: possibilità di salvare, caricare ed esportare la Playlist. 
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7.3.1	 Creazione di una Playlist

Metodo I:
1.	 Click destro/ctrl click sull'icona della cartella Playlist nel Browser Tree.

2.	 Seleziona Create Playlist dal menu contestuale.

3.	 Digita un nome per la tua nuova Playlist nella finestra. 

4.	 Conferma con OK.

5.	 La tua nuova Playlist apparirà sotto la cartella Playlist.

Metodo II:
1.	 Seleziona una o più tracce nella Browser List.

2.	 Trascinale sulla cartella Playlist nel Browser Tree.

3.	 Digita un nome per la tua Playlist nella finestra popup.

4.	 Conferma con OK. 

5.	O ra la tua nuova Playlist apparirà sotto la cartella Playlist.

7.3.2	 Aggiungere Tracce ad una Playlist
1.	 Clicca e tieni premuta una o più tracce.

2.	 Trascinale su di una playlist a tua scelta e continua a tenere premuto il mouse. 
La visualizzazione del Browser List cambia e visualizza la playlist di destinazione.

3.	 Se sposti il tuo mouse su di un contenuto della playlist ora, vedrai apparire una linea 
rossa che indica dove verrà inserita la traccia una volta rilasciato il mouse. 

! 
Questo comportamento viene 
visualizzato se la playlist segue 

il suo ordine originario. 

! 
Questo comportamento viene 
visualizzato se la playlist segue 

un ordine riorganizzato. 
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7.3.3	 Eliminare Tracce da una Playlist

Eliminazione delle Tracce da una Playlist
Ci sono due modi di eliminare tracce:

►► Clicca su una o più tracce premi DEL o Canc sulla tastiera del tuo computer.

►► Control Click/tasto Destro sulla traccia(e) e seleziona Delete

Eliminare Tracce da tutte le Playlist e dalla Collection:
1.	 Click sulla icona della Collection nel Browser Tree.

2.	 Control Click/tasto Destro sulla traccia(e) e seleziona Delete

3.	 Le tracce verranno rimosse dalle playlist della tua Collection.

Eliminazione delle Tracce dal disco fisso.
1.	 Click destro/ctrl click su di una traccia e seleziona Show in Finder (Mac) o Show in 

Explorer (Windows).

2.	 Elimina la traccia come se stessi eliminando ogni altro file dal tuo disco fisso.

3.	 Ripeti questa operazione per tutte le tracce che intendi eliminare.

4.	 Per rimuovere le tracce dalla tua Collection, click destro/ctrl click sulla Track Collection 
nel Browser Tree. Seleziona Consistency Check e clicca il pulsante Remove. 

! 
Eliminare tracce dalla Collection 
le cancellerà anche da tutte le  

	 Playlist.
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7.3.4	 Organizzazione delle Playlist.
Ci sono vari modi di riordinare e organizzare le Playlist. Cambiamenti all'ordine possono 
essere annullati cliccando sull header #.

Riordinare per colonne.
►► Clicca sul nome in cima alla colonna per ordinare la Playlist in base a questa  

categoria. Clicca una seconda volta per invertire l'ordine. 

►► Clicca sull'header della colonna # per ripristinare la Playlist al suo ordine originario.

►► Dopo aver riavviato TRAKTOR tutt le Playlist saranno ripristinate al loro ordine 
originario.

Consolidare un nuovo Ordine.
►► Clicca sul nome in cima alla colonna per ordinare la Playlist in base a questa categoria.

►► Per rendere questo nuovo ordine permanente, click destro/ctrl click sull'icona di  
questa Playlist e seleziona Consolidate.

Cambiare in modo Permanente la Posizione delle Tracce Selezionate all'interno della playlist. 
►► Ripristina la Playlist al suo ordine originario cliccando sull'header della colonna #. 

►► Seleziona una o più tracce e trascinale in alto o in basso all'interno della Playlist.

►► La linea rossa indica dove sarà rilasciata la selezione quando il mouse sarà a sua 
volta rilasciato. 

!
Questo è possibile solamente 
nel caso in cui la Playlist è 

organizzata secondo il suo ordine origi-
nario; è possibile ottenerlo cliccando 
sull'intestazione della colonna #.
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7.3.5	 Organizzazione delle Playlist in Cartelle
E' anche possibile l'opzione di organizzare ulteriormente le tue Playlist correnti creando 
una Cartella Playlist.

1.	 Click destro/ctrl click sull'icona della cartella Playlist nel Browser Tree.

2.	 Seleziona Create Folder dal menu contestuale.

3.	 Scegli un nome per la tua nuova Cartella e inseriscilo nella finestra seguente.

4.	 Conferma con OK.

5.	L a tua nuova Cartella Playlist apparirà sotto l'icona della cartella delle Playlist.

6.	 Ora puoi aggiungere delle Playlist in questa cartella trascinandovele sopra.

7.3.6	 Sottocartelle della Collection.
►► Le sottocartelle sotto la icona della Collection sono raggruppate in base ad Artista, 

Release, Label o Genere. Un numero indica la quantità di voci corrispondenti a  
ciascuna categoria.

►► Doppio click su una delle quattro voci per vedere un ulteriore visualizzazione di  
ogni categoria.

Esempio:
►► Cliccando due volte su Artists allargherà la Playlist fino a mostrare tutti gli artisti ed 

il numero di relativi brani presenti nella tua Collection.

►► Clicca su di un nome artista per visualizzare tutte le sue tracce nella Browser List.
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7.3.7	 Preferiti
La Finestra Favorites è uno strumento di navigazione collocato in cima al Browser. 
Se non sei in grado di vedere Favorites, vai su: Preferences > Layout Manager > Browser 
Details ed attiva Show Playlist Favorites.

Tre Favorites vengono assegnati in maniera automatica:

►► Track Collection

►► History Playlist

►► Preparation

Fai come segue per creare ed utilizzare un Favorite:
1.	 Clicca la cartella delle Playlist per sfogliarne il contenuto.

2.	 Clicca, tieni premuto e trascina il nome della Playlist al di sopra di una icona Favorite 
libera.

3.	 Ora puoi accedere alla Playlist in ogni momento cliccando sull'icona Favorite.

7.3.8	 Esportazione Playlist
L'esportazione di una Playlist genera una cartella contenente le tracce della Playlist come 
anche il Playlist file.   

Per esportare una Playlist:

1.	 Click destro/ctrl click sulla Playlist e seleziona Export Playlist dal menu contestuale.

2.	 Inserisci un nome per la playlist esportata.

3.	 Inserisci un percorso di destinazione.

4.	 Conferma con OK.

%
Puoi assegnare una qualunque 
cartella del File Browser o 

Playlist come Favorite.

!
Il trascinamento di una playlist 
su di un Favorite precedente-

mente assegnato sostituirà il precedente 
Favorite.
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7.3.9	 Importazione Playlist
E' possibile importare delle Playlist in vari modi:

Metodo I
1.	 Individua la Playlist nell'Explorer di TRAKTOR dentro il Browser Tree.

2.	 Trascina il file di playlist su di una delle cartelle delle Playlist nel Browser Tree o su 
di una Cartella Playlist da te creata.

3.	 La Playlist e tutte le tracce in essa contenute saranno aggiunte alla tua Track Collection.

Metodo II
1.	 Individua il file di playlist (*.nml) all'interno dell'Explorer di Windows o nel Finder di Mac.

2.	 Trascina il file di playlist su di una delle cartelle delle Playlist nel Browser Tree o su 
di una Cartella Playlist da te creata.

3.	 La Playlist e tutte le tracce in essa contenute saranno aggiunte alla tua Track Collection.

Metodo III
1.	 Click destro/ctrl click sulla cartella delle Playlist di TRAKTOR o di una Cartella di 

Playlist da te creata e seleziona Import Playlist.

2.	 La Playlist e tutte le tracce in essa contenute saranno aggiunte alla tua Track Collection.

7.3.10	 Stampa Playlist
La stampa delle playlist ti permette di salvare i contenuti dei brani delle Playlist in un 
formato leggibile da ogni web browser (HTML).

1.	 Click destro/ctrl click sull'icona della Playlist nel Browser Tree.

2.	 Seleziona Save as Webpage.

3.	 Inserisci un nome per la Playlist.

4.	 Inserisci un percorso di destinazione per il file esportato.

5.	 Dalla lista Options seleziona quali colonne intendi aggiungere al file.

6.	 Conferma con OK.

%
Puoi utilizzare questo metodo 
per importare Playlist da versio-

ni precedenti di TRAKTOR dopo averle 
esportate come spiegato in precedenza.
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7.3.11	 Ulteriori funzioni Playlist
Click destro/ctrl click su di una Playlist per trovare le seguenti funzioni aggiuntive:

►► Analyze: analizza le tracce contenute nella Playlist selezionata.

►► Rename: ti permette di rinominare la Playlist selezionata.

►► Clear Playlist: rimuove tutte le tracce dalla Playlist selezionata.

►► Delete Playlist: elimina la Playlist selezionata. Le tracce non verranno rimosse dalla 
tua Track Collection.

►► Reset Player State: rimuove tutte le icone delle Tracce dalla colonna Icone nella 
Browser List.

7.3.12	 History Playlist
TRAKTOR genera automaticamente un elenco delle tracce da te suonate durante una  
performance nella History Playlist. Spesso può tornare utile poter risalire a quali brani sono 
stati suonati in una occasione specifica.

Posizione di salvataggio della History playlist:
►► Dopo aver chiuso TRAKTOR, la History Playlist viene ripulita. In ogni caso, puoi  

trovare la Playlist salvata sotto: "Documenti\Native Instruments\Traktor\History” (Win) 
e “~/Native Instruments/Traktor /History (Mac)”.

►► La History Playlist viene nominata con la data e l'ora della relativa sessione. 
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Suggerimenti sull'uso di History Playlist
Pensa a re-importare la History Playlist dopo una buona sessione per utilizzarla  
nuovamente per gig futuri.

Se hai lavorato con TRAKTOR per un lungo periodo (pensa ad anni), le dimensioni delle 
History Playlist possono diventare molto grandi. Prova questo trucco:

1.	 Nell'Explorer sotto Windows o nel Finder (Mac) naviga la tua cartella di TRAKTOR ed 
apri History (Windows: Documenti\Native Instruments\Traktor\History; Mac: ~//Native 
Instruments/Traktor).)

2.	 Come regola approssimativa: ogni traccia presente in una lista occupa 1kb di spazio. 
Questo significa he tutte le Playlist di 5 o meno kb avranno meno di 4-6 tracce ciascuna.

3.	 Puoi eliminare i file più piccoli per poter sfogliare le History Playlist in maniera più 
realistica.

7.4	 Modifica dei Metadata della Traccia

Ogni traccia della tua Collection ha determinate proprietà ("Tags" o "Metadata") come Titolo 
Brano, Nome artista, Copertina etc.. TRAKTOR ti permette di modificare questi dati in 
due modi.

7.4.1	 Modifica delle Proprietà della Traccia in modalità Edit Inline
1.	 Nella Browser List, clicca su di una traccia per evidenziarla.

2.	 Clicca ancora nel campo che intendi modificare, per esempio il nome dell'artista. 

3.	 Vedrai apparire un cursore all'interno del rispettivo campo.

4.	 Modifica il nome dell'artista 

5.	 Clicca su di un altro campo di proprietà per modificarne il contenuto. 

6.	 Premi il tasto Invio sulla tua tastiera per uscire dalla modalità Editing Inline e conferma, 
o premi Esc per annullare le modifiche.

! 
TRAKTOR PRO scrive diretta-
mente i file tag sulla maggior 

parte dei tuoi file musicali! nota: .wav 
e .aiff non sono in grado di conservare 
metadata.

!
Le funzione di modifica dei 
metadata delle tracce non è 

disponibile in TRAKTOR LE

! 
Se stai utilizzando le funzional-
ità di iTunes si raccomanda di 

modificare i tag solo da iTunes!
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7.4.2	 Modifica delle Proprietà tramite la Finestra Edit
Non tutte le proprietà di una traccia sono visibili all'interno del Browser List. Per avere ac-
cesso a tutte le proprietà disponibili per una traccia, utilizza l'Edit Dialog. Questa finestra 
permette l'editing simultaneo di una selezione di tracce. 

Edit Dialog

Editing si una Singola Traccia
1.	 Seleziona una traccia nel Browser List cliccandola.

2.	 Click destro/ctrl click sulla traccia selezionata e seleziona Edit dal menu contestuale.

3.	 La Browser List si configura come Edit Dialog della traccia.

4.	 Modifica l'informazione desiderata per il brano.

5.	 Usa il menu a scorrimento vicino alle proprietà di una traccia per selezionare una delle 
proprietà precedentemente salvate nella tua Track Collection.

6.	 Usa il pulsante Restore per annullare tutti i cambiamenti effettuati Per applicare i cam-
biamenti, clicca il pulsante Apply oppure OK. Puoi annullare l'editing cliccando Cancel.
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Editing simultaneo di una selezione di tracce.
1.	 Se desideri modificare una selezione di tracce (per es. tutti i brani di un album), selezio-

nale e scegli Edit dal menu contestuale, (come per modificare una singola traccia).

2.	 Nell'Edit Dialog puoi notare che la maggior parte delle caselle vicino agli attributi non 
sono selezionati.

3.	 In fondo all'Edit Dialog puoi notare 3 nuovi pulsanti, rispettivamente Previous, Select 
All, e Next. Puoi usare questi pulsanti per sfogliare la tua selezione di tracce.

4.	 Le caselle indicano quali attributi condividono lo stesso valore per le tracce 
selezionate. Inoltre indicano anche che tutto ciò che verrà scritto nei rispettivi campi 
viene salvato nei metadata una volta applicati i cambiamenti.

5.	 Se desideri cambiare un attributo globalmente per tutte le tracce selezionate (per es. 
il nome dell'artista), assicurati che la casella sia selezionata e premi Applica o OK.

6.	 Se desideri modificare le tracce selezionate una ad una, usa il pulsante Previous e 
Next in fondo alla finestra per scorrere la lista.

7.	 Cliccando Restore si procederà all'annullamento dei cambiamenti.

8.	 Per annullare l'editing clicca Cancel.

7.5	 Icone Tracce

E' importante avere una visione d'insieme del tuo set se ti stai esibendo davanti ad un 
pubblico.

La colonna delle icone ti fornisce informazioni sullo stato di una traccia. E' possibile or-
ganizzarla secondo l'ordine dei messaggi di stato 

►► Le lettere A, B,C, e D identificano le tracce attualmente caricate nei Deck.

►► Un Check Mark significa che la traccia è già stata suonata in uno dei Deck.

►► Un Punto Esclamativo identifica tracce non trovate nella posizione precedentemente 
occupata dal file. Alcune delle ragioni potrebbero risiedere nella non disponibilità del 
supporto di archiviazione, oppure la traccia potrebbe essere stata spostata e rinominata.

►► Un simbolo Lock indica tracce con Beatgrid e Tempo bloccato.	
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Ordinare in base a questa colonna organizza le tracce come segue:
►► In cima le tracce già suonate.

►► Al centro tracce attualmente in esecuzione.

►► Tracce non ancora suonate al di sotto.

►► Tracce mancanti in fondo.

7.6	 Il Preview Player

Il Browser fornisce un Preview Player per effettuare il preascolto di tracce senza caricarle 
nel Deck. Il Preview Player è pensato per essere utilizzato in modalità Mixer Interno dal 
momento che il segnale originale viene inviato all'uscita Monitor. Per effettuare il preascolto 
di una traccia nel Preview Player:

►► Trascina una traccia dal Browser List al Preview Player.

oppure

►► Clicca la piccola icona Cuffie nella colonna preascolto del Browser List.	

►► Un vantaggio di utilizzare il Preview Player è che non si necessita di un Deck aggiuntivo.

►► Inoltre lo stato ed il conto della traccia non cambieranno.

►► Puoi mettere in pausa il Preview Player cliccando sul piccolo pulsante Play/Pause.

►► Spostati all'interno della traccia cliccando il piccolo Stripe.	

! 
Per utilizzare il Preview Player 
hai bisogno di una scheda au-

dio multi canale. Imposta un uscita per 
l'Out Preview in Preferences > Audio 
Setup > Output Routing.
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7.7	 Copertine

TRAKTOR ha varie funzioni relative alle copertine a tua disposizione. Non solo è possibile 
visualizzare le copertine all'interno del Browser, ma anche assegnare le tue copertine da 
file di immagine presenti nel tuo disco fisso.

7.7.1	 Mostra Copertine

Cover Art Window (Finestra Copertine)
TRAKTOR è provvisto di una finestra Cover Art al di sotto del Browser Tree. E' possibile 
attivarla o disattivarla dalle preferenze.

►► Preferences > Layout Manager > Browser Details e seleziona o deseleziona Show 
Cover Art.	

List Window
E' anche presente una colonna per le copertine all'interno del Browser List. Per attivarla 
o disattivarla:

►► Click destro/ctrl click sull'intestazione del Browser List e seleziona o deseleziona  
Cover Art.	
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7.7.2	 Modifica delle copertine
TRAKTOR ti permette di importare o eliminare copertine .jpeg dalla tua Track Collection.

Funziona come segue:

Import
1.	 Control Click/tasto Destro sulla traccia e seleziona Import Cover.

2.	 Usa la finestra per guidare TRAKTOR al file di immagine contenente la copertina.

3.	 Seleziona il file di immagine e conferma.

4.	 La copertina è ora salvata nel file stesso.

5.	 E' inoltre possibile scegliere varie tracce e importare copertine per tutte le tracce 
selezionate in una volta sola.

Delete
1.	 Control Click/tasto Destro sulla traccia e seleziona Delete Cover.

2.	 La copertina in questione è ora stata eliminata.

3.	 E' inoltre possibile scegliere varie tracce ed eliminare le copertine per tutte le tracce 
selezionate in una volta sola.	

!
La funzione di modifica delle 
copertine non è disponibile in  

	 TRAKTOR LE
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7.8	 Manutenzione Collezione

Lavorare con il Browser prima della performance o in una situazione dal vivo può risultare 
davvero stressante. Ci sono molte cose di cui tenere traccia, come la rimozione di brani 
obsoleti, individuare nuovamente brani che sono stati spostati in un altra cartella, etc. etc.

7.8.1	 Controllo Consistenza
Il Consistency Check Report provvede una visione complessiva della tua Track Collection 
fornendo opzioni per aiutarti a gestirla. 

►► Nel Browser Tree, click destro/ctrl click sulla icona della Track Collection e seleziona 
Check Consistency dal menu.

►► Una volta che TRAKTOR ha eseguito il controllo, apparirà il Consistency Check Report 
ed illustrerà i risultati ottenuti.	

Show Overview/issing tracks/Tracks to Analyze
Il Consistency Check Report ti da informazioni riguardo le seguenti cose:

►► Total Tracks: Il numero complessivo di tracce presenti nella tua Collection.

►► Tracks Missing: Il numero totale di tracce che sono state eliminate dal tuo hard disk 
o spostate dalla loro posizione originale.

►► Tracks Not Analyzed: Il numero totale di tracce che non sono state ancora analizzate.

►► Tracks Missing Stripe: Il numero totale di tracce che sono state importate ed 
analizzate ma la cui Overview Waveform (Stripe) è stata rimossa o spostata.

►► Total Tracks to Analyze: il numero complessivo di tracce che devono ancora essere 
analizzate.	
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Ritrovare tracce mancanti
Il Consistency Check Report ti permette anche di ritrovare le tracce della tua Collection 
mancanti.

1.	 Clicca il pulsante Relocate.

2.	 Ritrovare le tracce in una cartella contenente molte sottocartelle può rivelarsi un pro-
cesso estremamente lungo. Non temere di interrompere la ricerca - questa operazione 
non danneggerà in alcun modo la consistenza della tua Collection.

3.	 Utilizza il browser per navigare attraverso le cartelle dove le tracce mancanti sono 
state spostate. 

4.	 Per trovare molteplici tracce situate in diverse cartelle, seleziona la cartella di livello 
superiore rispetto a quelle dove essi sono situate. Puoi persino scegliere direttamente 
la cartella principale del tuo disco fisso.

Rimuovi le Tracce mancanti.
►► Se intendi eliminare dalla tua Collection le associazioni a queste tracce mancanti, 

elimina questi riferimenti cliccando sul pulsante Remove.	

Analizzare le Tracce
►► Se nella Collection sono presenti tracce non ancora analizzate, puoi farlo cliccando  

il pulsante Analyze.	

Show Consistency Check on Startup
E' possibile impostare il Consistency Check Report in modo che venga eseguito ogni volta 
che si procede all'avvio di TRAKTOR. Fai attenzione al fatto che questa operazione può 
aumentare il tempo richiesto da TRAKTOR per l'avvio, risultando perciò scomodo in una 
situazione dal vivo.   

1.	 Vai su:  Preferences > File Management > File Management.

2.	 Seleziona la casella intitolata Show Consistency Check Report on Startup e chiudi 
le preferenze.

3.	 Da ora il Consistency Check Report verrà eseguito ad ogni avvio di TRAKTOR.
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7.8.2	 Analisi
TRAKTOR si serve della funzione di analisi per reperire diversi ed importanti parti di  
informazioni dalle tue tracce. Esse sono:

BPM Estimate
►► Il BPM Estimate è una accurata lettura del tempo basato sul tipo di musica che stai 

analizzando. Per saperne di più sulla verifica del BPM Estimate e su come creare una 
Beatgrid consulta il capitolo 6.7.5	 Beatgrid Panel (Grid Panel).	

Gain Value
►► Ogni traccia ha un'ampiezza di volume percepito basato sulle sue proprietà musicali. 

Il Gain Value rilevato durante l'analisi è una calcolo accurato per determinare 
l'impostazione ottimale del Gain Knob del canale, in modo che possa corrispondere 
ad un ampiezza pari a 0dB.

►► Per utilizzare questa rilevamento del gain caricando una traccia in un Deck, abilita la 
funzione Auto Gain dalle preferenze.	

Stripe
►► Il procedimento di analisi genera una piccola rappresentazione della forma d'onda al 

di sotto del Wave Display (Stripe). In caso la Stripe di una traccia non sia presente, la 
traccia potrebbe non essere ancora stata analizzata.	

Auto Analysis
Puoi impostare TRAKTOR in modo che esso analizzi le tue tracce automaticamente una 
volta caricatele in un Deck o dopo averle importate nella tua Collection.

►► Apri Preferences > File Management > File Management per opzioni sull'analisi 
in background.

►► Puoi saperne di più sulle opzioni di analisi consultando il capitolo 14.10.1 (Analisi)	
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7.8.3	 Allocazione Dati
TRAKTOR è dotato di funzioni che generano e mettono in riferimento tra di loro specifici 
tipi di file. Questi tipi di file sono archiviati nelle loro directory di default. E' possibile 
cambiare questi percorsi dal menu Data Location Preferences qui:

►► Apri Preferences > File Management > Data Location.	

Puoi cambiare il percorso dei seguenti tipi di file cliccando sul pulsante con il punto es-
clamativo (...!):

►► Root Directory: il percorso del file che TRAKTOR segue per caricare e salvare le 
informazioni relative alla Collection e le sue impostazioni.

►► iTunes: il percorso dei file della tua libreria iTunes (questo percorso deve essere 
identico a quello delle impostazioni di iTunes).

►► Music Folders: utilizzalo per specificare la posizione della musica che deve venire 
analizzata utilizzando la funzione Import Music Folders.	

7.8.4	 Altre funzioni di Manutenzione
►► Reset Played State: Ripristina il conteggio dei play e l'icona della traccia a fianco 

di ognuna delle tracce già suonate. 

►► Relocate: Apre una finestra che ti permette di navigare la cartella contenente 
i brani mancanti. Questo può tornare utile se hai destrutturato una cartella musicale.

►► Analyze (Async): Avvia l'analisi per le tracce selezionate.

►► Show in Explorer/Finder: Usa questa funzione per trovare la traccia nell'Explorer di 
Windows o nel Finder del Mac.

►► Search in Playlist: Ricerca la traccia selezionata e presenta un rapporto che indica 
tutte le playlist contenenti la traccia selezionata.	



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 82  

7.9	 Lavorare con i CD Audio

7.9.1	 CD Text
In passato, le tracce dei CD Audio venivano visualizzate come Track01, Track02 etc. etc.

Ad ogni modo, se inserisci un CD Audio provvisto di relative informazioni su artista, titolo 
etc.. - sarai in grado di vedere questi dati nel Browser di TRAKTOR.

7.9.2	 CD Audio e Favorites
►► Se trascini l'icona del CD Audio su di un Favorite, il CD rimarrà assegnato al Favorite 

anche una volta rimosso.

►► Se nel lettore CD non si trova alcun CD, il Favorite sarà contraddistinto da una issing 
Icon, raffigurata come una croce rossa.	

7.9.3	 Espelli CD
E' anche possibile espellere un CD da TRAKTOR. 

►► Click destro/ctrl click sull'icona del CD Audio e seleziona Eject CD per espellerlo. 	

7.10	 Lavorare con Lettori MP3

TRAKTOR ti permette di riprodurre tracce dal tuo lettore MP3.

►► Avvia TRAKTOR e collega il tuo Lettore MP3 al tuo computer. TRAKTOR riconoscerà 
il tuo lettore MP3 come se fosse un disco fisso e la sua icona apparirà nel Browser 
Tree - questa operazione potrebbe impiegare fino a 10 secondi. 

►► Una volta selezionato il lettore MP3, appare il messaggio Loading per avvisarti che 
TRAKTOR sta leggendo le informazioni relative alle tracce ivi contenute. 

►► Una volta terminato il caricamento potrai selezionare i brani come faresti da un  
comune disco fisso.	

! 
Non tutti gli Audio Cd in com-
mercio sono forniti di queste 

informazioni testuali aggiuntive.

! 
Collegare e scollegare un let-
tore MP3 durante l'esecuzione 

delle tracce potrebbe causare una breve 
interruzione dell'audio. Fai attenzione 
a non scollegare il lettore MP3 mentre 
stai suonando una traccia salvata al suo 
interno!



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 83  

7.10.1	 iPod
Apple iPod utilizza un singolare sistema di archiviazione file per archiviare la musica. 
TRAKTOR riconoscerà l'iPod collegato al tuo computer e mostrerà l'iPod nel Browser 
contraddistinto dal proprio nome.

►► Clicca due volte sull'iPod per accedere alle playlist ed alle tracce archiviate al  
suo interno.

Note:
La riproduzione di file protetti acquistati su iTunes Store non è possibile.
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8	 Utilizzo del Mixer Interno e del Crossfader
Il Mixer Interno è il centro nevralgico di TRAKTOR. Tramite Mixer Interno è possibile 
controllare il mix e modulare il suono delle tue tracce per dare vita a transizioni naturali.

8.1	 Channel Fader

I Channel Fader servono a regolare il volume del canale. Il loro Channel Level Meter ti aiuta 
a regolare il volume della prossima traccia rispetto a quella attualmente in esecuzione.

►► I Channel Fader sono visibili solo in caso sia attivata la modalità Full Size (dimensione 
intera) per i Deck.	

8.2	 Crossfader

Il Crossfader ti permette di dare vita a transizioni fra i Deck trascinandolo da un lato all'altro.

8.2.1	 Pulsanti di Crossfader Assign
Con i pulsanti Crossfader Assign puoi decidere quale dei Deck è possibile ascoltare nella 
posizione di sinistra e di destra del Crossfader.

►► Un Deck che non è assegnato ad alcun lato del Crossfader viene controllato solamente 
dal Channel Fader.	

8.2.2	 Crossfade Manuale
►► Clicca, tieni premuto e trascina il Crossfader da un lato all'altro.

►► Oppure, puoi usare i pulsanti Crossfader Switch. Ad ogni click essi spostano il 
Crossfader nella loro rispettiva direzione.

►► Cliccando due volte sul Crossfader esso viene riportato alla posizione centrale.	

! 
Caratteristiche di Advanced 
Control sono descritte nel capi-

tolo 11.	 (Controllo Mouse per Fader e 
Knob).
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8.2.3	 Crossfade Automatico
Effettuare il Crossfade in maniera automatica è possibile utilizzando i  
pulsanti Crossfader Move.

►► Se clicchi su di un pulsante Crossfader Move, il Crossfader inizierà a sfumare da sé 
nella rispettiva direzione.

►► Per arrestare la transizione clicca nuovamente il pulsante Crossfader Move.

►► Puoi regolare il tempo di Auto Crossfade in Preferences > Mixer > Crossfader.	

8.3	 Equalizzatore

L'Equalizzatoe è un elemento di mixaggio estremamente importante. Esso modifica il 
suono del tuo mix in base alle frequenze.

Gli EQ knobs possiedono tutte le funzioni avanzate descritte nel capitolo 11 (Controlli 
Mouse per Fader e Knob).

8.3.1	 Tipi di Equalizzatore
TRAKTOR offre 4 tipi differenti di EQ, modellati secondo i migliori mixer da DJ oggi 
in commercio.

Per altri tipi di EQ, vai in Preferences > Mixer EQ > Selection.

Classic
Il Classic Equalizer è il classico standard EQ a tre bande di TRAKTOR 3. Fornisce il 
controllo per regolare Basse, Medie ed Alte frequenze per ognuno dei Deck.

Ogni knob controlla la rispettiva banda di frequenze di +12/-24 db. Inoltre provvede Kill 
Switches che tagliano totalmente la rispettiva frequenza una volta attivati. 

% 
E' sempre una buona idea utiliz-
zare gli EQ durante una tran-

sizione per evitare i clip che si possono 
facilmente verificare quando due tracce 
suonano insieme a tutto volume.
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P600
Il P600 è un Club DJ Mixer standard dotato di tre bande (Bassi, Medi e Alti). Funziona 
come il Classic EQ, ma offre una gamma di +12/-26 dB ed i Kill Switches tagliano le 
frequenze di -26 dB.

Nuo4
Nuo4 è un emulazione dell'EQ che si trova sul DJ mixer a quattro canali Ecler Nuo4. Esso 
è provvisto di un equalizzatore a 3 bande (bassi, medi, alti). Esso offre una gamma di 
+10/-30 per bassi e medi, +10/  -25 dB. per le alte frequenze. Come per i tipi di mixer 
Classic ed il P600 è provvisto di Kill Switches per tutte le frequenze, ma essi effettuano 
un taglio di -30/-25 dB.

XONE:92
XONE:92 è un'emulazione dell'EQ proprio del DJ Mixer Allen Heath XONE:92 La sua unicità 
è nell'includere un EQ a 4 bande (bassi, medio-bassi, medio-alti, alti). Alti e bassi sono 
dotati di attenuazione totale (total kill) con un roll off di 12 dB. I medi sono provvisti di 
un taglio di -30 dB.

8.4	 Gain, Cue e Pan

8.4.1	 Gain
Tramite il Gain Knob puoi controllare il livello pre fader dei singoli canali indicato dai 
Level Meter del Channel Fader. 

►► Il Gain è visibile solo in caso che la modalità Full Size (dimensione intera) sia attiva 
per i Deck.

►► TRAKTOR è inoltre dotato di una potente funzione di Autogain, che si può abilitare in 
Preferences > Mixer. Questa funzione si basa sui valori di Gain rilevati durante 
l'analisi delle tracce.	

!
L'EQ P600 non è disponibile in 
TRAKTOR LE.

!
L'EQ Nuo4 non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.

!
L'EQ XONE:92 non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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8.4.2	 Cue
Con il pulsante Cue puoi ascoltare il Deck tramite le uscite Monitor.

8.4.3	 Pan
Con il Pan Knob puoi controllare il bilanciamento fra il canale sinistro e quello destro per 
ciascun Deck in maniera individuale.

►► Il Pan Knob è visibile solo nel caso che la modalità Full Size (dimensione intera) 
dei Deck è attivata.	

8.5	 Filtro, Chiave e Insert Effetto

8.5.1	 Filtro
Il Filter Knob permette di controllare il filtro bipolare.

►► In posizione centrale, il filtro è inattivo.

►► Una rotazione del knob a destra attiva il filtro passa alti. A mano mano che lo sposti 
verso destra, attenuerai progressivamente le basse e medie frequenze.

►► Una rotazione del knob a sinistra attiva il filtro passa bassi. A mano mano che lo 
sposti verso sinistra, attenuerai progressivamente le medie ed alte frequenze.

►► In Preferences > Mixer > Filter Selection puoi scegliere tra Filter:92, che emula i filtri 
della serie Allen Heath Xone e Filter per un classico ladder filter.	

8.5.2	 Key
Con il Key knob puoi controllare il pitch di una traccia in esecuzione senza influenzarne il 
tempo. Il Key Control deve essere precedentemente attivato premendo il piccolo pulsante 
al di sotto di esso. 

►► In posizione centrale, la traccia viene eseguita all'intonazione originale.

►► Una rotazione verso sinistra o destra regola l'intonazione verso l'alto o verso il basso

! 
Per utilizzare la funzionalità Cue 
è necessario un dispositivo au-

dio multi canale. Cue è visibile solo se la 
visualizzazione del Deck a piene dimen-
sioni è attivata.

!
Il Key Knob non è disponibile in 
TRAKTOR LE.
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8.5.3 	 Effect Insert
I due pulsanti Effect insert presenti in ciascun canale inseriscono l'unità effetto all'interno 
della catena del segnale.

►► Puoi inserire entrambi le Effect Unit in un unico canale.

►► E' anche possibile inserire la stessa Effect Unit in più di un canale.

►► Inserisci una Effect Unit su tutti i canali per simulare un Master Effect.

►► Impostando la Effect Unit in modalità External Send, viene disattivato il rispettivo 
Insert Button.	

8.6	 Il Mixer Interno in Modalità Mixer Esterno

E' possibile utilizzare Traktor con un mixer esterno che sostituisce il mixer interno. Ad ogni 
modo, puoi comunque utilizzare alcune funzioni del mixer Interno anche in External Mode.

I controlli del Mixer Interno che non vengono usati quando si utilizza un mixer esterno sono 
situati nella strip interna. (EQ e Channel Fader). Questi controlli non sono attivi e vengono 
nascosti in Modalità Mixer Esterno.

I controlli del Mixer Interno che è possibile combinare con un mixer esterno sono situati 
nella strip esterna del mixer interno.

►► Il Filtro può venire combinato in maniera efficace con gli EQ del mixer esterno.

►► Key ed FX possono anche essere utilizzati in combinazione con un mixer esterno.

►► Il Gain knob ti permette di dare una ulteriore spinta al volume delle tue tracce.

►► Il pulsante Cue delle cuffie serve ad ascoltare il Tick su quel canale se Tick è attivato 
nel Master Panel.

►► Il Pan Knob è utile dal momento che non tutti i mixer hardware sono dotati di pan 
per ogni canale.	

! 
Gli Effect Insert non sono as-
segnabili ai singoli Effect Slot 

in Traktor Duo e Traktor LE.

% 
Lo spegnimento di un effetto 
tramite Insert Button arresta il 

processo di questa istanza dell'effetto 
per cui permette di risparmiare CPU.

!
L'External Send mode non è 
disponibile in TRAKTOR DUO 

	 e TRAKTOR LE.

! 
Il Master Volume Knob nel 
Master Panel funziona anche 

in External Mixer Mode e può servire 
per aumentare o diminuire il volume 
complessivo.
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9	 Utilizzo di TRAKTOR con un Mixer Esterno
TRAKTOR può sostituire completamente un setup da Dj, o semplicemente rimpiazzare i 
giradischi. In questo caso dovrai utilizzare TRAKTOR con un mixer esterno. Questa mo-
dalità ti permette di mixare le tue tracce digitali con il tocco analogico dei knob e dei fader  
del mixer hardware.

9.1	 Requisiti

I requisiti del tuo hardware dipendono dalla complessità del tuo setup.

9.1.1	 Mixer
In modalità External Mixer, ognuno dei Deck di TRAKTOR è assegnato ad uno dei canali 
del tuo mixer. Gli ingressi necessari per i Deck di TRAKTOR sono livelli di ingresso Line 
- come per i normali CD Player.

La configurazione più elementare utilizza due Deck in riproduzione e perciò necessita di 
un mixer a due canali.

L'aggiunta di un terzo e quarto Deck può ampliare questo setup. Ogni sorgente aggiuntiva 
ha bisogno di un ingresso aggiuntivo sul tuo mixer.

Una configurazione ancora più elaborata integra gli effetti send di TRAKTOR. Il loro uti-
lizzo non solo richiede un canale aggiuntivo sul tuo mixer ma anche una uscita send sul 
mixer da assegnare agli effetti direttamente da lì. Normalmente questa uscita viene con-
trollata tramite knob FX send o rispettivi pulsanti su ognuno dei canali del mixer.

% 
Puoi anche utilizzare la funzione 
Preview Player del Browser in 

External Mixer Mode. Questo richiede un 
ulteriore canale sul mixer.
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9.1.2	 Dispositivo Audio
Per collegare tutti i Deck al mixer è necessario un dispositivo audio con tante uscite per 
quanti Deck utilizzati. TRAKTOR non supporta due schede audio fianco a fianco, ma ci 
sono molti modi di aggregare due schede audio che permettono loro di comparire come 
una singola unità nella configurazione audio di TRAKTOR.

Se desideri utilizzare la funzione send effect, la scheda audio deve anche avere una uscita 
stereo aggiuntiva per gli effetti in mandata che giungono dal mixer.

Se sei in possesso di un numero di canali sufficiente sul tuo hardware, è anche possibile 
collegare il Preview Player ad una uscita separata della scheda audio.

TRAKTOR SCRATCH PRO
Se stai utilizzando TRAKTOR SCRATCH PRO, è necessario il dispositivo audio AUDIO 8 
DJ o un mixer  che certifica il supporto di TRAKTOR SCRATCH PRO.

% 
NATIVE INSTRUMENTS AUDIO 
8 DJ è specialmente pensato 

per soddisfare i requisiti di Traktor.
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9.2	 Configurazione Hardware

Questa parte descrive la configurazione dell'hardware in maniera generica. Il setup esatto 
dipende dall'hardware da te utilizzato.

1.	 In primo luogo accertati che il tuo dispositivo audio esterno sia installato in maniera 
corretta, connesso al tuo computer e funzionante.

2.	 Collega le uscite della tua scheda audio esterna agli ingressi del mixer. Ogni 
uscita stereo dell'interfaccia audio esterna viene collegata ad un ingresso stereo del  
mixer. Con Traktor Scratch Pro utilizza i cavi Multicore come descritto nel capitolo 13 
(Funzionalità TRAKTOR SCRATCH PRO).Collega le tue cuffie al mixer e le uscite del 
mixer all'amplificatore collegato alle tue casse.
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9.3	 Configurazione Software

All'avvio di TRAKTOR per la prima volta, il "Setup Wizard" ti permette di impostare 
la configurazione di base per la modalità Mixer Esterno. E' inoltre possibile effettuare 
gli aggiustamenti necessari dalle preferenze. Per fare ciò, apri Preferences > Audio 
Setup cliccando sull'apposito pulsante Preferenze o usa il Menu Applicazione e continua 
direttamente con lo step 3.

1.	 Nel "Setup Wizard" seleziona l'opzione mixer Esterno.

2.	 Conferma la tua selezione premendo il tasto OK. Questa operazione apre la pagina 
Audio Setup delle Preferenze. 

	

3.	 Usa la lista Audio Device per selezionare la scheda audio esterna. 

4.	 Imposta la latenza e la frequenza di campionamento su di un valore compatibile con 
il tuo sistema. Si consiglia di utilizzare in principio una latenza leggermente alta,  
intorno ai 15 ms.

5.	 Apri la pagina Output Routing per assegnare le uscite di TRAKTOR PRO alle uscite 
fisiche della tua scheda audio. 

% 
Per ora utilizza un'impostazione 
moderata. Puoi cambiarla in 

seguito e testare di che tipo di perfor-
mance è capace il tuo sistema.
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	 Verifica che la modalità External Mixer Mode sia selezionata.

6.	 Assegna le uscite A, B, C, D a tutte le uscite della scheda audio esterna collegate al 
mixer. Nota che è necessario collegare un paio di uscite ad ogni canale, cosicché il 
canale A sia di norma collegato alle uscite 1 e 2 della tua scheda audio, il canale B 
alle uscite 3 e 4 e così via. Per utilizzare degli effetti devi assegnare anche l'uscita 
Send (normalmente al canale collegato al fx return del mixer).

7.	 Se desideri utilizzare gli effetti send, avanza all'interno della pagina Input Routing e as-
segna l'Input Send. Normalmente a questa viene collegata l'uscita Send Out del mixer.

8.	 Chiudi le Preferenze cliccando il pulsante Close.

TRAKTOR SCRATCH PRO
Utilizzando TRAKTOR SCRATCH PRO devi anche aggiungere la configurazione Timecode. 
(vedi capitolo 14.3 Timecode Setup).
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10	 Utilizzo della Global Section
La Global Section di TRAKTOR contiene i Master Control. Inoltre ti permette di controllare 
gli effetti, il Master Clock e di avviare la registrazione dei tuoi mix.

10.1	 Master Panel

Il Master Panel al centro della Global Section fornisce i controlli di volume e riproduzione 
principali.

10.1.1	 Controllo di Volume Master
►► Il Master Volume Knob controlla l'uscita principale. 

►► La posizione di default (senza spinta ne' attenuazione) è ad ore 2.

►► Impostalo in modo che il Master Level dell'Header utilizzi in pieno la gamma  
dinamica disponibile. 

►► In modalità External Mixer il Master Volume Knob serve come gain globale per regolare 
l'uscita di TRAKTOR su livelli di ingresso ottimali per il mixer esterno.	

10.1.2	 Controlli Cuffie

PH Vol
►► Il Vol knob controlla il volume dell'uscita Monitor delle tue cuffie.	

Mix
►► Il Mix knob ti permette di mixare in cuffia il segnale in Cue con quello Master.
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Tick
►► Con il pulsante Tick puoi attivare un beat acustico che funziona come un metronomo 

e ti aiuta durante la creazione di Beatgrids.

►► E' possibile ascoltarlo solamente su segnali di cui si effettua il preascolto tramite 
cuffie (Modalità Internal Mixer).

►► In modalità External Mixer viene assegnato al segnale del canale se il tasto Cue sul 
mixer interno è attivo.	

10.1.3	 Control Modes
I Control Modes di TRAKTOR determinano il comportamento del mouse e del cue point 
durante la riproduzione, permettendoti una navigazione in Sync all'interno della traccia e 
regolazioni precise dei Cue Point. 

E' possibile attivare tutte le modalità in maniera indipendente. Esse funzionano in  
maniera globale per tutti i Deck. Quando sono attivi, i Mode Button (Snap, quant, CD Mode) 
diventano blu.

Snap Mode
In Snap Mode, la posizione di playback si sposta sempre al prossimo beat rilevato. 
L'attivazione di Snap ti aiuta a lavorare con precisione su di un beat mentre stai impostando 
i Cue Point ed i Loop.

►► Se Snap è attivo puoi impostare i Cue Point ed i loop solamente sui beat rilevati.	

Quantized Mode
Quant Mode ti permette di saltare fra Cue Point e Loop salvati senza interruzione e senza 
perdere il Sync. Funziona anche con gli Hotcue.

►► Spostarsi nella traccia in modalità Quantized porta la posizione di playback alla  
prossima destinazione ma senza perdere la sincronizzazione.

!
Lo Snap Mode non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

!
Il Quantized Mode non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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CD Mode
CD Mode emula il comportamento dei CD Player (prima dell'invenzione della jog  
wheel sensibile al tocco). 

Mettendo un Deck in pausa, viene suonato un breve loop stutter alla posizione di playback 
corrente. E' possibile spostare in avanti o indietro questo loop per regolare la sua posizione. 
Infine premendo Cue si imposta un Cue Point in quella posizione. Funziona così:

1.	 Attiva la modalità CD nel Master Panel.

2.	 Suona una traccia e naviga vicino alla posizione di playback dove intendi assegnare 
il Cue Point.

3.	 Metti in pausa la traccia cliccando su Play/Pause Ora il breve stutter loop è attivo.

4.	 Vai sul Move Panel, scegli Beat Jump Mode e attiva Fine.

5.	U sa i pulsanti Move nel Move Panel per spostare la posizione dello stutter loop.

6.	 Una volta trovata la giusta posizione per il Cue Point, clicca Cue nei controlli di 
Trasporto. Il loop si interrompe e il Cue Point attuale è in posizione.	

10.1.4	Modalità Cruise
La modalità Cruise ti permette di suonare automaticamente una traccia dopo l'altra da 
una playlist o dalla tua Track Collection.

Attivando Cruise gli si permette di iniziare a controllare senza interruzione il playback. 

►► La traccia in esecuzione continua a suonare. 

►► Il prossimo brano della playlist verrà caricato nel Deck opposto ed avviato automati-
camente da TRAKTOR una volta che la prima traccia giunge a termine. 

►► Di seguito il prossimo brano della Playlist verrà caricato e suonato automaticamente 
e così via.	

!
Il CD Mode non è disponi-
bile in TRAKTOR DUO e 

	 TRAKTOR LE.
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Note:
E' necessario che almeno una traccia sia in esecuzione per abilitare la modalità Cruise.

►► Per attivarla clicca sul pulsante Cruise nel Master Panel. 

►► Il Crossfader è impostato automaticamente in posizione centrale. 

►► Il Channel Fader della traccia in esecuzione è aperto mentre l'altro è chiuso. Alla fine 
della traccia in esecuzione la traccia andrà in dissolvenza e la prossima entrerà  
in Fade In.

►► Utilizza una playlist per generare un ordine delle tracce da eseguire automaticamente.

►► Puoi automatizzare la Modalità Cruise utiizzandola in combinazione con i marker Fade 
e Load per controllare le transizioni. Per prima cosa devi attivare Use Fade In & Out 
Markers in Preferences > Loading > Loading.

►► Puoi attivare manualmente la transizione al prossimo brano in ogni momento pre-
mendo il Channel Fader della traccia in esecuzione.	

10.2	 Pannello Master Clock

Il Master Clock è un componente centrale di TRAKTOR e funziona come riferimento 
temporale per gli effetti e per la funzione di Sync. Inoltre esso invia messaggi di Clock 
MIDI all'hardware ed al software esterno.

►► Per visualizzare il Master Clock Panel, clicca sulla icona Metronome sul lato sinistro 
della global section.	

10.2.1	Modalità
Il master Clock ha tre modalità operative attivati dai pulsanti Manual, Auto e Ext. In 
modalità Manual, il Master Clock scorre indipendentemente dai Deck, in Auto il Master 
Clock segue automaticamente il tempo di uno dei Deck in esecuzione. External Mode  
attiva il MIDI clock in modalità ricezione per sincronizzare TRAKTOR ad un segnale di 
MIDI Clock in arrivo da una sorgente esterna.

% 
La modalità Cruise funziona an-
che con un Mixer Esterno.

!
Il Master Clock Panel non è 
disponibile in TRAKTOR DUO 

	 e TRAKTOR LE.
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Auto Mode (Default)
►► In modalità Auto, il Master Clock segue sempre il tempo di uno dei Deck in esecuzione. 

►► In Auto Mode tutti i controlli di tempo manuali del Master Clock vengono disabilitati.

►► Il Master Clock determina automaticamente quale Deck è il miglior candidato per 
fungere da riferimento temporale. Su questo Deck viene automaticamente attivato il 
pulsante Master.

►► E' possibile cambiare il Deck che è stato prescelto automaticamente come  
riferimento temporale cliccando il pulsante Master su di un altro Deck.

►► Utilizzando il Master Clock in Auto Mode, non è richiesta alcuna interazione con  
il Master Clock Panel, per cui la visualizzazione del pannello non è necessaria.

Manual Mode
►► La modalità manuale è quello che dice la parola stessa: sei in controllo del Master Clock.

►► Il Tempo Display indica il tempo del Master Clock in BPM.

►► Una volta che un Deck è stato designato come tempo Master (premendo il tasto Master 
su quel Deck), l'area gialla all'interno del Tempo Display indica lo sfasamento del 
Master Clock rispetto a quel Deck.

►► Per regolare il tempo manualmente, trascina il valore visualizzato con il mouse, usa  
i tasti “+” and “-“ o effettua il tap del tempo con il pulsante Tap.

►► E' possibile utilizzare i pulsanti Pitch Bend come sui normali Deck per aggiustare 
il tempo del Master Clock.

►► L'opzione Tick fornisce un riferimento acustico al tempo del Master Clock nelle 
tue cuffie.
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External Mode
►► In External Mode il Master Clock viene controllato in maniera remota da un segnale 

di MIDI Clock ricevuto da una sorgente esterna.

►► Il Tempo del Master Clock indicato nel Tempo Display potrebbe aver bisogno di qualche 
secondo per attaccarsi al segnale di MIDI Clock. 

►► In questa modalità, tutti i controlli di tempo manuali del Master Clock vengono  
disabilitati.

►► I Deck di TRAKTOR possono essere sincronizzati al Master Clock come in Manual 
Mode premendo il pulsante Sync sul rispettivo Deck.

►► Per fare corrispondere i beat tra l'applicazione TRAKTOR PRO in trasmissione e 
quella in ricezione è necessario regolare lo sfasamento dell'invio del MIDI Clock 
nell'applicazione in trasmissione.

10.2.2	Invia MIDI Clock
La funzione MIDI Clock ti permette di sincronizzare l'hardware esterno al tempo delle 
tracce in esecuzione in TRAKTOR.

►► Per iniziare ad inviare segnale di MIDI Clock, clicca Start/Stop. Un ulteriore click 
interrompe l'invio. Se il MIDI Clock è attivo, il pulsante Start/Stop diventa blu.

►► Cliccando il tasto Sync, TRAKTOR fa partire un messaggio di MIDI Clock Stop 
immediatamente seguito da un messaggio di MIDI Clock Start per sincronizzare  
nuovamente l'hardware esterno.

►► Prima di poter inviare il segnale di MIDI Clock devi attivare Send MIDI Clock per il tuo 
dispositivo MIDI in Preferences > MIDI Setup.

►► Per fare corrispondere i beat tra l'applicazione Traktor Pro in trasmissione e quella in 
ricezione è necessario regolare lo sfasamento dell'invio del MIDI Clock nell'applicazione 
in trasmissione. 

% 
Per sincronizzare hardware es-
terno via MIDI Clock, il Master 

Clock deve essere impostato come 
Master Tempo Source.



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 100  

10.3	 Effect Panels
TRAKTOR è dotato di due Effect Unit individuali. I loro pannelli di controllo sono situati 
alla destra ed alla sinistra della Global Section. Per passare dal Master Clock o dall'Audio 
Recorder al rispettivo Effect Panel, clicca sui tasti FX1 ed FX2 su ciascuna estremità 
della Global Section.

E' possibile utilizzare come insert ognuna delle Effect Unit  in maniera individuale per ogni 
Deck di TRAKTOR, o su più di un Deck alla volta cliccando sui pulsanti FX Assign che si 
trovano nel mixer strip di ciascun Deck.

Gli effetti di Traktor sono di default effetti insert, sebbene sia possibile utilizzarli  
anche come effetti send.

E' possibile utilizzare ciascuna delle Effect Unit in 2 modi - Chained e Advanced, descritti 
qui di seguito. E' possibile cambiare la modalità in Preferences > Effects > FX Panel Mode.

10.3.1	Chained Mode

In Chained Effect Mode puoi utilizzare e controllare fino a tre effetti in un unico pannello. 
Funziona come segue:

►► Seleziona gli effetti che intendi utilizzare tramite Effect Selector (2).

►► Puoi accendere o spegnere ognuno degli effetti grazie ai 3 pulsanti Effect On (5) e 
controllarne l'intensità con l'Effect Amount Knob (3).

►► Puoi controllare il rapporto segale principale - segnale effettato per tutta la catena di 
segnale con il Dry/Wet Knob (1).

►► Puoi salvare una particolare impostazione come default tramite il pulsante Snapshot (4)

►► Per richiamare le impostazioni di default di un effetto, clicca due volte l'effect knob. 
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10.3.2	Advanced Mode

Advanced Effect Mode ti concede il pieno controllo su tutti i parametri di un singolo effetto.

►► Seleziona un effetto tramite Effect Selector (2).

►► Tramite Effect Parameter Knob da 1 a 3 (3) e tramite Effect Buttons 1, 2 (7) puoi 
modulare il comportamento dell'effetto selezionato. Le opzioni disponibili dipendono 
dall'effetto prescelto (vedi 15.5	Effetti in dettaglio).

►► Con l'Effect On Button (5) puoi accendere e spegnere l'effetto.

►► Il Dry/Wet knob (1) controlla il rapporto fra segnale ed effetto.

►► Puoi salvare una particolare impostazione come default tramite il pulsante Snapshot (4)

►► Il Reset Button (6) ripristina tutte le impostazioni dell'effetto del pannello alla posizione 
di default

10.3.3	Effetti Send
E' possibile utilizzare le Effect Unit anche in  modalità Send. Questa opzione è disponibile 
esclusivamente in External Mixer Mode (ed una scheda audio multi canale) ed occorre 
configurarla dalle preferenze:

►► Vai a Preferences > Audio Setup > Output Routing ed imposta Mixing Mode su exter-
nal. Poi imposta una uscita della tua scheda audio come Output Send. Questa uscita 
viene normalmente collegata all'ingresso FX Return del mixer esterno.

►► Vai avanti nella pagina Input Routing e assegna un ingresso della tua scheda audio 
come Input Send. Questa uscita viene normalmente collegata all'uscita FX Send del 
mixer esterno.
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►► Ora apri la pagina Effects delle Preferenze ed imposta Effect Routing per almeno una 
Effect Unit su External Send.

►► Il segnale audio che viene mandato agli Effect Slot viene ora interamente controllato 
dagli FX Send del mixer esterno (pulsanti o knob).

10.3.4	Note Generiche
►► Potresti voler utilizzare solamente una selezione di effetti disponibili. Puoi pre-selezi-

onarli da Preferences > Effects > Effect Pre-Selection. Solamente gli effetti pre-
selezionati sono ora accessibili dagli Effect Panel.

►► Ulteriori informazioni sui TRAKTOR Effect si trovano nel capitolo 15.5 (Effetti 
in Dettaglio).

10.4	 Pannello Audio Recorder

L'Audio Recorder in TRAKTOR serve per registrare i tuoi mix o una sorgente esterna, come 
per es. il tuo mix effettuato con un mixer esterno, un microfono ed un giradischi. Inoltre 
lo si può utilizzare per attivare il Broadcasting.

10.4.1	Registrare il tuo Mix
►► Prima di iniziare a registrare devi regolare le relative impostazioni in Preferences 

> Recording, specialmente per definire quale canale intendi registrare e dove vuoi che 
la registrazione venga salvata (vedi capitolo 14.8 Recording).

►► Per attivare l'Audio Recorder, clicca la Tape Icon a destra della Global Section.

►► Con il Gain Knob puoi regolare il livello della registrazione. Il Recording Meter ti aiuta 
ad impostare il livello ottimale.

►► Avvia la registrazione cliccando il Recorder Button rosso. Clicca nuovamente per 
interrompere la registrazione e salvare il file registrato nella cartella Audio Recordings.

►► Il display indica la grandezza attuale del file e la durata della registrazione.

!
L'Audio Recorder Panel non è 
disponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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►► Cliccando Cut, TRAKTOR salva la registrazione corrente ed inizia senza interruzione 
un nuovo file di registrazione.

►► Per eliminare la registrazione corrente, clicca il Delete Button.

10.4.2	Broadcasting
TRAKTOR ti da la possibilità di trasmettere il tuo mix o il tuo radio show in internet.

►► Per iniziare il broadcasting, attiva l'Audio Recorder Panel e clicca il Broadcast Button.

►► Il Broadcasting deve essere configurato in Preferences > Broadcasting. 
Le impostazioni richieste dipendono dal tuo network e dalle impostazioni del server.

►► Per ulteriori informazioni consulta il capitolo 15.4 (Broadcasting).
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11	 Controlli del Mouse per Fader e Knobs
Per semplificarti la vita controllando il software via mouse o touch pad, TRAKTOR sup-
porta una grande varietà di funzioni di controllo su schermo.

11.1	 Controlli di Base

Tutti i Knob e fader in TRAKTOR possono essere controllati trascinando il mouse, con la 
rotella del mouse o cliccando i piccoli tasti Plus e Minus a fianco a ciascun knob o fader. 
Trascinare il mouse è un ottimo metodo per effettuate cambiamenti dinamici, mentre i 
pulsanti Plus e Minus ti permettono regolazioni più sottili e sono più adatti per impostare 
un knob su di un valore specifico.

Trascinamento del Mouse
►► Sposta la freccia del mouse su di un knob o fader, poi clicca, tieni premuto e trascina 

il mouse verso l'alto o il basso. Così facendo sposterai il knob in senso orario o  
antiorario ed il fader verso l'alto od il basso.

►► Clicca due volte il knob o il fader per ritornare alle sue impostazioni di default.

Rotella del Mouse
►► Sposta la freccia su di un knob o fader ed usa la rotella del mouse per spostarlo 

verso l'alto o il basso, oppure in senso orario o antiorario.

Plus e Minus Buttons.
►► Quando passi con la freccia del mouse su di un knob o fader, appaiono dei piccoli 

tasti “+” e “-”.

►► Clicca su di essi per spostare il knob o fader e cambiare il suo valore a piccoli scatti.

% 
Clicca, tieni premuto e trascina 
un knob orizzontalmente. Sarà 

possibile regolare il knob con un range 
più sottile.
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11.2	 Advanced Control

Oltre alle funzioni standard del mouse chiarite precedentemente, TRAKTOR offre funzioni 
avanzate che utilizzano i tasti Plus e Minus, la rotella del mouse ed il tasto destro.

Sensitivities
TRAKTOR offre cinque tipi di sensibilità per il controllo a scatti dei parametri:

1.	 Un click destro/ctrl click sui tasti “+” or “-“ apre un menu con cinque opzioni di sen-
sibilità, min, fine, default, coarse, switch.

2.	 Seleziona una di queste opzioni.

3.	 Clicca i tasti Plus e Minus o usa la rotella del mouse per osservare come il compor-
tamento del knob o del fader è cambiato.

Funzioni Tasto destro/ctrl click 
1.	 Click destro/ctrl click, tieni premuto e trascina un knob o fader. Apparirà un Ghost 

Pointer grigio, ma il fader o il knob non si sposteranno.

2.	 Continua a premere il tasto destro, poi clicca il sinistro e tieni premuto. Così facendo 
porterai il knob o il fader al valore del Ghost pointer.

3.	 Continua a premere il tasto destro, e rilascia il sinistro. Il knob o fader ritornerà alla 
sua posizione originale mentre il Ghost Pointer grigio rimarrà visibile.

4.	 Se desideri che il knob o il fader rimangano al valore del Ghost Pointer, puoi semplice-
mente rilasciare il tasto destro dopo che il knob o il fader hanno raggiunto il valore 
del Ghost Pointer. Il Ghost Pointer grigio scomparirà, ed a questo punto puoi rilasciare 
anche il tasto sinistro.

% 
Se hai un track pad o mouse 
senza secondo tasto, puoi uti-

lizzare queste funzioni tenendo premuto 
il tasto Ctrl del tuo computer mentre 
clicchi il mouse.
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12	 Controllo tramite Hotkeys MIDI e Tastiera
E' possibile comandare tutti i controlli di TRAKTOR con la tastiera del tuo computer o con 
un controller MIDI. TRAKTOR utilizza file di impostazioni (*.tsi) per salvare le assegnazi-
oni della tua tastiera e dei controller MIDI.

12.1	 Keyboard  Hotkeys

I KEYBOARD HOTKEYS VENGONO UTILIZZATI PER CONTROLLARE TRAKTOR tramite 
la tastiera del tuo computer. TRAKTOR contiene una assegnazione standard con tutti i 
controlli di base caricati di default. Puoi trovare l'assegnazione di default illustrata nel 
flyer incluso. 

Per caricare un'altra assegnazione, fai come segue: 

1.	 Apri Preferences cliccando sull'apposito pulsante Preferenze o usa il Application > 
Menu File > Preferences.

2.	 Clicca Import.

3.	 Naviga fino a Document\Native Instruments\Traktor\Settings (PC) o ~/Native 
Instruments/Traktor/Settings (Mac) e scegli il file nominato “[settingsfilename.tsi]”.

4.	 Conferma e chiudi le preferenze.

5.	 Usa la tastiera del tuo computer per controllare TRAKTOR.

►► Puoi trovare una spiegazione su come creare le tue assegnazioni nel capitolo 15.1 
(Hotkey e MIDI Mapping).

►► Cliccando Application Menu > Help >Downloads la pagina di Download di TRAKTOR 
PRO del sito internet di NATIVE INSTRUMENTS si aprirà automaticamente. Da lì è 
possibile scaricare altre numerose assegnazioni per tastiera. 

% 
Puoi anche utilizzare una com-
binazione di azioni del mouse, 

tastiera e MIDI Hotkey per controllare 
TRAKTOR.

!
I Keyboard Hotkey non sono 
disponibili in TRAKTOR DUO e 

	 TRAKTOR LE.
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12.2	 MIDI Hotkey

TRAKTOR funziona con tutti i controller MIDI ed è provvisto di file di configurazione per 
i più diffusi controller MIDI in commercio.

Per configurarli fai come segue: 

1.	 Collega il controller MIDI al tuo computer come descritto nel suo manuale.

2.	 Apri Traktor e vai su Preferences > MIDI Setup.

3.	 Attiva il tuo controller cliccando due volte sulla colonna Active in MIDI Input Devices 
e MIDI Output Devices.

4.	 Clicca il pulsante Import nell'angolo in basso a sinistra della finestra Preferenze.

5.	 Naviga fino a Document\Native Instruments\Traktor\Settings (PC) o ~/Native 
Instruments/Traktor/Settings (Mac) e scegli il file nominato “[settingsfilename.tsi]”.

6.	 Conferma e chiudi le preferenze.

7.	 Usa il tuo MIDI controller per controllare TRAKTOR.

►► Se non trovi inclusa nessuna configurazione per il tuo controller o se desideri impostare 
le tue assegnazioni personali, puoi trovare una spiegazione su come creare le tue as-
segnazioni nel capitolo 15.1 (Hotkey e MIDI Mapping).

►► Cliccando Application Menu > Help >Downloads aprirai la pagina di Download di 
TRAKTOR PRO del sito internet di NATIVE INSTRUMENTS. Da lì è possibile scaricare 
altre numerose assegnazioni MIDI. 

!
I MIDI Hotkeys non sono dis-
ponibili in TRAKTOR LE.

% 
L'Indicatore MIDI nell'Header 
si accende nonappena viene 

ricevuto qualche messaggio MIDI.
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13	 Funzionalità TRAKTOR SCRATCH PRO
Questo capitolo spiega come configurare TRAKTOR SCRATCH PRO

13.1	 Configurazione del Giradischi

13.1.1	 Collegare i Giradischi con i Cavi Multicore

Collegare i cavi Multicore ad AUDIO 8 DJ.
►► Nella confezione sono presenti 2 set di cavi Multicore, ognuno dei quali comprende 

2 segmenti che è possibile collegare ad un connettore XLR a 7 pin.

►► Ognuno dei 2 Set di Cavi Multicore serve per collegare un giradischi Timecode  
a TRAKTOR.

►► Usa una delle sezioni più corte dei cavi con i connettori RCA rosso, nero, giallo e  
bianco e collega questi ultimi a quelli dello stesso colore che si trovano sul retro di 
AUDIO 8 DJ.

►► Ripeti l'operazione con il secondo dei cavi più corti e collegalo allo stesso modo al 
CHANNEL B di AUDIO 8 DJ.

Collegare i cavi Multicore ai tuoi giradischi e Mixer. 
►► Prendi uno dei segmenti del cavo più lunghi provvisto di connettori rosso e bianco. 

►► Scollega i cavi RCA del giradischi di sinistra dal tuo mixer e collegalo all'RCA  
femmina sul segmento del cavo, contrassegnato come "Player TT/CD".

►► Collega i due connettori RCA indicati come "Mixer TT/CD" negli ingressi phono del 
mixer appena liberatisi scollegando il giradischi. 

►► Collega i due connettori RCA indicati come "Mixer Line/In" negli ingressi Line del 
mixer nello stesso canale del tuo mixer hardware.

►► Ripeti l'operazione con il secondo paio di sezioni del cavo più lungo ed il giradischi destro.
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13.1.2	 Giro di prova con TRAKTOR SCRATCH PRO e Giradischi
►► Metti i Control Record sui giradischi.

►► Cambia l'impostazione del tuo mixer da Phono a Line. 

►► Imposta l'Input Mode di AUDIO 8 DJ per i canali A e B su Timecode Vinyl  
selezionando la rispettiva modalità con il tasto Input Mode sul pannello frontale.

►► In TRAKTOR PRO, clicca sulla freccia verso il basso al di sotto della lettera che  
indica il Deck e assicurati che come sorgente input sia selezionato Scratch Control. 

►► Carica una traccia dalla Demo Playlist nel Deck A ed avvia il giradischi.

►► TRAKTOR SCRATCH PRO inizia la calibrazione, l'Absolute Mode Button diventa blu e 
la traccia inizia a suonare.

13.1.3	 Le Zone di Controllo su Vinile
Il Control Vinyl consiste delle seguenti tre zone, ognuna con distinte funzioni di playback.

Lead In - I primi solchi del disco
Appoggiando la puntina all'interno della Lead Zone del disco si salterà all'inizio della traccia. 

Se la rispettiva opzione nelle Preferenze è attiva, puoi utilizzare questa funzione per  
tornare all'inizio di una traccia quando stai suonando in Relative Tracking Mode - il tipo di 
tracking passa ad Absolute Mode, rendendo possibile posizionare nuovamente la puntina.

Playback Zone - la parte principale del disco 
Quest'ultima à suddivisa in 10 tracce sul lato A e 15 sul lato B. Questa zona viene  
utilizzata per il normale playback. Le divisioni sono indicatori del tempo che non influ-
enzano la continuità del playback della traccia caricata. 

% 
Se la tua traccia supera i 10 
minuti della Playback Zone 

continuerà normalmente a suonare nella 
Scroll Zone - devi sollevare e appoggiare 
nuovamente la puntina per interrompere 
il playback e passare alla modalità Scroll. 
Anche se raggiungi la fine di un disco, 
la traccia continuerà  suonare dal mo-
mento che alla fine c'è un groove infinito 
(Locked Groove).
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Scroll Zone - Le ultime due tracce del disco
Appoggiare la puntina nella Scroll Zone ti permette di sfogliare la tua playlist spostando 
manualmente il disco in avanti e all'indietro. 

Interrompendo il movimento del disco, viene caricata la rispettiva traccia. 

Per suonare la traccia selezionata, è sufficiente posizionare il braccio del giradischi nuo-
vamente nella Playback Zone.

13.2	 Configurazione del lettore CD

13.2.1	Collegare i lettori CD con i Cavi Multicore

Collegare i cavi Multicore ad AUDIO 8 DJ.
►► Nella confezione sono presenti 2 set di cavi Multicore, ognuno dei quali comprende 

2 segmenti che è possibile collegare ad un connettore XLR a 7 pin.

►► Ognuno dei 2 Set di Cavi Multicore serve per collegare un CD Player Timecode a 
TRAKTOR.

►► Usa una delle sezioni più corte dei cavi con i connettori RCA rosso, nero, giallo e  
bianco e collega questi ultimi a quelli dello stesso colore che si trovano sul retro di 
AUDIO 8 DJ.

►► Ripeti l'operazione con il secondo dei cavi più corti e collegalo allo stesso modo al 
CHANNEL B di AUDIO 8 DJ.

Collegare i cavi Multicore ai tuoi CD Player e Mixer. 
►► Prendi uno dei segmenti del cavo più lunghi provvisto di connettori rosso e bianco. 

►► Scollega i cavi RCA del CD Player di sinistra dal tuo mixer e collegalo all'RCA  
femmina sul segmento del cavo, indicato come "Player TT/CD".

►► Collega i due connettori RCA indicati come "Mixer TT/CD" negli ingressi Line del 
mixer appena liberatisi scollegando il CD Player. 
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►► Collega i due connettori RCA indicati come "Mixer Line/In" negli ingressi Line del 
mixer nello stesso canale (!) del tuo mixer hardware.

►► Ripeti l'operazione con il secondo paio di sezioni del cavo più lungo ed il giradischi 
destro.

Utilizzando i CD Player potresti ritrovarti con un numero di connessioni LINE  
insufficienti sul tuo mixer. In questo caso sei costretto a lasciare scollegati i connettori 
RCA del cavo Multicore indicati come "Mixer TT/CD" o è necessario collegarli ad un altro 
canale disponibile sul mixer.

13.2.2	Giro di prova con TRAKTOR SCRATCH PRO e Lettori CD
►► Inserisci i Control CD nei tuoi lettori CD.

►► Assicurati che il tuo mixer sia impostato su Line Channel lì dove il cavo è collegato. 

►► Imposta l'Input Mode di AUDIO 8 DJ per i canali A e B su Timecode CD selezionando 
la rispettiva modalità con il tasto Input Mode sul pannello frontale.

►► Carica una traccia dalla Demo Playlist nel Deck A ed avvia il CD Player.

►► TRAKTOR SCRATCH PRO inizia la calibrazione, l'Absolute Mode Button diventa blu e 
la traccia inizia a suonare.

13.2.3	Le Zone Controllo su CD
Il Control CD consiste delle seguenti tre tracce, ognuna con diverse funzioni di playback.

CD Track #1: Lead In – (0:04 min) 
L'avvio della CD Track #1 sposterà la traccia caricata sul Lead In. Se la rispettiva opzione nelle 
Preferenze è attiva, puoi utilizzare questa funzione per tornare all'inizio di una traccia quando 
stai suonando in Relative Tracking Mode - il tipo di tracking passa ad Absolute Mode.

CD Track #2: Playback Zone – (27:30) 
Questa traccia viene utilizzata per il normale playback.

! 
Se li lasci scollegati, perdi la 
possibilità di suonare un nor-

male CD Audio da quel particolare CD 
Player. 
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CD Track #3: Scroll Zone – (2:30) 
Avviare la traccia #3 ti permette di scorrere in alto ed in basso la tua playlist, girando 
manualmente la jog wheel del tuo lettore CD. 

Interrompendo il movimento della jog wheel, viene caricata la rispettiva traccia. Per suonare 
la traccia selezionata, avvia semplicemente la traccia # 1 del CD.

13.3	 Calibrazione 

La calibrazione è necessaria per i seguenti motivi:

►► Rilevamento del tipo di media (vinile o CD), come anche lato del vinile suonato.

►► Rilevamento del livello di ingresso del segnale di controllo.

►► Rilevamento del collegamento e della qualità del segnale, e se sia sufficientemente 
buona per effettuare il tracking.

►► Correzione di un eventuale inversione dei canali.

Il decoder invia in uscita una serie di messaggi che definiscono il risultato del processo 
di calibrazione:

►► Vinyl 10/15 Min: Rilevato il lato del disco di Timecode.

►► CD: Rilevato Timecode CD.

►► Left/Right Ch. Missing: Uno dei canali è assente. TRAKTOR SCRATCH PRO funziona 
solo in modalità emergency; è possibile solamente il playback in avanti.

►► Waiting: TRAKTOR SCRATCH PRO sta aspettando di ricevere un segnale in ingresso 
per la calibrazione. 

►► Calibrazione: TRAKTOR SCRATCH PRO sta decodificando il segnale in ingresso.

►► Calib. Failed: la calibrazione non ha avuto successo.

►► Skipping: il vinile o CD contenente il Timecode salta.

►► Browsing: sei nella Scroll Zone.

Puoi fare ripartire la Calibrazione ogni volta che clicchi sul pulsante ON sull'icona della 
calibrazione.

% 
Se la tua traccia supera i 27:30 
minuti della Playback Zone 

continuerà normalmente a suonare nella 
Scroll Zone - devi avviare manualmente 
la track #3 per attivare la modalità 
Scroll. Anche se la tua traccia supera 
i 30 minuti, continuerà a suonare in 
Internal Mode.
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13.4	 Modalità di Playback Tracking

13.4.1	Internal Mode
Internal Playback significa che puoi controllare il playback tramite il tasto Play ed il pitch 
fader software, indipendentemente dei giradischi esterni o CD Player.

13.4.2	Absolute Mode
E' possibile attivare Absolute Playback Tracking Mode premendo il pulsante raffigurante un 
disco ed il braccio del giradischi. Questa azione collega in maniera assoluta la posizione 
del giradischi sul disco alla posizione di playback della traccia. Ogni azione del braccio 
del giradischi ha effetto diretto sul playback della traccia in TRAKTOR SCRATCH PRO, sia 
che si muova in avanti o indietro il disco, sia che si sposti la puntina su di un'altra parte 
del disco (Needle Drop).

13.4.3	Relative Mode
Una volta in Absolute Tracking Mode, premi il tasto Loop a destra del tasto Absolute 
Tracking. Potrai notare quanto segue:

1.	 Il playback della traccia inizia ad effettuare il loop della parte attuale del brano.

2.	 Playback Mode ora è cambiato ed il relativo tasto raffigura solamente un disco. Questa 
modalità si chiama Relative Tracking Mode.

Mentre il software inizia a riprodurre in loop la stessa parte del brano, la puntina del 
disco si sposta in avanti generando un crescente sfasamento rispetto al software. Per 
questo motivo il software ignora la posizione della puntina e rileva solamente la velocità di  
rotazione del disco.
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13.5	 Ulteriori Informazioni

Per ulteriori informazioni riguardo AUDIO 8 DJ sei pregato di fare riferimento al suo manuale.

Se hai problemi con la configurazione di TRAKTOR SCRATCH PRO sei pregato di  
consultare il capitolo 17.3 (Risoluzione dei problemi di TRAKTOR SCRATCH PRO).
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14	 Preferenze
TRAKTOR è dotato di numerose opzioni per personalizzarne il setup. Il capitolo seguente 
descrive tutte le opzioni in ordine di apparizione.

14.1	 Audio Setup

14.1.1	 Audio Setup

Audio Device
Sei pregato di scegliere un dispositivo audio. Se nessun dispositivo audio è attualmente 
selezionato, puoi sempre selezionare la scheda audio interna come dispositivo audio.

Sample Rate
Scegli una frequenza di campionamento in relazione alla tua scheda audio. Nota che  
frequenze di campionamento più alte causano un maggiore affaticamento del tuo computer. 
Il valore standard è 44100 kHz.

Audio Latency
Seleziona una latenza audio adatta al tuo sistema. Valori più bassi fanno lavorare di più il 
tuo computer ed un impostazione troppo bassa può causare interruzioni del segnale audio 
e altri comportamenti indesiderati. 
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14.1.2	Output Routing

Mixing Mode
Seleziona Internal Mixing Mode se desideri utilizzare il Mixer Interno di TRAKTOR.   

La modalità Internal Mixing ti da accesso alle seguenti opzioni:

►► Output Monitor: Scegli una coppia di uscite per effettuare il preascolto delle tue tracce.

►► Output Master: Scegli una coppia di uscite per l'uscita master.

►► Output Record: Scegli una coppia di uscite per la registrazione audio. Le Recording 
Output vengono utilizzate per inviare il segnale dell'uscita master da TRAKTOR ad un 
ingresso separato del mixer o del registratore per registrare il tuo mix. 

Seleziona External Mixing Mode se desideri utilizzare un mixer hardware esterno. 

La modalità External Mixing ti da accesso alle seguenti opzioni:

►► Output Channel A/B/C/D: Scegli una coppia di uscite per ciascun Deck. Le impostazi-
oni effettuate qui dipendono dalla tua scheda audio.

►► Output Preview: Seleziona una coppia di uscite per il Preview Player.

►► Output Send: Seleziona una coppia di uscite per utilizzare effetti send.	

Clicca su Mono per unire i canali in modalità mono.

! 
In Internal Mixing Mode il 
Monitor Channel è anche il ca-

nale che trasmette il segnale del Preview 
Player del Browser.
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14.1.3	 Input Routing

Input Channel A-D
Usa questo menu per configurare TRAKTOR in modo da utilizzare i vari ingressi della tua 
scheda audio per segnale proveniente da un dispositivo esterno. Gli indicatori di volume 
alla destra del selettore di input indicherà il livello di segnale se segnale è presente.

Input Send
Seleziona qui una coppia di ingressi per l'utilizzo degli effetti send.

Swap Input Channel
Clicca sui rispettivi tasti per scambiare i canali A, B, C e D.

14.2	 MIDI Setup

Una volta installati i driver per il tuo dispositivo MIDI, esso apparirà in questa sezione. 
TRAKTOR supporta l'uso di molteplici dispositivi MIDI.

14.2.1	MIDI Input Devices
Attiva un dispositivo MIDI in ingresso cliccando due volte sulla rispettiva riga.

14.2.2	MIDI output Devices
Per utilizzare le caratteristiche MIDI Out di TRAKTOR, per es. accendere i LED sul tuo 
MIDI controller, attiva il rispettivo dispositivo MIDI cliccando due volte sulla sua riga. Nella 
maggioranza dei casi nella lista degli Input Device e in quella degli output Device apparirà 
un controller con lo stesso nome .

! 
Se il tuo dispositivo MIDI non 
appare all'interno della lista, 

potrebbe essere necessario riavviare 
TRAKTOR per permettergli di ricon-
oscerlo. Così facendo, assicurati che il 
tuo dispositivo MIDI sia collegato ed ac-
ceso.

!
Il MIDI setup non è disponi-
bile in TRAKTOR DUO e 

	 TRAKTOR LE.
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14.2.3	MIDI Clock Settings

Send MIDI Clock
Se questa opzione è attiva, TRAKTOR invierà un segnale di MIDI Clock al dispositivo 
selezionato.

MIDI Clock Send Offset
Qui puoi configurare il tempo di offset per il segnale di MIDI Clock.

14.3	 Timecode Setup

Timecode Inputs
Le figure del Control Signal ti danno un'idea di base sulla qualità del Control Signal.

Decoder Gain
Qui viene indicato il volume del segnale Timecode in ingresso. Un gain più alto implica  
di norma un migliore tracking.

Assign to Decks
Tramite questi pulsanti è possibile assegnare i segnali di Timecode ai canali di TRAKTOR. 
Puoi assegnare un segnale a svariati Deck per controllare più di un Deck con un solo CD 
Player o giradischi.

! 
Le opzioni di Scratch sono solo 
disponibili se sei in possesso di 

una licenza TRAKTOR SCRATCH PRO. 
E' necessario installare l'hardware rich-
iesto.

!
Il Timecode Setup non è dis-
ponibile in TRAKTOR LE.
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Tracking
Track Start Position: Puoi scegliere la posizione d'inizio da qui. Questo è utile se desideri 
marcare il tuo disco con uno sticker lead-in, oppure se l'inizio del disco è rovinato o graffiato.

Turntable Speed: Seleziona la modalità 45 giri se la preferisci a quella a 33 RPM.

Tracking Alert: Se il segnale di Timecode peggiora pericolosamente, i pulsanti di tracking 
iniziano a lampeggiare in rosso.

Load next track when flipping record: Con questa opzione, puoi caricare la prossima 
traccia della Playlist girando il disco.

Use Playlist Scrolling Zone: con questa opzione attivata, puoi abilitare lo scorrimento della 
Playlist. Per saperne di più sullo scorrimento della Playlist consulta il capitolo 13.1.3	(Le 
Zone di Controllo su Vinile) e 13.2.3 (Le zone di controllo su CD).

Switch to Absolute Mode in lead-in: Posizionando la puntina sulla zona di Lead-In del Control 
Vinyl o leggi la prima traccia del Control CD, la modalità di tracking passa ad Absolute Mode.

Switch to Absolute Mode when Loading: Quando si carica una traccia, la modalità di track-
ing passa sempre ad Absolute Mode.

14.4	 Loading

Loading
►► Loading only into stopped Deck: Ti previene dal caricare per errore una traccia nel 

Deck che sta suonando sul main mix.

►► Stop playback at the end of a track: Arresta la riproduzione di un Deck una volta 
raggiunta la fine del brano.

►► Load next at end of track: Questa opzione permette a TRAKTOR di caricare 
automaticamente la prossima traccia della Preparation Playlist.

►► Initially cue to Load Marker: Con questa opzione abilitata, una traccia effettuerà il cue 
automaticamente su di un Load Marker prestabilito nonappena caricata.
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►► Activate Fade In & Out Markers: Questa opzione permette l'utilizzo dei Fade In e Fade 
Out Markers per effettuare il crossfade automatico fra le tracce.

►► Autoplay loops Playlist: Questa opzione influenza il Cruise Mode (Autoplay). Con questa 
opzione attiva, TRAKTOR ripeterà la Playlist dall'inizio una volta raggiunta la sua fine.

Resetting Controls
►► Reset all deck controls when loading a track: Ripristina tutti i controlli del Deck al loro 

valore di default ogni volta che viene caricata una traccia.

►► Reset all mixer controls when loading a track: Ripristina tutti i controlli del Mixer al 
loro valore di default ogni volta che viene caricata una traccia.

Deck Cache Size
Puoi osservare delle barre gialle lampeggianti al di sotto e dietro la Stripe. Tutto quello 
che vedi in questo range viene copiato nella cache, permettendo di effettuare loop e  
spostamenti all'interno della traccia senza interruzioni. La barra gialla smette di  
lampeggiare una volta che l'intera traccia è stata copiata nella cache. 

Scegli quanti megabyte per traccia e per deck devono essere caricati, ma fallo con attenzione.

Scegliendo 256 MB per il deck A&B significa che, con tracce caricate all'interno di entrambi 
i decks, il tuo computer necessita di 512 MB della tua RAM solo per controllare i due Decks. 

Il display sottostante mostra quanta RAM rimane con le tue impostazioni attuali.
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14.5	 Transport

Pitch
►► Pitch Fader Range: Determina il range del controllo del tempo dei Deck. 

►► Fine Pitch Range: Determina il range di un pitch controller aggiuntivo disponibile 
esclusivamente via MIDI. E' possibile utilizzare questo secondo controller del pitch in 
combinazione con il pitch control del Deck. Impostando il range su +/- 8% o meno 
puoi controllare la velocità di un deck con molta precisione tramite valori incrementali 
del Fader MIDI.	

Key Lock Quality
Questa impostazione regola la qualità del time stretch utilizzato quando si sta usando la 
funzione Key Lock.

►► Usa ECO con un processore lento.

►► Usa HiQ con un processore più potente.	

Loops
►► Auto Detect Size: Usa questo slider per regolare le dimensioni in base alle quali una 

traccia viene rilevata automaticamente come loop e quindi messa automaticamente 
in loop. Un loop rilevato in maniera automatica presenterà barre di stato loop verdi 
all'inizio ed alla fine.	

Beat Counter
►► Beats per Phrase: 

Imposta da qui quanti beat deve contenere una battuta (bar).
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14.6	 Mixer

EQ Selection
►► EQ Type: Scegli fra l'EQ a tre bande classico (Classic) o una emulazione 

dell'equalizzatore di un Mixer Pioneer DJM 600 (P600), Ecler Nuo4 (NUO4) o Allen 
& Heath XONE:92 (ZONE:92).

Filter Selection
►► Ladder: Usa il filtro Ladder come l'effetto Filter per i channel filter knobs.

►► Xone: Utilizza l'emulazione del filtro Xone:92 vista anche nell'effetto Filter:92 per 
i channel filter knobs.	

Crossfader
►► Auto Crossfade Time: Questo slider regola il tempo impiegato dal crossfade auto-

matico per effettuare il crossfade fra due tracce.

►► Smooth/Sharp: Regola la curva del crossfade da qui.

Level
►► Set Autogain when loading a track: Con questa opzione selezionata, TRAKTOR regola 

il gain al posto tuo.

►► Enable Master Limiter: Attivando questa opzione è possibile evitare di mandare il 
segnale in clip.

!
L'EQ Selection non è disponibile 
in TRAKTOR DUO.

!
La funzione di Filter Selection 
non è disponibile in  

	 TRAKTOR DUO.

!
La curva del crossfader non è 
regolabile in TRAKTOR DUO.
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14.7	 Effects

Effect Slot Routing
TRAKTOR PRO può effettuare il routing di tutti gli effetti come insert o come send.

►► Insert: In Insert Mode l'effetto viene messo in insert all'interno della catena del segnale 
prima del channel filter. Il bilanciamento del segnale originale (Dry) e quello effettato 
(Wet) viene controllato dal Dry/Wet knob nel pannello degli effetti.

►► Send: In modalità Send l'effect unit diviene indipendente dal flusso di segnale interno 
di TRAKTOR. La effect unit riceve il segnale esternamente da uno degli ingressi 
della scheda audio come specificato in Preferences > Audio Setup > Input Routing. 
La effect unit invia il suo segnale ad una delle uscite della scheda audio, come  
specificato in Preferences > Audio Setup > Output Routing. 	

FX Panel Mode
FX1/FX2: Scegli tra Advanced e Chained Effects.

►► L'Advanced Mode consente un controllo più dettagliato su uno degli effetti selezionati.

►► Il Chained Mode ti da controllo su fino a tre effetti in un unico pannello.	

Effect pre-selection
TRAKTOR offre una vasta gamma di effetti. E' possibile effettuare una selezione personaliz-
zata degli effetti disponibili per ridurre le dimensioni dell'Effect Selector nelle effect units.

Di default, tutti gli effetti disponibili sono pre-selezionati. Per rimuovere un effetto dalla 
pre selezione, sceglilo e premi il tasto REMOVE, o clicca due volte su di esso.

Per aggiungere un'effetto dalla preselezione, sceglilo e premi il tasto ADD o clicca due 
volte su di esso.

E' possibile personalizzare l'ordine con il quale l'effetto appare nella selezione del menu a 
scorrimento spostando le effect unit in alto o in basso all'interno della lista tramite i tasti 
Up e Down.

!
Il Send mode non è disponi-
bile in TRAKTOR DUO e  

	 TRAKTOR LE.

!
L'Advanced Mode non è dis-
ponibile in TRAKTOR DUO e  

	 TRAKTOR LE.

!
Solo un effetto per effect unit in 
modalità chained è disponibile 	

	 su TRAKTOR LE.
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14.8	 Recording

Source
►► Source: Seleziona Internal per registrare l'uscita Master di TRAKTOR e seleziona 

External per registrare una sorgente audio esterna come un giradischi o un microfono.

►► External Input: Seleziona il canale in ingresso che TRAKTOR utilizza per ricevere 
l'audio esterno.	

File
►► Directory: Questo determina il percorso nel quale vengono salvate le tue registrazioni.

►► Prefix: Questo determina il prefisso del nome del file di ogni registrazione.

►► Split File at Size: Selezionando una dimensione di file, le tue registrazioni verranno 
divise ogni volta che tale dimensione viene raggiunta. 

14.9	 Broadcasting

Proxy Settings
Se ci si collega ad internet tramite un Proxy, utilizza questa selezione per configurare 
TRAKTOR in maniera che possa servirsi delle tue impostazioni Proxy.

Server Settings
Usa questo menu per configurare TRAKTOR in modo da utilizzare il tuo server Shoutcast/
Icecast

Metadata Settings
Usa questo menu per impostare i metadata del tuo stream audio in trasmissione.

!
Il Recording Mode non è dis-
ponibile in TRAKTOR DUO e  

	 TRAKTOR LE.

!
Il Broadcasting Mode non è 
disponibile in TRAKTOR DUO  

	 e TRAKTOR LE.
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14.10	File Management

14.10.1		 File Management

File Management
►► Import Music Folders at Startup: Con questa opzione selezionata, ad ogni avvio di 

TRAKTOR verranno importate automaticamente nella tua cartella Musica tutte le 
tracce che non lo sono già state.

►► Determine track time automatically (before analysis): Con questa opzione attiva, 
TRAKTOR calcola il tempo della traccia prima di analizzarla in dettaglio.

►► Background Analysis on Collection Load/Import: Esegue una analisi automatica di tutte 
le tracce della Collection non ancora analizzate nonappena vengono importate.

►► Background Analysis when Loading into Deck: Questa opzione attiva l'analisi solamente 
una volta caricata la traccia nel Deck. Analizzando le tracce di volta in volta non  
incontri eventuali problemi di CPU che potrebbero verificarsi durante una analisi in 
background permanente.

►► Show Consistency Check Report on Startup: Con questa opzione selezionata, il 
Consistency Check Report verrà visualizzato ad ogni avvio di TRAKTOR. Questo report 
riporta informazioni sulla tua Track Collection e ti da varie opzioni di gestione.	

File Structure Mode
Il File Structure Mode determina in quale modo verranno esportate le Playlist.

% 
L'Analisi è un processo che gen-
era un grande carico di CPU. 

Grazie alla bassa priorità del processo di 
analisi non vi sono rischi di rallentamenti 
per TRAKTOR in sé, ma utilizzando an-
che altro software insieme a TRAKTOR 
potresti notare che il software risponde 
più lentamente del solito. 



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 126  

Analyze BPM Range
►► Min/Max: inserisci il valore minimo e quello massimo di beat per minuto (BPM) che 

sono di norma caratteristici delle tue tracce per aiutare l'analisi dei BPM di TRAKTOR 
a trovare il valore appropriato durante l'analisi. E' consigliato di mantenere il range di 
piccole dimensioni e di evitare di raddoppiare un valore (per es. 80-159 BPM è  
meglio che 80-161 BPM). Il valore più basso che puoi immettere è 40 bpm, mentre 
il massimo valore possibile è 250.

►► Place Auto rid Marker: Con questa opzione selezionata, TRAKTOR piazza automatica-
mente un Beatmarker.	

Editing
Allow Inline Editing in List Window: Se attivo, puoi modificare i metadata dei tuoi file di 
musica cliccando due volte su di essi nel Browser List. 

Se questa opzione è disabilitata, non è permesso effettuare l'editing inline dei tag di una trac-
cia all'interno del Browser per prevenire cambiamenti indesiderati durante un set. Seleziona 
questa opzione se stai preparando le tracce a casa per avere un accesso più rapido ai tag.

14.10.2	 Data Location

Directories
►► Root Dir: Questo è il percorso che porta alla tua Collection/Playlists/Settings/History/

Mappings files. E' possibile impostare un altra cartella. Per cambiarla, clicca il ...! 
Button e indica a TRAKTOR il percorso alla cartella desiderata. Clicca su Default Dir 
per ripristinare i percorsi a quelli di default.

►► iTunes Music Library: Se desideri utilizzare l'integrazione di iTunes con TRAKTOR devi 
comunicare al programma dove sono salvati i file della tua iTunes Library. Clicca il 
Button e indica a TRAKTOR il percorso del file della Library di iTunes.	
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Music Folders
Se desideri utilizzare la tua struttura personale di cartelle di musica puoi aggiungere tali 
cartelle in questa lista. TRAKTOR è in grado di importare automaticamente tutti i file di 
musica salvati in questa Music Folder.

►► Add...!: ti permette di aggiungere cartelle ed impostarle come Music Folder.

►► Delete!: elimina il Music Folder selezionato dalla lista.

►► Cambia...!: se hai cambiato la posizione o il nome di un Music Folder clicca su 
questo tasto per comunicare a TRAKTOR il cambiamento.	

14.11	Layout Manager

14.11.1			 Layout Manager

Layout Manager
►► Change Name: Da qui puoi specificare il nome per il Layout selezionato. Clicca Rename 

per verificare quanto inserito.

►► Personal Layouts: In questa lista vengono mostrati tutti i Layout salvati. Per attivare 
un Layout, clicca due volte sulla intera fila. Il Layout attivo è contraddistinto da Active 
nella prima colonna. L'ordine di questa lista definisce anche l'ordine dei Layout nel 
Layout Selector dell'Header di TRAKTOR PRO. Add aggiunge un nuovo Layout al Layout 
Manager. Remove elimina il layout selezionato. Move Up/Down cambia la posizione del 
layout selezionato all'interno dell'ordine dei layout. 

►► Show Global Section: attiva o disattiva l'intera Global Section.

►► Left/Right: scegli i Panel visibili di default a sinistra ed a destra della Global Section. 

►► EQ + Fader + Cue: Mostra o nascondi le rispettive funzioni.

►► Filter +Key + gain + balance: Mostra o nascondi i rispettivi controlli.

►► Crossfader: Mostra o nascondi il Crossfader.

!
Il Layout Manager non è dis-
ponibile in TRAKTOR DUO e  

	 TRAKTOR LE.
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14.11.2		 Deck in Dettaglio

Deck Style
►► Deck Size A & B (C & D): passa da visuale intera a minima dei Deck. I Deck 

rimpiccioliti non permettono la visualizzazione della Waveform e degli Advanced 
Controls.

►► Scratch Panels: accende e spegne gli Scratch Panels per utilizzarli con TRAKTOR 
SCRATCH PRO.

►► Adv. Controls: attiva o disattiva gli Advanced Controls per i Deck a visuale intera.

►► A & B (C & D): Seleziona l'Advanced Control Panel visibile di default.

►► Show Deck C & D: attiva e disattiva i Deck C e D, se disabilitato essi vengono 
nascosti e impostati su mute.	

Deck Header
►► Show Cover Art: attiva e disattiva l'icona della copertina.

►► File Info: da qui puoi scegliere quali informazioni vengono visualizzate nel Deck Header 
per la traccia caricata. Sono disponibili nove campi suddivisi in tre file. La fila superiore 
è più grande e quella inferiore più piccola, così da poter organizzare le informazioni 
in base all'importanza.	

Pitch Controls
►► Phase Meter: attiva o disattiva il Phase Meter per tutti i Deck.

►► Pitch Fader: attiva o disattiva il Pitch Fader per tutti i Deck.

! 
Gli Scratch Panel sono dis-
ponibili solo se TRAKTOR 

SCRATCH PRO e l'hardware richiesto 
sono installati.
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14.11.3		 Browser in Dettaglio
►► Show Preview Player: attiva o disattiva il Preview Player.

►► Show Track Info: attiva o disattiva la Info Window. 

►► Show Playlist Favorites: attiva o disattiva i Browser Favorites nella parte superiore 
del Browser.

►► Show Cover Art: attiva o disattiva la visualizzazione delle copertine.

►► Show Status Bar/Error Messages: attiva o disattiva la barra di stato. Inoltre segnala al 
suo interno eventuali messaggi di errore.

14.12	Global View Options

Decks
►► Highlight Beatmarkers: Se questo è attivo, la Beatgrid sarà più chiara e visibile.

►► Show Minute Markers: Permette di visualizzare nella Stripe View una linea bianca in 
corrispondenza di ogni minuto.

►► Channels: Questa opzione configura l'aspetto della Waveform. Beats permette di vedere 
solamente i beat della traccia. Beats and Highs permette di vedere i beat della traccia 
insieme alle alte frequenze rilevate al suo interno Beats and Envelope permette di 
vedere i beat della traccia insieme agli inviluppi rilevati al suo interno.

►► Track End Warning: Questo slider regola la quantità di tempo di avvertimento che 
TRAKTOR concede approssimandosi alla fine di una traccia. E' indicato dal lampeg-
giamento in rosso della Stripe View.

►► PlayMarker Position: Determina quanto a sinistra o a destra apparirà il Play Marker.

►► Stripe View Fit: Valido su TRAKTOR SCRATCH PRO: scegli fra due opzioni di visualiz-
zazione. 

►► Display Deck Focus: Se questa opzione è attiva TRAKTOR evidenzierà il Deck in uso.
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Miscellaneous
►► Switch to Fullscreen on Startup: Con questa opzione selezionata, TRAKTOR si avvierà 

in modalità schermo intero (riempiendo l'intero schermo del computer) ogni volta che 
viene lanciato.

►► Fullscreen Resolution: Determina il fattore di ingrandimento della visuale a schermo 
intero di TRAKTOR. Se impostato su Desktop, TRAKTOR utilizza la risoluzione nativa 
del tuo computer 1:1. Scegliendo un'altra opzione, la visuale a schermo intero appare 
più larga (ingrandita) perchè TRAKTOR utilizza una risoluzione più bassa. Le opzioni 
disponibili dipendono dal tuo hardware.

►► Show value when over control: Con questa opzione attiva, i knob come Gain, Master 
Volume o gli Effect Knob indicano il loro valore corrente al passaggio del mouse.

►► Font: Da qui puoi selezionare il tipo di caratteri utilizzato da TRAKTOR nel Browser.

►► Font Size: Con questa opzione puoi determinare la dimensione dei caratteri usati nel 
Browser di TRAKTOR.

►► List Row Height: Scegli le dimensioni delle righe della Browser List.

►► Reset Hidden Dialogs: Il Reset Button ripristina tutte le finestre che sono state nas-
coste cliccando sulla caselle "Don't show this again".

14.13	Keyboard Mapping

Questo menu serve per caricare e configurare la tua tastiera per assegnarla alle funzioni di 
controllo di TRAKTOR. Aggiungi un controllo, clicca Learn e premi un tasto della tastiera 
per assegnare il controllo. 

Osserva gli attributi del controller disponibile cambiare in dipendenza dal controllo  
desiderato e in quale modo impostazioni diverse cambiano il comportamento dei controlli.

Puoi aggiungere controlli ed assegnarli ad uno specifico Deck oppure al Deck attivo.

Effettua l'Import e l'Export delle impostazioni per condividerle con altri utenti.

Per saperne di più sul Keyboard Mapping consulta il capitolo 15.1.1	(Keyboard Mapping).

!
Il Keyboard Mapping non è 
disponibile in TRAKTOR DUO  

	 e TRAKTOR LE.
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14.14	 MIDI Mapping

Questo menu serve per configurare i vari tasti del tuo MIDI Controller ed assegnarli alle 
funzioni di controllo di TRAKTOR. Aggiungi un controllo, clicca Learn e premi un tasto 
della tastiera per assegnare il controllo. 

Osserva gli attributi del controller disponibile cambiare in dipendenza dal controllo  
desiderato e in quale modo impostazioni diverse cambiano il comportamento dei controlli.

Puoi aggiungere controlli ed assegnarli ad uno specifico Deck oppure al Deck attivo.

Effettua l'Import e l'Export delle impostazioni per condividerle con altri utenti.

Per saperne di più sul MIDI Mapping consulta il capitolo 15.1.2 (MIDI Mapping).

!
Il MIDI Mapping non è disponi-
bile in TRAKTOR LE.
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15	 Conoscenza Avanzata
In questo capitolo trovi ulteriori informazioni per una conoscenza più approfondita di  
alcune funzioni.

15.1	 Hotkey e MIDI Mapping

TRAKTOR salva le assegnazioni degli Hotkey per controllo tramite tastiera e la configura-
zione dei controller MIDI in file ".tsi". 

TRAKTOR viene installato con assegnazioni per i controller più importanti in commercio ed 
alcune impostazioni di default per controllare TRAKTOR con la tastiera del tuo computer. 

Questo capitolo fornisce un'introduzione alla creazione di assegnazioni personalizzate  
partendo da zero o modificando una mappatura esistente.

►► Per scoprire come caricare uno dei settings inclusi, consulta il capitolo 12.	(Controllo 
tramite Tastiera e MIDI Hotkey).

►► Per creare la tua configurazione personale, apri Preferences cliccando sull'apposita 
icona Header o tramite il Menu Applicazione.

15.1.1	 Keyboard Mapping
Keyboard Mapping ti permette di configurare Hotkey per controllare TRAKTOR nel modo 
in cui desideri.

►► Apri Preferences > Keyboard Mapping.

Per assegnare un tasto della tua tastiera ad una funzione di TRAKTOR devi: 

►► Cliccare su Add.

►► Seleziona la funzione che intendi assegnare. 

►► Clicca Learn. 

!
Il Keyboard Mapping non è 
disponibile in TRAKTOR DUO  

	 e TRAKTOR LE.
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►► Premi il rispettivo tasto della tastiera.

►► Per assicurarti che l'assegnazione sia andata a buon fine, la modalità Learn si deve 
spegnere da se.

Per una spiegazione delle opzioni disponibili consulta il capitolo dedicato al MIDI Mapping 
più avanti. Sei pregato di notare che non tutte le opzioni disponibili per il MIDI Mapping 
lo sono anche per Keyboard Mapping.   

15.1.2	MIDI Mapping
Le funzioni del MIDI Mapping sono estremamente potenti. Per via delle numerose opzioni 
disponibili, le assegnazioni MIDI possono diventare piuttosto complicate da gestire, per 
cui prova prima a mantenere le tue assegnazioni piuttosto semplici.

►► Per prima cosa accertati che il tuo controller sia collegato e attivo in Preferences > 
MIDI Setup.

►► Apri Preferences > MIDI Mapping.

Creazione di un MIDI Mapping - Panoramica
Per assegnare un controllo del tuo Controller MIDI ad una funzione di TRAKTOR devi: 

►► Cliccare su Add.

►► Seleziona la funzione che intendi assegnare. 

►► Clicca Learn. 

►► Premi il rispettivo pulsante sul tuo Controller MIDI.

►► Per assicurarti che l'assegnazione sia andata a buon fine, la modalità Learn si deve 
spegnere da se.

A questo punto è normalmente necessario specificare ulteriori opzioni per ottenere il  
comportamento desiderato, come la modalità Toggle piuttosto che Hold, o la regolazione 
della sensibilità di un knob. E' possibile verificare tali cambiamenti da software senza 
bisogno di chiudere la pagina MIDI Mapping.

% 
Per testare se il tuo controller è 
collegato premi semplicemente 

un pulsante o muovi un knob o fader su 
di esso e verifica che l'indicatore MIDI 
nell'Header di Traktor si accenda.

!
Il MIDI Mapping non è disponi-
bile in TRAKTOR LE.
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Sono disponibili alcuni aiuti visivi, come l'organizzazione per colonne e la sottolineatura di 
voci assegnate allo stesso tasto, knob o fader.

La parte finale del capitolo provvede alcuni esempi passo dopo passo su come mappare 
funzioni specifiche al tuo controller MIDI.

Comprensione delle opzioni disponibili.
Questa sezione descrive le funzioni di ogni controllo della pagina MIDI Mapping.

Assignment Table

►► L'Assignment Table mostra l'intero set di associazioni MIDI contenuti nel file ".tsi".

►► E' possibile riordinare la tabella in base ad una qualsiasi delle colonne, per es. per 
nome, modificatore o tasto hardware, knob o fader.

Reset

►► Annulla l'assegnazione della voce selezionata dalla sua assegnazione attuale.

Reset All

►► Ripristina l'intera mappatura per ripartire da zero.

Add 

►► Questo menu contiene tutte le funzioni MIDI che possono essere assegnate 
all'hardware.

►► Per creare una nuova assegnazione, scegli da questo menu la funzione da mappare.

Duplicate

►► Duplica la voce selezionata. Usa questa funzione per assegnazioni multiple o quando 
stai lavorando con Modifiers degli stessi controlli su Deck differenti.
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Delete

►► Elimina la voce selezionata. In seguito a ciò viene selezionata la voce precedente  
a quella eliminata.

Delete All

►► Elimina l'intera Assignment Table per ripartire da zero. 

Learn

►► Attiva il Learn mode, con il quale eventi MIDI in ingresso vengono mappati alla voce 
attualmente selezionata.

Assigned Controller (senza nome)

►► Indica il valore dell'ultimo evento MIDI in ingresso.

MIDI CH

►► Indica il canale MIDI per l'ultimo evento MIDI in ingresso.

Lock Omni

►► Se attivo, TRAKTOR ignora il canale MIDI specificato nell'assegnazione.

Comment

►► Questa voce ti permette di inserire un commento per ogni controllo assegnato. 
I Commenti servono per motivi di documentazione in assegnazioni molto complesse 
e sono utili anche per raggruppare funzioni, utilizzando l'organizzazione alfabetica 
della colonna Comment.
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Interaction Mode 

►► Determina che tipo di interazione il controller hardware dovrebbe intrattenere con il 
parametro controllato in TRAKTOR.

►► Hold: Questa funzione è attiva per tutto il tempo che viene tenuto il rispettivo tasto. 
Ad esempio il Pitch Bend ed il tasto Shift. La modalità Hold può essere associata 
esclusivamente a dei tasti!

►► Toggle: Ogni volta che il tasto viene premuto, la funzione cambia il proprio stato. E' 
possibile associare la modalità Toggle esclusivamente a dei tasti!

►► Trigger: La modalità Trigger serve per controllare funzioni senza durata, come 
l'impostazione di un Cue Point o il passaggio ad un altro Layout. Sebbene l'operazione 
sia molto comune, le funzioni che richiedono la modalità Trigger sono rare perchè molte 
di queste opzioni sono già state raggruppate all'interno dei cosiddetti "Ranges". I Ranges 
sono liste di opzioni alternative che vengono controllate in Direct Mode come descritto 
qui di seguito. E' possibile associare il Trigger Mode esclusivamente a dei tasti.

►► Direct: Direct Mode controlla in maniera diretta il valore del parametro o la gamma di 
valori, come il controllo del pitch con un fader o lo scorrimento di una lista con un 
rotary knob. Il Direct Mode serve anche per usare un pulsante per selezionare un va-
lore specifico da una lista, come la selezione di un effetto. E' possibile utilizzare la 
modalità Direct con tutti i tipi di controlli hardware disponibili. Ogni tipo di controllo 
ha un sottogruppo individuale di opzioni descritte qui di seguito.

►► Next (Inc): Si sposta in maniera incrementale attraverso un certo range aumentando 
di valore. Le dimensioni dello scatto sono fisse ma le si possono anche regolare  
nel campo Resolution.

►► Previous (Dec): Scatta in maniera incrementale attraverso un certo range diminuendo 
di valore. Le dimensioni dello scatto sono fisse ma le si possono anche regolare  
nel campo Resolution.

►► Reset: Ripristina il range al suo valore di default. Un esempio spesso utilizzato è lo 
spostamento all'inizio di una traccia mappando il Reset Mode della funzione "Deck 
Seek Position" ad un pulsante. 

►► Output: La modalità da utilizzare per accendere e spegnere i LED del controller co-
mandati via MIDI. 
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Assignment

►► Determina su quale Deck avverrà l'azione di una funzione.

►► Global: Alcune funzioni non sono in relazione con i Deck; l'unica modalità disponibile 
in questo campo è GLOBAL.

►► Focus / Deck A / Deck B / Deck C / Deck D: Se le funzioni sono interrelate, le si può 
assegnare al Deck attivo o ad uno specifico Deck.

►► FX 1 / FX 2: Assegnando controlli sugli effetti, le opzioni di assegnazione disponibili 
sono "FX 1" e "FX 2", in riferimento alle due unità disponibili.

Tipi di Controller

►► Button: Tasti MIDI inviano normalmente un evento "Note On" se premuti e "Note Off" 
una volta rilasciati. Il valore della nota distingue i diversi segnali provenienti dai  
diversi tasti.

►► Fader/Potentiometer: Fader e Potenziometri sono entrambi dotati di un raggio limitato e 
d una posizione assoluta all'interno del proprio raggio. Il vantaggio di utilizzare  
controlli assoluti sta nel fatto che essi forniscono un feedback visivo del loro stato e di 
conseguenza non devi guardare il computer per controllare il crossfader, l'EQ o il pitch 
fader. Un problema inerente ai controlli assoluti è che il software potrebbe cambiare il 
valore della funzione controllata. Questo provoca uno sfasamento tra il valore della fun-
zione all'interno del software e la posizione fisica del fader o del knob. Quindi allo spos-
tamento del valore del fader o del knob, le funzioni controllate compiono un salto per 
corrispondere a tale valore, la qual cosa può risultare inaspettata ed indesiderata. Con 
la funzione "Soft Takeover" descritta in seguito è possibile risolvere il problema.
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►► Rotary Encoder: Gli encoder a corsa infinita o i touch pad non hanno una posizione 
assoluta. Se il controller non è provvisto di anelli di LED o di un display, è possibile 
assicurarsi del valore delle funzioni controllate tramite encoder a corsa infinita solo 
guardando il computer. Il grande vantaggio di questo tipo di controllo sta nel fatto che 
il valore può anche venire controllato dal software, perchè i cambiamenti vengono  
effettuati esclusivamente in maniera incrementale. Ad esempio è possibile impostare 
un parametro di un effetto controllato tramite encoder su di un certo valore  
richiamando il preset e lo si può modificare direttamente da lì con l'encoder. Questa 
funzione non è utilizzabile con un fader o un potenziometro.

►► Rotary Encoder (inv): In commercio si trovano due differenti tipi di rotary encoder a 
corsa infinita. Se la funzione controllata risponde al contrario e malamente con l'uso 
del primo tipo di Rotary Encoder, scegli Rotary Encoder (Inv).

►► Rotary AutoReset/Rotary AutoReset (inv): Queste due modalità si comportano come i 
Rotary Encoder Modes ma aggiungono un comando neutrale MIDI di reset quando lo 
spostamento si interrompe. Per esempio controllando la funzione Pitch bend tramite 
Rotary Encoder, gli ultimi Pitch Bend Buttons rimangono accesi. Utilizzando Rotary 
AutoReset i Pitch Bend Buttons verranno ripristinati su Off. 

Modifier

Questa sezione offre due coppie di condizioni per eseguire la funzione prescelta. I Modifiers 
vengono utilizzati allo stesso modo del pulsante SHIFT sulla tastiera del tuo computer. 

Se queste caselle rimangono vuote, il comando MIDI momentaneamente selezionato viene 
sempre eseguito.

Se le caselle Modifier contengono dei dati (per es. Modifier:M1, Value: 1) il comando 
MIDI momentaneamente selezionato viene eseguito solo quando il Modifier 1 è impostato  
sul valore 1.

Il menu ADD offre 8 Modifier indipendenti ciascuno dei quali può venire assegnato ad un 
pulsante MIDI e può presentare 8 diversi stati numerati (0, 1, ..., 7)
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0 è lo stato neutrale di ciascun Modifier.

►► La condizione è espressa da un modificatore ed il suo valore. La funzione viene  
eseguita solo se la condizione si verifica (true). 

►► E' possibile cambiare il valore e lo stato dei Modifier via MIDI come ogni altra 
funzione di TRAKTOR. 

Button Options: (Type = Button)

►► Set to Value: Utilizzando il Direct Mode con tasti legati a funzioni doppio stato, come 
ad esempio Play/Pause, permette alla funzione di essere impostata su ON o OFF  
indipendentemente dal suo stato attuale, cosa che la modalità Toggle non è in grado 
di fare. Utilizzando il Direct Mode con tasti associati a dei range di valori, vengono 
visualizzati i valori disponibili ed è necessario selezionare uno di essi o inserire il valore 
nel campo modificabile.

Opzioni Fader / Potentiometer (Type = Fader)

►► Soft Takeover: Questa funzione serve nel caso in cui le funzioni controllate dall'hardware 
possono cambiare il proprio valore senza toccare l'hardware stesso, come il pitch 
fader, il quale si sposta alla pressione del tasto Sync. Se Soft Takeover è attivo, l'azione 
del fader o knob ad esso associato verrà ignorato fino a che venga portato alla  
posizione occupata nel software. Questo ti permette di riprendere il controllo di  
controlli assoluti in maniera naturale.

►► Invert: Ti permette di invertire l'azione di un tasto, fader o knob.
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Opzioni Encoder (Type = Rotary)

►► Rotary Sensitivity: Regola il rapporto della trasmissione fra parametri hardware e soft-
ware. Un valore ottimale per iniziare è normalmente 50%. Per utilizzare una risoluzi-
one maggiore scendi fino ad 1%. Per scorrere le liste, utilizza 100% 

►► Rotary Accelleration: Determina in quale modo alte velocità di rotazione influenzino il 
software. Per un comportamento lineare del controller (per es. una quantità di modu-
lazione indipendente dalla velocità del movimento) imposta il valore Accelleration su 0%.

►► Su valori di Accelleration più alti, è possibile ottenere cambiamenti maggiori ruotando 
più velocemente il knob. 

►► Invert: Ti permette di invertire l'azione di un tasto, fader o knob.

Opzioni LED (Control Type = Output)

Di solito un singolo LED viene attivato da un parametro via software.

I LED vengono identificati rispondendo ad un controllo MIDI specifico (CC#). Di solito 
inviare il controllo con valore "0" spegne il LED mentre un controllo di valore "127" ne 
provoca l'accensione.

Alcuni LED si accendono secondo intensità o colori diversi a seconda del valore inviato 
tramite MIDI controller.

A volte i controller sono dotati di insiemi di LED associati ad un singolo controllo MIDI.  
Simili insiemi si accendono progressivamente in base al valore inviato tramite controller. 

►► Controller Range: Di default indica l'intero range proprio della funzione selezionata in 
TRAKTOR. Il range della funzione software viene mappato al LED o all'insieme di LED 
del controller. Range continui hanno di norma valori da 0 a 1, dove 0 sta per il valore 
minimo ed 1 quello massimo. Una lista di valori ha di norma un range del tipo 0, 1, 
2, 3,... - dove ognuno dei numeri rappresenta uno degli stati disponibili. E' possibile 
ridurre il range ad un sotto-range per poter selezionare valori specifici o per effettuare 
uno zoom su di un range continuo.

►► MIDI Range: E' possibile personalizzare il MIDI range del LED Ad esempio un LED 
colorato può necessitare del valore 64 per diventare verde. In questo caso occorre 
limitare il MIDI range a "0' - 64".
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►► Invert: Permette di invertire lo stato on/off del LED.

►► Blend: Serve per una mappatura di un range continuo ad un altro (ad es. mappando 
la posizione di un fader ad un gruppo di LED).

►► Se stai mappando due LED a doppio stato (ON/OFF) disattiva sempre l'opzione Blend.

15.1.3	 Suggerimenti

Pianifica in maniera corretta
Le Assegnazioni MIDI diventano facilmente molto più grandi del piano originale, dal  
momento che potresti desiderare aggiungere qualche ritocco qua e là. Comunque, ricorda 
che più sono le assegnazioni fatte più difficile sarà modificarle e passarle in rassegna. 

Per cui è consigliabile non creare una Mappatura MIDI a tentativi, bensì creare un buon 
piano delle assegnazioni ancora prima di assegnare il primo tasto. Dovresti iniziare ad 
implementarlo solamente una volta sicuro che il mapping non cambierà.

Specifica tutti i modifier.
Utilizzando i modifier, un metodo per mantenere una visuale chiara delle tue assegnazioni 
è quello di fare una lista di tutti i Modifier, quali pulsanti li attivano, e quali funzioni di 
TRAKTOR sono dipendenti da questi. Non ti pentirai di aver creato tale lista, una volta 
che ti trovi nel mezzo della correzione delle assegnazioni da te create.

Implementazione
Occupati dell'implementazione in maniera sistematica.

►► Prima di tutto implementa tutti i Modifier utilizzati nel tuo mapping. Ciò comporta il 
vantaggio di avere tutte le funzioni dipendenti dai Modifier istantaneamente attive 
durante la programmazione.

►► Usa la funzione Duplicate quando possibile. E' possibile risparmiare molta fatica con-
figurando perfettamente il Jog Wheel per il Deck A (comprese tutte le impostazioni di 
sensibilità), testarlo ed infine duplicarlo per il Deck B, piuttosto che rifarlo da zero una 
seconda volta.
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►► Procedi per gruppi funzionali. Ad esempio, implementa tutte le funzioni di Loop in 
una volta, e se possibile inserisci un commento a tutte queste funzioni cosicché sia 
in seguito possibile identificarle in relazione al looping. Infine, fai dei test sul gruppo 
e salva il file dei settings. In questo modo puoi creare degli stadi intermedi del tuo 
file di mapping i quali operano completamente in funzione di un numero specifico di 
gruppi funzionali.

Semplice funzione SHIFT
L'esempio seguente di assegnazione associa la funzione Play ad un tasto premuto  
singolarmente, e la funzione Sync allo stesso tasto quando premuto in combinazione con 
un altro tasto.

►► Add > Deck > Transport > Deck Play/Pause

►► Modifier M1: Val = 0

►► Interaction Mode: Toggle

►► LEARN a PLAY Button sul controller

►► Add > Deck > Tempo > Deck Sync Tempo/ Phase

►► Modifier M1: Val = 1

►► Interaction > Toggle

►► LEARN allo stesso tasto PLAY sul controller

►► Add > Modifier > Modifier #1

►► Interaction > Hold  /  Value = 1 

►► LEARN al tasto SHIFT del controller
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Jog Wheels
Jog Wheels? Si, ve ne sono diverse in commercio. E, per qualche motivo, non sono  
tutte uguali.

►► La maggior parte delle jog wheel invia eventi su di un canale MIDI CC quando è  
in movimento.

►► Per le assegnazioni a delle Jog Wheel usa il DIRECT Interaction Mode e Rotary come 
tipo di controller.

►► Alcune Jog Wheel sono provviste di zone sensibili al tocco (touch sensitive) che è  
possibile utilizzare per assegnare diverse funzioni al tocco del disco sulla parte  
esterna piuttosto che sulla parte interna. La maggior parte di queste Jog Wheel  
sensibili al tocco inviano eventi su un MIDI CC diverso a seconda che la zona centrale 
sia toccata o meno. In questo modo puoi assegnare direttamente funzioni diverse alle 
due modalità della Jog Wheel.

►► Inoltre, le Jog Wheel sensibili al tocco inviano un comando Note On anche  
semplicemente toccando  il disco (senza ruotarlo). Questo evento viene di norma  
associato alla funzione: Deck > Transport > Deck Scratch ON, per simulare il tocco 
del dito sul vinile che si impossessa del controllo della sua rotazione.

►► Per potere anche ottenere il controllo sullo scratch in maniera naturale occorre  
assegnare il MIDI CC inviato dalla Jog Wheel quando la si ruota toccando il centro a 
Deck > Transport > Deck Scratch.

►► Alcune Jog Wheel inviano un messaggio MIDI di Note ON se ruotate a sinistra, un 
diverso MIDI Note ON se a destra. Queste Jog Wheel non sono utilizzabili per  
effettuare lo scratch ma ciononostante possono servire per il Pitch Bend o per  
spostarti all'interno della traccia.

►► A seconda della specifica funzione assegnata all'evento Note On, può essere  
necessario ripristinare la funzione alla fine del movimento. Questa funzionalità viene 
fornita dal JOG Controller Type, che ripristina la funzione controllata una volta inter-
rotto il movimento della Jog Wheel.

►► Un altra variabile fra diversi tipi di Jog Wheel è la quantità di dati inviati durante una 
intera rivoluzione. Ciò risulta in diverse sensibilità ed è possibile controllarlo tramite 
gli slider SENSITIVITY e ACCELLERATION nei Rotary Encoder Settings
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Come puoi vedere, la varietà di implementazioni MIDI per le Jog Wheel è assai variegata, 
e configurare la Jog Wheel secondo i tuoi bisogni potrebbe richiedere diverso tempo o la 
ricerca nella sezione DOWNLOADS del sito internet di TRAKTOR di mapping file designati 
per il tuo specifico controller.

Disattivare una Jog Wheel
L'esempio seguente mostra come utilizzare un Modifier per attivare e disattivare la Jog 
Wheel. La Jog Wheel è disattivata quando il modifier è pari a zero.

►► Add > Deck > Transport > Deck CD-DJ Jog

►► Modifier M1: Val = 1

►► Interaction Mode : Direct

►► Type of Controller: Rotary

►► LEARN alla Jog Wheel sul controller

►► Add > Modifier > Modifier #1

►► Interaction > Toggle

►► LEARN al tasto ENABLE sul controller

(nel caso che il tuo controller sia provvisto di un tasto retroilluminato)

►► Add > Modifier > Modifier #1

►► Interaction > Output

►► Assegna il MIDI CC del tasto LED tramite il menu a scorrimento vicino al tasto LEARN
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Looping Section
Questo esempio mostra come mappare tre tasti MIDI per controllare i LOOP di TRAKTOR 
con le seguenti funzionalità: 

►► Il tasto "-" imposta inizialmente un loop di 4 beat e una volta premuto nuovamente 
dimezza le dimensioni del loop.

►► Il tasto "+" imposta anch'esso inizialmente un loop di 4 beat e una volta premuto 
nuovamente raddoppia le dimensioni del loop.

►► Il tasto "Exit" permette di abbandonare il loop o attiva la modalità loop per i loop  
salvati. 

Per ottenere tutto ciò dobbiamo definire un Modifier che serve a differenziare le funzion-
alità del tasto "-" e "+" a seconda che il loop sia in esecuzione o meno.

MODIFIER

►► Add > Modifier > Modifier #1

►► Interaction > Direct  /  Value = 1

►► LEARN a "-" sul controller

►► Duplica questa linea.

►► LEARN a "+" sul controller

►► Duplica questa linea.

►► Cambialo in Value = 0

►► LEARN a "EXIT" sul controller

LOOP ACTIVE

►► Add > Deck > Cue/Loops > Loop Active

►► Interaction > Toggle

►► LEARN a "EXIT" sul controller
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IMPOSTARE UN LOOP DI 4 BEAT

►► Add > Deck > Cue/Loops > Loop Resize+Set

►► Interaction > Direct-Button  /  Value = 4

►► Modifier M1: Val = 0

►► LEARN a "-" sul controller

►► Duplica questa linea.

►► LEARN a "+" sul controller
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CAMBIARE LE DIMENSIONI DEL LOOP

►► Add > Deck > Cue/Loops > Loop Size

►► Interaction > Previous-Button

►► Modifier M1: Val = 1

►► LEARN a "-" sul controller

►► Duplica questa linea.

►► Cambia Interaction in > Next-Button

►► LEARN a "+" sul controller

Lavorare con gli Hot Cue Buttons
Questo esempio illustra come sia possibile impostare in maniera intelligente le sezioni di 
Cue ed Hot Cue su di un controller MIDI. Implementa 4 tasti Hot Cue, un tasto per salvare 
i cue point o i loop ( chiamato STORE) ed una funzione secondaria sullo stesso tasto la 
quale se premuta insieme ad un tasto SHIFT elimina il cue point selezionato. 

I tasti sono utilizzati in questo modo:

►► Premendo i tasti 1-4 si passa ai rispetti Hot Cue 1-4

►► Premendo STORE si salva il Current Cue Point o Current Loop e lo si assegna al primo 
slot Hotcue disponibile.

►► Tenendo premuto STORE e premendo inoltre uno dei 4 tasti Hotcue si assegna il Cue 
Point o il Loop direttamente al tasto Hotcue appena premuto.

►► Premendo SHIFT+STORE si elimina il Cue Point o Loop attualmente selezionato.



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 148  

Ecco come procedere:
TASTI HOT CUE

►► Add > Deck > Cue/Loops > Select HotCue

►► Interaction > Hold  /  Value = 1 

►► LEARN a "1" sul controller

►► Duplica questa linea.

►► Cambialo in Value = 2

►► LEARN a "2" sul controller

►► Duplica questa linea.

►► Cambialo in Value = 3

►► LEARN a "3" sul controller

►► Duplica questa linea.

►► Cambialo in Value = 4

►► LEARN a "4" sul controller

TASTO STORE/MAPPING

►► Add > Deck > Cue/Loops > Store Cue/Loop

►► Interaction > Trigger

►► Modifier M1: Val = 0

►► LEARN a "STORE" sul controller

►► Add   > De c k > Cue/L o ops  > Map HotCue

►► Interaction > Hold-Button

►► Modifier M1: Val = 0

►► LEARN allo stesso tasto "STORE" sul controller. 
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ELIMINA I CUE POINT

►► Add > Modifier > Modifier #1

►► Interaction > Hold  /  Value = 1 

►► LEARN al tasto SHIFT del controller

►► Add > Deck > Cue/Loops > Delete Cue/Loop

►► Interaction > Trigger

►► Modifier M1: Val = 1

►► LEARN allo stesso “STORE“ Button sul controller►	

15.2	 Profili di TRAKTOR

15.2.1	Il Root Folder di TRAKTOR
TRAKTOR salve tutte le informazioni necessarie per la creazione di un TRAKTOR Profile 
personalizzato in una cartella, nominata Root Folder.

Il percorso di default del Root folder è:

►► PC: Documenti\Native Instruments\Traktor

►► Mac: ~/Native Instruments/Traktor

Esso contiene i seguenti tipi di file

►► *.nml  = questa è l'estensione di tutte le playlist come anche quelle della Collection, 
le History playlist e quelle create dall'utente.

►► *.tsi = estensione propria di tutti i settings (tastiera, MIDI, Preferenze, Layout)

►► *.log = estensione dei file di log generati all'avvio di TRAKTOR

% 
Puoi cambiare il percorso in 
Preferences > File Management  

	 > Data Location.
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Puoi fare una copia della cartella Root per i seguenti motivi:

►► Per creare un backup di questa cartella, che archivia l'intero profilo inclusa la 
Collection, le tue impostazioni attuali, le assegnazioni MIDI e gli Hotkey.

►► Per suonare su di un altro computer, salvando il tuo intero ambiente di lavoro, tracce 
comprese, su di un supporto di archiviazione dati portatile. Indirizzare un altro  
computer alla tua Root Folder personale riproduce il tuo ambiente di lavoro su tale 
computer.

►► Per trasferire il tuo ambiente di lavoro su di un altro computer sul quale è pure in 
esecuzione TRAKTOR.

►► Per creare un User Profile distinto con Collection separate sullo stesso computer.

Si può comunicare a TRAKTOR di passare ad un altra Root folder, il che risulta nel  
cambiamento di Profilo di TRAKTOR.

15.2.2	La Cartella Recordings

Recordings
Oltre alla Root folder TRAKTOR genera una seconda cartella contenente i file audio 
registrati con la funzione Recording di TRAKTOR in formato WAV. Di default essa si trova 
in:

►► PC: Musica\Traktor\Recordings

►► Mac: ~/Musica\Traktor\Recordings

!
Il Recordings Folder non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

! 
Non è possibile modificare 
il percorso della cartella  

	 Recordings. 
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15.2.3	Backup Completo
Oltre al backup automatico della Collection, di tanto in tanto ha anche senso eseguire il 
backup manuale della cartella Root nella sua interezza.

►► Il Root folder è nominato TRAKTOR. Il percorso di default del Root folder è specifi-
cato nella sezione precedente 15.2.1 (Il Root Folder di TRAKTOR).	

Se hai impostato il Root folder su di un'altra destinazione, è possibile risalire al percorso 
esatto in questo modo:

►► Apri Preferences > File Management > Data Location.

►► Clicca "...!" vicino al campo Root Dir.

►► Il browser dei file indicherà la posizione attuale del Root folder.

Per eseguire un backup completo dei tuoi file personali di TRAKTOR, fai una copia del 
Root Folder di TRAKTOR e salvalo su di un disco rigido a parte. 

Accertati di eseguire anche il backup della cartella RECORDINGS. Il percorso di default del 
RECORDINGS folder è specificato nella sezione precedente 15.2.2 (Il Recordings Folder).

15.2.4	Ripristina TRAKTOR da un Backup

Metodo 1:
Questo metodo elimina le impostazioni correnti e la Collection. Utilizza questo  
procedimento dopo avere re-installato TRAKTOR.

►► Accertati che TRAKTOR non sia in esecuzione.

►► Sovrascrivi il Root folder attuale con il contenuto di quello di cui si è eseguito il 
backup. Il percorso di default della cartella da sostituire è: PC: Documenti\Native 
Instruments\Traktor

►► Mac: ~/Native Instruments/Traktor

►► Riavvia TRAKTOR.

% 
Puoi cambiare il percorso in 
Preferences > File Management 

> Data Location.
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Metodo 2:
Questo metodo permette di preservare le impostazioni attuali e la Collection. Puoi ritornare 
a queste impostazioni in ogni momento semplicemente ripetendo questo procedimento.

►► Copia il backup del Root Folder nel tuo computer.

►► Apri Preferences > File Management > Data Location.

►► Clicca "...!" vicino al campo Root Dir.

►► Punta alla posizione della cartella di backup che hai creato precedentemente.

►► Conferma e riavvia TRAKTOR.

15.2.5	Crea una versione portatile di TRAKTOR
Salvando tutte le tue tracce ed il Root Folder su di un hard disk esterno è possibile 
ricreare il tuo profilo personale su ogni computer sul quale TRAKTOR è in esecuzione.  
Procedi come segue.

Sul computer 1:
►► Accertati che TRAKTOR sia chiuso.

►► Sposta tutte le tracce necessarie sul disco fisso portatile.

►► Copia la Root folder attuale sul supporto esterno.

►► Avvia TRAKTOR

►► Apri Preferences > File Management > Data Location.

►► Clicca "...!" vicino al campo Root Dir.

►► Punta alla posizione della copia della cartella di backup che hai appena creato sul 
supporto portatile.

►► Chiudi e riavvia TRAKTOR per assicurarti che il cambiamento abbia funzionato. 
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Sul computer 2
►► Collega il supporto portatile

►► Avvia TRAKTOR

►► Apri Preferences > File Management > Data Location.

►► Clicca "...!" vicino al campo Root Dir.

►► Punta alla Root folder del supporto portatile.

►► Riavvia TRAKTOR.

Se la lettera del drive (Win) o il nome del drive e la user directory (Mac) del tuo percorso 
personalizzato non sono cambiati dovresti essere in grado di trovare tutto nello stesso 
stato di prima della nuova installazione. 

Se la lettera del drive della posizione personalizzata è cambiato, potrai osservare che tutte 
le tracce sono contraddistinte dal simbolo (!) che indica link interrotti. Usa la funzione 
Relocate per trovare nuovamente questi file. 

15.2.6	Backup Collection Automatico (Backup di sicurezza) 
Ogni volta che cambi qualcosa all'interno della tua Collection e chiudi TRAKTOR, verrà 
generato un backup della tua Collection nella cartella "Backup" contenuta nella tua cartella 
"Traktor". Se per errore dovessi eliminare o compromettere in parte la tua Track Collection 
procedi come segue:

►► Click destro/ctrl click sulla Collection Tree Icon e seleziona Import Collection dal menu 
contestuale.

►► Nella cartella "Backup", seleziona la versione di backup che desideri ripristinare.

►► Conferma con OK. 
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15.2.7	Riparare una Collection Corrotta
Una Collection corrotta potrebbe causare un crash di TRAKTOR all'avvio. Se non è 
possibile avviare TRAKTOR procedi come segue:

►► RInomina il file collection.nml della Root folder attuale di TRAKTOR in collection_orig-
inal.nml.

►► Riavvia TRAKTOR - questa operazione creerà una nuova Collection.

►► Prova ad importare un backup della Collection come descritto sopra.

15.3	 Sincronizzazione Tramite MIDI Clock

TRAKTOR ti permette di sincronizzare hardware e software esterno. Per questa funzional-
ità vengono utilizzati segnali di clock MIDI ed il Master Clock Panel nella Global Section.

15.3.1	TRAKTOR come Sorgente del tempo (Invio MIDI Clock)
Per utilizzare TRAKTOR come sorgente del tempo esso deve inviare segnali di MIDI Clock 
all'hardware o software esterno.

►► Per poter inviare il segnale di MIDI Clock devi attivare il tuo dispositivo MIDI in uscita 
che invierà il segnale di MIDI Clock in Preferences > MIDI Setup.

►► Dalla stessa pagina delle Preferences, devi attivare l'opzione Send MIDI Clock.

►► Nella Global Section, apri il Master Clock Panel cliccando il Metronomo.

►► Seleziona la modalità Auto o Manual.

►► Per iniziare ad inviare segnale di MIDI Clock, clicca Start/Stop. Un ulteriore click inter-
rompe l'invio. Se il MIDI Clock è attivo, il pulsante Start/Stop diventa blu.

►► Il Tempo Display  indica il tempo del segnale MIDI Clock in BPM.

! 
Non è possibile risolvere seri 
problemi di corruzione del file 

con questo metodo.

!
La sincronizzazione via MIDI 
Clock non è disponibile in 

TRAKTOR DUO e TRAKTOR LE.

% 
Per sincronizzare hardware es-
terno via MIDI Clock, il Master 

Clock deve essere impostato come 
Master Tempo Source.
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►► Cliccando il tasto Sync, TRAKTOR fa partire un messaggio di MIDI Clock Stop imme-
diatamente seguito da un messaggio di MIDI Clock Start per sincronizzare nuovamente 
l'hardware esterno.

►► Potrebbe essere necessario regolare l'offset fra TRAKTOR e l'hardware o software in 
ricezione. Per fare ciò, utilizza lo slider nominato MIDI Clock Sending Offset che si 
trova in Preferences > MIDI Setup.

15.3.2	Sincronizzare TRAKTOR ad un Segnale MIDI Clock Esterno (External Sync)
►► TRAKTOR è in grado di ricevere segnali MIDI Clock da un altro computer dove 

TRAKTOR o altre applicazioni sono esecuzione, o da hardware MIDI che invia MIDI 
Clock.

►► Per poter ricevere il segnale di MIDI Clock devi selezionare il dispositivo MIDI in in-
gresso che si appresta a ricevere il segnale di MIDI Clock in Preferences > MIDI Setup.

►► Nella Global Section, apri il Master Clock Panel cliccando il Metronomo.

►► Seleziona External Mode (Ext). In questa modalità il master clock di TRAKTOR segue 
il segnale MIDI Clock esterno una volta inviato.

►► Per sincronizzare il clock alla fase dell'hardware o dell'applicazione che invia il segnale 
di MIDI Clock, premi start sul dispositivo in trasmissione.

►► In caso di uno sfasamento tra l'hardware o software e TRAKTOR, l'offset deve essere 
corretto dal dispositivo in trasmissione.

15.3.3	Sincronizzare due versioni di TRAKTOR
Questi sono i passaggi necessari per sincronizzare due versioni di TRAKTOR in esecuzione 
su due computer differenti.

►► Collega via MIDI i due computer per trasmettere segnali MIDI

►► Decidi quale dei due computer deve essere il Tempo Master e segui le istruzioni  
descritte all'interno della sezione 10.2 (Master Clock Panel).   

►► Sull'altro computer segui le istruzioni descritte nella sezione 10.2 (Master Clock Panel).

►► Per sincronizzare entrambi i computer, premi il tasto TICK nel Master Clock Panel.   
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►► Una volta che i due tick sono udibili, premi il tasto SYNC sul computer in 
trasmissione per effettuare il reset del computer in ricezione.

►► Ora inizia a regolare lo slider MIDI Clock Sending Offset che si trova in Preferences > 
MIDI Setup fino a che i due tick sono in perfetta sincronia.

►► Infine puoi disattivare i due Ticks e sei pronto per iniziare.

15.4	 Broadcasting

Con TRAKTOR puoi trasmettere il tuo mix su Internet. In pratica tutto ciò che viene udito 
dal Master Out verrà trasmesso in streaming su Internet e gli ascoltatori da ogni parte del 
mondo saranno in grado di sintonizzarsi ed ascoltare il tuo show in tempo reale.

15.4.1	Protocollo di Streaming
TRAKTOR utilizza un protocollo di streaming chiamato Icecast. Il software di TRAKTOR 
contiene un client Icecast, capace di inviare dati ad un server Icecast.

Per utilizzare questa caratteristica, è necessario avere accesso ad un computer sul quale un 
server Icecast è in esecuzione. Si raccomanda che questo computer sia provvisto di una con-
nessione internet con almeno 128 kb/s di transfer rate in upstream. La larghezza di banda 
disponibile viene divisa tramite gli ascoltatori, per cui deve essere più ampia possibile.

►► Per imparare a configurare un server Icecast, consulta il sito internet Icecast nella 
sezione"Docs": www.icecast.org/docs.php

!
Il Broadcasting Mode non è 
disponibile in TRAKTOR DUO 

	 e TRAKTOR LE.

% 
Per saperne di più su questo 
protocollo di streaming e su 

come installare un server, fai riferimento 
alla homepage ufficiale di Icecast (www.
icecast.org).

! 
Utente Mac: Icecast fun-
z i o n a  s o l a m e n t e  c o n 

Windows e Linux. Per effettuare il 
Broadcasting con un Mac dai un oc-
chiata alla applicazione dal semplice 
utilizzo Nicecast su rogue amoeba:	  
rogueamoeba.com/nicecast/

http://www.icecast.org/docs.php
http://www.icecast.org
http://www.icecast.org
http://rogueamoeba.com/nicecast/
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15.4.2	Configurazione di TRAKTOR
Prima di iniziare, è necessario configurare TRAKTOR in modo che il client locale si possa 
collegare al server ed i metadata dello stream radio contengano le corrette informazioni.

►► Apri Traktor e vai su Preferences > Broadcasting.

►► Regola Proxy Settings in relazione alla tua configurazione internet attuale. Se non 
utilizzi un proxy, seleziona Use Direct Connection.

►► Poi, inserisci l'indirizzo del server Icecast al quale desideri collegarti. Esso è costitu-
ito da un hostname o un indirizzo IP.

►► Specifica la porta dove è possibile raggiungere il server. La maggior parte dei server 
utilizzano il setting di default 8000.

►► Digita il percorso e la password. E' possibile ottenere questa informazione dall'host 
del server Icecast e  permette solo a client selezionati di effettuare lo streaming da lì.

►► Seleziona il formato dello streaming. Ricordati che con una bit rate superiore è  
necessaria una larghezza di banda superiore per ogni singolo stream. Per questo mo-
tivo, un numero inferiore di ascoltatori si possono sintonizzare contemporaneamente.

►► Infine, puoi specificare le impostazioni metadata del client. Questa informazione viene 
inviata al server ed ai tuoi ascoltatori.

15.4.3	Avviare la Trasmissione
Una volta effettuate le configurazioni necessarie, puoi iniziare il tuo stream dal vivo:

1.	 Apri l'Audio Recorder Panel nella Global Section.

2.	 Clicca il tasto Broadcast On/Off.

►► Se il pulsante è premuto, sei collegato al server e puoi iniziare la tua trasmissione.

►► Se il simbolo inizia a lampeggiare, non è stato possibile stabilire una connessione con 
il server. Controlla ancora una volta il procedimento di configurazione ed assicurati 
che tutti i dati siano inseriti in maniera corretta.

% 
Cerca di essere molto specifico 
nella tua descrizione; più facile 

sarà identificare il contenuto musicale 
del tuo stream, più probabilità ci saranno 
che degli ascoltatori si colleghino!
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15.5	 Effetti in Dettaglio

15.5.1	 Introduzione
Questo capitolo illustra in dettaglio le informazioni sui singoli aspetti degli effetti di cui 
TRAKTOR è provvisto. Ulteriori informazioni riguardo agli effetti di Traktor si trovano nel 
capitolo 10.3 (Effect Panels).

15.5.2	Parametri Comuni
Tutti gli effetti presentano i seguenti parametri in comune:

D/W (Dry/Wet)
Questo parametro controlla il bilanciamento fra il segnale originale (Dry; posizione  
completamente a sinistra) ed il segnale dell'effetto (Wet; posizione completamente a  
destra) per tutti gli effetti.

ON
Questo tasto accende e spegne l'effetto per tutti gli effetti. Alcuni effetti che si basano 
sul buffer come il Delay o il Reverb continueranno a trasmettere segnale in uscita per un 
certo tempo dopo averli disattivati. Per disabilitare completamente l'azione di un effetto 
su di un canale specifico usa gli Effect Assign Buttons nella mixer strip del canale.

Snapshot & Reset
Questo tasto ripristina i parametri dell'effetto sul suo valore di default per tutti gli effetti. 
E' possibile salvare il valore di default premendo lo Snapshot Button (simbolo camera) nel 
pannello degli effetti. Passando da un effetto all'altro, il nuovo effetto verrà ripristinato alla 
sua posizione di default. 

! 
Alcuni effetti integrano di più 
che un semplice controllo Dry 

Wet nel knob D/W. Il knob per questi 
effetti si chiama D/RNG (Dry-Range) e 
la sua azione è descritta a parte nelle 
spiegazioni degli effetti.

! 
Alcuni effetti impiegano il pul-
sante On per attivare il procedi-

mento di campionamento necessario per 
riempire il buffer dell'effetto. Questi ef-
fetti devono essere avviati in stato Off. 
Avviandoli in stato On non si avrà nessun 
contenuto audio.

!
Per far si che il Gater riesca a 
corrispondere ai beat della mu-

sica, è assolutamente necessario che le 
tue tracce abbiano Beat Grid bene al-
lineati e che il Master Clock segua il 
tempo della traccia in Auto Mode.
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15.5.3	Gater
Il Gater effettua ritmicamente il mute di parti del segnale audio con una frequenza 
regolabile. Il Master Clock controlla la frequenza e la lunghezza del muting. E' possibile 
aggiungere un rumore di fondo al Gater per enfatizzare il pattern ritmico.

Advanced Mode
NOISE (Noise Level)

►► Controlla la quantità di rumore di fondo che verrà aggiunta al Gate Min: nessun rumore 
aggiunto Max: il massimo rumore possibile

SHAPE

►► Controlla la forma del Gate. Min - Center:	1% Hold, 0% Decay - 50% Hold, 0% Decay 
Center - Max:	50% Hold, 0% Decay - 0% Hold, 100% Decay	

RATE

►► Controlla la frequenza del Gater.

►► I 5 valori disponibili sono espressi in frazioni di battuta, e sono distribuiti in maniera 
uguale lungo il range del knob. Min - Max: Off - 1/4 - 1/8 - 1/16 - 1/32	

MTE (Mute)

►► Effettua il mute assoluto della musica e lascia passare solamente il rumore di fondo.	

STT (Stutter)

►► Attiva un tempo di 3/16 per produrre un effetto di stutter.

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob controlla la frequenza del Gater e si comporta come il Rate knob in Advanced 

Mode. 

!
Il Gater non è disponibile in 
TRAKTOR LE.

! 
Attivando MTE in combinazione 
con un rumore di fondo pari a 

zero risulta in nessun audio in uscita.

! 
L'attivazione di STT disabilita 
l'azione del Rate knob.
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15.5.4			 Flanger
Un classico Flanger standard con controllo della frequenza basato sui BPM o libero, e 
sfasamento stereo.

Advanced Mode
SPRD (Stereo Spread)

►► Crea un effetto di Stereo Spread controllando il phase offset tra canale sinistro e 
destro. Min: nessun offset di phase Max: phase offset massimo (1/2 periodo).

FEEDB (Feedback)

►► Controlla l'intensità del feedback del Flanger, rendendo l'effetto più forte e colorato. 
Min: feedback minimo Max: feedback elevato

	

RATE

►► Controlla la frequenza dell'oscillazione del Flanger.

►► Gli 11 valori disponibili sono espressi in frazioni di battuta, e sono distribuiti in maniera 
uguale lungo il range del knob.  Min - Max: 16 bars, 8 bars, 4 bars, 2 bars, 4/4, 2/4, 
3/8, 1/4, 3/16, 1/8, 1/16	

UP

►► Quando premuto, viene invertita la direzione dell'oscillazione, parte con la frequenza 
più bassa e si sposta verso l'alto.	

FR.R

►► Abilita il controllo di frequenza continuo, indipendentemente dal tempo della musica 
ed ha un range compreso fra 30 sec (Min) a 1/30 sec (Max)	

% 
Il pulsante LFO RESET nel 
Master Panel ripristina la fase 

dell'oscillazione di bassa frequenza a 
zero (punto più alto).

! 
In modalità Freerun (Fr.R) la 
frequenza dell'oscillazione del 

Flanger non è legata al tempo della mu-
sica e varia continuamente da 30 ms 
(Min) a 1/30 di secondo (Max)
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LFO RESET (Master Panel)

►► Ripristina l'oscillazione e riparte al valore più basso o più alto, a seconda dello stato 
di DN/UP

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob controlla la frequenza dell'oscillazione del suono del flanger verso l'alto o 

verso il basso. Il knob si comporta come il Rate knob con la funzione Freerun attivata 
in Advanced Mode.	

15.5.5	Phaser
Un classico Phaser standard con controllo della sequenza basato sui BPM o libero, 
ed inversione di fase stereo.

►► I controlli del Phaser si comportano in maniera identica a quelli del Flanger descritti 
precedentemente.	

15.5.6	Filter LFO
Classico filtro basato sull'architettura ladder e dotato di LFO sincronizzabile. L'LFO può 
essere controllata dal Beat Grid (e quindi sempre in sync con la traccia) o può anche agire 
in modalità Freerun.

Advanced Mode
D/RNG (Dry.Range)

►► Controlla l'intensità dell'effetto con una combinazione di Dry-Wet e del LFO-RANGE. 
Il filtro è totalmente bypassato quando il controllo è completamente a sinistra.

►► Nonappena il knob cessa di essere posizionato completamente a sinistra, il filtro agisce 
al massimo ed il knob aumenta progressivamente il range della LFO a mano a mano 
che lo si ruota in senso orario.	  

!
Il Phaser non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.

!
ll Filter LFO non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.
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SHAPE

►► Controlla la forma del LFO.

►► Alla posizione di sinistra del knob la forma è triangolare, effettuando il morph in onda 
a dente di sega con un forte decay avvicinandosi alla posizione di destra.	

RES

►► Controlla la resonance del filtro. Valori di resonance elevati rendono il suono del filtro 
colorato e più facilmente distinguibile. Min: resonance bassa Max: Resonance elevata

RATE

►► Controlla la frequenza dell'oscillazione del Filtro.

►► Gli 11 valori disponibili sono espressi in frazioni di battuta, e sono distribuiti in maniera 
uguale lungo il range del knob.  Min - Max: 16 bars, 8 bars, 4 bars, 2 bars, 4/4, 2/4, 
3/8, 1/4, 3/16, 1/8, 1/16	

Chained Mode (Controllo con 1 Knob)

►► Il knob si comporta come il Rate knob con la funzione Freerun dell'Advanced Mode.	

15.5.7	Filtro: 92 LFO
Questo filtro è modellato su quello del mixer Allen & Heath Xone:92, dotato di funzione 
LFO sincronizzabile. L'LFO può essere controllata dal BeatGrid (e quindi sempre in sync 
con la traccia) o può anche agire in modalità Freerun.

►► I controlli del Filter:92 LFO si comportano in maniera identica  a quelli del Filter de-
scritti precedentemente.	

% 
Il pulsante LFO RESET nel 
Master Panel ripristina la fase 

dell'oscillazione di bassa frequenza a 
zero (punto più alto).

!
ll Filter:92 non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.
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15.5.8	Filter
Classici filtri standard con modalità di controllo a 2 knob e knob singolo, basati 
sull'architettura di filtro ladder.

Advanced Mode
HP (High Pass)

►► Controlla la frequenza di cutoff dei bassi.

►► Il posizione totalmente a sinistra lascia passare l'intera banda.

►► Ruotandolo verso destra esso taglia in maniera progressiva le frequenze da quelle 
basse a quelle alte.	

RES

►► Controlla la resonance del filtro. Valori di resonance elevati rendono il suono del filtro 
colorato e più facilmente distinguibile. Min: resonance bassa Max: Resonance elevata

LP (Low Pass)

►► Controlla la frequenza di cutoff degli alti.

►► Se posizionato totalmente a destra lascia passare l'intera banda.

►► Ruotandolo verso sinistra esso taglia in maniera progressiva le frequenze da quelle 
alte a quelle basse.	

BRJ (Band Reject)

►► Imposta il filtro in modalità Band Reject. In questa modalità le frequenze comprese 
tra le due frequenze di cutoff vengono eliminate anziché lasciate passare.	

% 
In DJ Mode (DJM) il LP knob 
è nominato LP/HP ed ha una 

funzione combinata di filtro passa bassi 
e passa alti.
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DJM (DJ Mode)

►► Imposta il pannello alla modalità di controllo del filtro ad un solo 1 knob. Il knob LP 
diventa un controllo bipolare per controllare sia la frequenza di cutoff inferiore che 
quella superiore.

►► Il posizione centrale lascia passare l'intera banda.

►► Ruotandolo dal centro a sinistra esso taglia in maniera progressiva le frequenze  
da quelle alte a quelle basse.

►► Ruotandolo dal centro a destra esso taglia in maniera progressiva le frequenze  
da quelle basse a quelle alte.

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob controlla l'effetto in DJ Mode e si comporta come il LP/HP knob in Advanced 

Mode.

15.5.9	Filtro:92
Questo filtro è modellato su quello del mixer Allen & Heath Xone:92.

►► I controlli del Filter:92 si comportano in maniera identica a quelli del Filter descritti 
precedentemente.	

15.5.10	 Flanger Flux
Flanger controllato manualmente ideale per il controllo tramite jog wheel.

Advanced Mode
FEEDB (Feedback)

►► Controlla l'intensità del feedback del Flanger, rendendo l'effetto più forte e colorato. 
Min: feedback minimo Max: feedback elevato

PITCH

►► Controlla il pitch dell'effetto. La posizione centrale del knob è neutrale - ad entrambi 
i lati l'effetto di flanger si sposta dalle frequenze alte a quelle basse.	

!
ll Filter:92 non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.

!
Il Flanger Flux non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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FB (Inverted Feedback)

►► Permette esclusivamente il passaggio di armoniche dispari, permettendo al flanger di 
suonare più profondo nello spettro di frequenze.	

SPR (Stereo Spread)

►► Crea uno sfasamento tra l'effetto di flanger del canale sinistro e quello destro,  
sortendo un effetto di profondità spaziale.

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob controlla il pitch dell'effetto. La posizione centrale del knob è neutrale -  

ad entrambi i lati l'effetto di flanger si sposta dalle frequenze alte a quelle basse.	

15.5.11	 Phaser Flux
Flanger controllabile manualmente ideale per il controllo tramite jog wheel.

I controlli del Phaser Flux si comportano in maniera identica  a quelli del Flanger Flux 
descritti precedentemente, a parte lo 8 Pole Switch.

8 PL (8 Pole)

►► Passa da filtro a 6 poli a filtro ad 8 poli, rendendo più intenso l'effetto.	

15.5.12	 Flanger Pulse
Effetto di Flanger innovativo e semi automatico attivato dai picchi del segnale presenti 
nella musica, producendo suoni dall'inviluppo interessante.

Ottiene l'effetto massimo su musica nella quale sono presenti intervalli, come ad es. loop 
di batteria, i quali permettono all'oscillatore automatico di svilupparsi al meglio grazie agli 
spazi vuoti contenuti nella musica. 

!
Il Phaser Flux non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.

!
Il Flanger Pulse non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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Advanced Mode
SHAPE

►► Controlla la forma del Flanger Pulse. Il range del controllo racchiude una moltitudine di 
pattern ed effettua il morphing tra di essi per effetti sonori costantemente innovativi.

►► Esplora il range di questo knob in combinazione con il knob FEEDB e con AMNT e 
salva un preset quando sei soddisfatto di esso.	

FEEDB (Feedback)

►► Controlla l'intensità del feedback del Flanger, rendendo l'effetto più forte e colorato. 
Min: feedback corto; Max: feedback intenso

AMNT (Amount)

►► Il knob ha due zone operative, al lato sinistro e a quello destro della posizione centrale 
controlla la quantità della modulazione della frequenza del Flanger.	

FB (Inverted Feedback)

►► Permette esclusivamente il passaggio di armoniche dispari, permettendo al flanger di 
suonare più profondo nello spettro di frequenze.	

SPRD (Stereo Spread)

►► Crea uno sfasamento tra l'effetto di flanger del canale sinistro e quello destro,  
sortendo un effetto di profondità spaziale. 

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob ha due zone operative, al lato sinistro e a quello destro della posizione centrale. 

Si comporta come il knob AMNT in Advanced Mode. 
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15.5.13	 Phaser Pulse
Effetto di Phaser innovativo e controllabile automaticamente che viene attivato dai picchi 
del segnale presenti nella musica, producendo suoni dall'inviluppo interessante.

Ottiene l'effetto massimo su musica nella quale sono presenti intervalli, come ad es. loop 
di batteria, i quali permettono all'oscillatore automatico di svilupparsi al meglio grazie agli 
spazi vuoti contenuti nella musica.

I controlli del Phaser Pulse si comportano in maniera identica  a quelli del Flanger Pulse 
descritti precedentemente, a parte lo 8 Pole Switch.

8 PL (8 Pole)

►► Passa da filtro a 6 poli a filtro ad 8 poli, rendendo più intenso l'effetto.

15.5.14	 Filter Pulse
Effetto di Filtro innovativo e controllato automaticamente basato sull'architettura filtro 
ladder, e attivato dai picchi del segnale presenti nella musica, producendo suoni 
dall'inviluppo interessante.

Ottiene l'effetto massimo su musica nella quale sono presenti intervalli, come ad es. Loop 
di batteria, i quali permettono all'oscillatore automatico di svilupparsi al meglio grazie agli 
spazi vuoti contenuti nella musica.

Advanced Mode
D/W (Dry/Wet)

►► Il controllo D/W è più di un semplice controllo di mix. Esso controlla anche la 
frequenza di cutoff dove i verifica l'azione del filtro automatico. 

►► Usa D/W in combinazione con il tasto Env per esplorare le dimensioni dell'affetto in 
questione.

!
Il Phaser Pulse non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

!
ll Filter Pulse non è disponi-
bile in TRAKTOR DUO e 

	 TRAKTOR LE.
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SOFTEN

►► Controlla la delicatezza dell'inviluppo del cutoff. Più il knob viene ruotato verso destra, 
più morbida sarà la modulazione del filtro.

RES

►► Controlla la resonance del filtro. Valori di resonance elevati rendono il suono del filtro 
colorato e più facilmente distinguibile. Min: resonance bassa Max: Resonance elevata

ENV

►► Controlla la frequenza di cutoff dove avviene l'azione di filtro automatico. In confronto 
ad un normale filtro, la frequenza del filtro viene modulata dai picchi della musica, 
ottenendo come risultato un pattern dinamico di modulazioni del filtro.

►► In posizione centrale la modulazione è neutrale, a destra la modulazione si sposta 
verso l'alto ed a sinistra verso il basso. 

►► L'effetto del knob ENV è dipendente in maniera profonda dalla posizione del knob D/W.

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob si comporta come l'AMNT knob in Advanced Mode.

15.5.15	 Filtro:92 Pulse
Effetto di Filtro innovativo e controllabile automaticamente modellato sui filtri del mixer 
Allen & Heath Xone:92 che viene attivato dai picchi del segnale presenti nella musica, 
producendo suoni dall'inviluppo interessante.

Ottiene l'effetto massimo su musica nella quale sono presenti intervalli, come ad es. loop 
di batteria, i quali permettono all'oscillatore automatico di svilupparsi al meglio grazie agli 
spazi vuoti contenuti nella musica.

►► i controlli del Filter:92 Pulse si comportano in maniera identica  a quelli del Filter 
descritti precedentemente. 

!
ll Filter:92 Pulse non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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15.5.16	 Delay
Classico Delay sincronizzabile dotato di tasto Freeze. La frequenza del a Delay viene cont-
rollata direttamente dal Master Clock di TRAKTOR per far si che il Delay continui a seguire 
il beat anche durante cambiamenti del tempo.

Advanced Mode
FILTER

►► Filtro interno al carbonio passa alti e passa bassi (simile ad un filtro passa banda). 
Il filtro viene aperto quando il knob è alla completa sinistra e taglia in maniera prores-
siva le basse ed alte frequenze ruotando verso destra.

FEEDB (Feedback)

►► Controlla l'intensità del feedback del Delay, rendendo l'effetto più forte e colorato.  
Min: feedback minimo Max: feedback elevato

RATE

►► Controlla il tempo del Delay.

►► I 7 valori disponibili sono espressi in frazioni di battuta, e sono distribuiti in maniera 
uguale lungo il range del knob. Min - Max: 1/32, 1/16, 1/8, 3/16, 1/4, 3/8, 4/4.	 

FRZ (Freeze)

►► Congela il Delay chiudendo l'ingresso ed impostando il Feedback sul massimo valore 
disponibile. 

►► Il filtro rimane attivo nel loop del feedback. Per freeze senza fine, il knob FILTER deve 
essere posizionato completamente a sinistra.	

% 
La frequenza dell'effetto 
può venire modulata durante 

l'operazione senza alcun crack o glitch 
nell'audio.

% 
Anche in modalità Freeze i 
Delay segue il Master Clock e 

perciò si fonderà naturalmente con il mix 
nonappena rilasciato.

! 
Il knob Rate continua a funzi-
onare in Freeze Mode e per-

mette di effettuare interessanti Mash-
Up. Tuttavia è fondamentale impostare 
il knob su valori bassi solo brevemente 
altrimenti il buffer perderà tutto il suo 
contenuto. 
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SPREAD

►► Crea uno sfasamento tra l'effetto di delay del canale sinistro e quello destro, sortendo 
un effetto di profondità spaziale. 

►► I tempi del Delay sono: L Min - Max: 1/32, 1/16, 1/8, 3/16, 2/4, 3/8, 4/4 R  
Min - Max: 1/32, 1/8, 3/16, 3/8, 3/8, 2/4, 4/4	

Chained Mode (Controllo con 1 Knob)
Il knob si comporta come il Rate knob nell'Advanced Mode quando è impostato su di un 
valore di feedback intermedio.

15.5.17	 Reverb
Classico Reverb standard con Room Size estremamente grandi, controlli individuali di filtro 
passa alti e passa bassi, e funzione freeze.

Advanced Mode
LP 

►► Filtro passa bassi inserito nel loop dell'effetto - completamente aperto se posizionato 
completamente a sinistra.	

HP

►► Filtro passa alti inserito nel loop dell'effetto - completamente aperto se posizionato 
completamente a destra.	

SIZE

►► Controlla le dimensioni della riverberazione introdotta, in una gamma che passa da 
Room Size piccoli a molto grandi.	

FRZ (Freeze)

►► Congela il Reverb chiudendo l'ingresso e lasciando aperta l'uscita.	
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CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob si comporta come il SIZE knob in Advanced Mode.	

15.5.18	 Iceverb
L'Iceverb è un riverbero innovativo con filtri auto oscillanti per ottenere effetti interessanti 
e colorati. Il Filter di Iceverb è fuori dal loop del feedback, e questo permette  al suo 
decadimento di essere indipendente dalle impostazioni del filtro.

Advanced Mode
COLOR

►► Controlla la frequenza di cutoff del filtro e di conseguenza il colore del riverbero.	

ICING

►► Controlla la resonance del filtro e di conseguenza l'intensità del colore.	

SIZE

►► Controlla le dimensioni della riverberazione introdotta, in una gamma che passa da 
Room Size piccoli a molto grandi.

FRZ (Freeze)

►► Congela il Reverb chiudendo l'ingresso e lasciando aperta l'uscita. 

►► Il controllo SIZE rimane attivo in modalità Freeze permettendo la creazioni di interes-
santi effetti di pitch.	

CHAINED MODE (CONTROLLO CON 1 KNOB)
►► Il knob si comporta come il SIZE knob in Advanced Mode.	

!
L'Iceverb non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.
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15.5.19	 Transpose Stretch
Il Transpose Stretch è un classico Pitch Shifter con controlli aggiuntivi di Grain Size 
e Time Stretch.

Advanced Mode
STRCH (Time Stretch)

►► Quando si sposta il knob al di fuori della posizione all'estrema sinistra, l'ingresso viene 
registrato per 1 bar (2 se il tasto "Tx2" è attivato) e ripetuto all'infinito in loop. 

►► Più si procede alla rotazione del knob verso destra, più lungo sarà lo stretch del 
tempo fino a che la musica si bloccherà completamente su di un singolo "Grain".	

GRNSZ (Grain Size)

►► Questo knob funziona quando il tasto GRN sottostante è attivo, e controlla le dimen-
sioni del grain. Di norma il grain size è legato direttamente internamente per una 
migliore intonazione complessiva.

►► Esso ha un range che va da grain molto larghi (333 ms) se in posizione completamente 
a destra a grain brevi (5 ms) se posizionato completamente a sinistra.

►► Dimensioni particolarmente piccole possono creare un interessante effetto di modu-
lazione FM/ring dal suono metallico. Prova inoltre la modalità di arresto completo e 
trasponi il valore al massimo per creare suoni metallici e "lamentevoli".	

KEY

►► Controlla il pitch dei grain.

►► La posizione centrale è neutrale e riproduce i grain all'intonazione originale.

►► A destra, i grain vengono intonati fino ad un'ottava in alto se in posizione completa-
mente a destra.

►► A sinistra, i grain possono essere intonati in basso fino a 5 ottave.	

!
Il Transpose Stretch non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

! 
Il knob STRCH deve essere 
posizionato completamente a 

sinistra per aprire l'ingresso dell'effetto. 
Occorre caricare l'effetto con il knob 
STRCH posizionato completamente a 
sinistra!
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GRN

►► Abilita il Grain Size Control

ST.2

►► Esegue 2 bar anziché una sola quando ci si trova in modalità STRCH	

Chained Mode (Controllo con 1 Knob)
►► Il knob si comporta come il KEY knob in Advanced Mode.	

15.5.20	 Reverse Grain
Effetto basato sul buffer che serve a catturare un loop dall'audio attualmente in esecuzione 
e a ripeterlo successivamente al contrario, con varie opzioni di modulazione.

Advanced Mode
ON

►► Effettua il sampling dell'audio e riproduce l'audio del buffer al contrario.	

PITCH

►► Controlla il pitch dell'audio acquisito. 

►► L'intonazione originale è ottenuta se posizionato interamente a destra. Ruotandolo 
verso sinistra  il pitch si abbassa in maniera progressiva.

►► Il range va da 0 a 100	

GRNSZ

►► Controlla le dimensioni degli audio grain. Crea interessanti effetti se usato in combin-
azione con lo Speed Knob.	

! 
L'effetto deve essere avviato in 
modalità Off e poi acceso per 

effettuare il sampling dell'audio corrente.

!
Il Reverse Gain non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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SPEED

►► Controlla la velocità di esecuzione degli audio grain del campionamento.

►► Esegue il sample a velocità normale in posizione di completa destra.

►► Riduce in maniera progressiva la propria velocità quando ruotato verso sinistra.	

INV

►► Riproduce i grain in ordine inverso.	

FWD (Forward)

►► Inverte la direzione di playback da playback all'indietro a playback in avanti.	

Chained Mode (Controllo con 1 Knob)
►► Il knob si comporta come il GRNSZ knob in Advanced Mode.	

15.5.21	 Ring Modulator
Il Ring Modulator è un effetto che modula le tracce moltiplicando un segnale ad alta fre-
quenza ed aggiungendolo al materiale audio.

Advanced Mode
AM-RM

►► Effettua il morphing del tipo di modulazione da modulazione di ampiezza quando 
posizionato completamente a sinistra o ring modulation quando interamente a destra.

►► La modulazione di ampiezza suona più morbida in confronto alla ring modulation.	

!
Il Ring Modulator non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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RAW

►► Controlla la forma dell'oscillatore della modulazione. 

►► L'oscillatore è un'onda sinusoidale quando posizionato interamente a sinistra, ideale 
per creare suoni morbidi, ed una onda square filtrata quando posizionato a destra, per 
ottenere suoni più graffianti. 	

PITCH

►► Controlla la frequenza di modulazione dell'oscillatore da bassa se completamente  
a sinistra o alta se completamente posizionato a destra  (100 Hz - 8371 Hz).	

Chained Mode (Controllo con 1 Knob)
►► Il comportamento di questo knob è una combinazione delle caratteristiche dei  

controlli RAW e PITCH che si trovano nell'Advanced Effect Mode.	

15.5.22	 Digital LoFi
Digital LoFi scompone la musica riducendo la sua profondità di bit e la sua frequenza 
di campionamento.

Advanced Mode
BIT (Bit Depth)

►► Controlla la bit rate con un range che va da piena bit rate se posizionato  
completamente a sinistra ad un solo bit di risoluzione se completamente a destra.	

SMTH (Sample Rate Smooth)

►► Ammorbidisce l'effetto introducendo uno sfasamento nella riduzione di sample rate.	

!
Il Digital LoFi non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

! 
Questo knob ha solo effetto se 
combinato con la sample rate  

	 reduction. 
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SMP.RT (Sample Rate)

►► Controlla la riduzione della Sample Rate con valori che vanno da nessuna riduzione se 
posizionato totalmente a sinistra fino a 100Hz di sample rate se totalmente a destra.	

SPREAD

►► Crea uno sfasamento tra il sample riprodotto dal canale sinistro e da quello destro, 
sortendo un effetto di profondità spaziale.	

Chained Mode (Controllo con 1 Knob)
►► Funziona come una combinazione dei tasti SMP.RT e BIT in Advanced Mode.	

15.5.23	 Mulholland Drive
Il Mulholland Drive è un effetto di distorsione estremamente sensibile costituito di due 
unità di overdrive indipendenti ed un imprevedibile comportamento di auto oscillazione. 

Se il Feedback è attivo esso agisce con il massimo effetto su musica nella quale sono  
presenti intervalli, come ad es. loop di batteria, i quali permettono all'oscillatore automatico 
di svilupparsi al meglio grazie agli spazi vuoti contenuti nella musica.

Senza Feedback si comporta come un normale effetto di distorsione.

Advanced Mode
TONE

►► Controlla la frequenza del tono del feedback.

►► Necessità di una certa quantità di feedback per sortire qualche effetto.

►► Genera una grande varietà di toni se utilizzato in combinazione con il knob FEEDB.	

!
Mulholland Drive non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.
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FEEDB (Feedback)

►► Controlla la quantità di feedback presente nell'effetto.

►► Con feedback uguale a zero e posizionato completamente a sinistra, l'effetto si  
comporta come una classica tube distortion.

►► Questo è il controllo che permette di aumentare il contenuto di feedback nell'effetto, 
con valori compresi fra 0 e 100%.	

DRIVE (Overdrive)

►► Controlla quale delle due overdrive unit è alimentata e di quanto.

►► Distorge una sola unità se posizionato interamente a sinistra o a destra, ed effettua  
il morphing avvicinandosi al centro.	

FB (Inverted Feedback)

►► Permette esclusivamente il passaggio di armoniche dispari, permettendo al'effetto di 
suonare più profondo nello spettro di frequenze.	

Chained Mode (Controllo con 1 Knob)
►► Questo knob si comporta come il DRIVE knob in Advanced Mode.	

15.5.24	 Beatmasher
Il Beatmasher  è un effetto basato sul buffer che cattura un breve loop dal materiale 
audio attuale e lo sconvolge rimescolandolo.

Advanced Mode
ON

►► Accendendo l'effetto, esso effettua il sampling di una bar del segnale audio  
basandosi sul tempo del master clock.

►► Per effettuare il sampling di una nuova porzione di audio, spegni ed accendi  
nuovamente l'effetto.	

% 
Se DRIVE e FEEDB sono im-
postati su valori elevati è pos-

sibile che l'effetto produca del suono 
anche senza alcun input.

! 
L'effetto deve essere avviato in 
modalità Off e poi acceso per 

effettuare il sampling dell'audio corrente.

!
Il Beatmasher non è disponibile 
in TRAKTOR LE.
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GATE

Questo è un controllo combinato per varie tipologie di mixaggio e per effettuare il gate 
del materiale campionato.

►► Il posizione totalmente a sinistra bypassa interamente l'effetto. 

►► Spostandosi da sinistra verso il centro, introduce porzioni progressivamente maggiori 
dell'audio presente nel buffer. 

►► In posizione centrale suona l'audio presente nel buffer. 

►► Dalla posizione centrale spostandosi verso destra, taglia porzioni progressivamente 
maggiori di audio come un Gater.

	

ROT (Rotate)

►► Sposta il materiale campionato di scatti di 1/8 di nota rispetto alla posizione originale.	

LEN (Lenght)

►► Controlla la lunghezza dell'audio che viene riprodotto dal buffer.	

FST (Fast)

►► Abilita un secondo range di valori per il controllo della lunghezza, per produrre loop 
molto più corti.	

REV (Reverse)

►► Inverte la direzione del playback dei campioni audio presenti nel buffer.	

Chained Mode (Controllo con 1 Knob)
►► Questo knob si comporta come il Lenght knob in Advanced Mode.
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15.5.25	 Turntable FX
Questo effetto simula il suono prodotto dal riavvolgimento o rallentamento del disco 
suonato sul giradischi.

Advanced Mode
BRK (Turntable Brake)

►► Attiva l'effetto di frenata del giradischi che si verifica togliendo la corrente al motore 
del giradischi.

►► La velocità della frenata del suono viene gestita dal knob B.SPD. 

►► E' possibile controllare la velocità ed il rallentamento in maniera individuale  
cambiando la posizione dello SPEED knob mentre BRK è attivo.	

AMNT

►► Controlla la quantità del movimento ondulatorio attivato tramite il tasto RCK.	

R.SPD

►► Controlla la velocità del movimento ondulatorio attivato tramite il tasto RCK.	

B.SPD

►► Controlla la velocità del movimento di frenata attivato tramite il tasto BRK.	

RCK

►► Attiva il movimento ondulatorio del giradischi.	

REW

►► Attiva l'effetto di riavvolgimento.

►► L'accellerazione dell'effetto di riavvolgimento è controllato dal knob B.SPD.	

! 
L'effetto deve essere avviato in 
modalità Off e poi acceso per 

effettuare il sampling dell'audio corrente.

!
!Il Turntable FX non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 180  

Chained Mode (Controllo con 1 Knob)
►► Il tasto ON si comporta come BRK ed il knob B.SPD in Advanced Effect Mode.	

15.6	 Aggiornamento di TRAKTOR 3 e TRAKTOR Scratch PRO

Sei pregato di leggere questo capitolo nella sua interezza per evitare eventuali perdite di 
dati. Ad ogni modo, si raccomanda comunque di effettuare il backup della tua cartella di 
TRAKTOR prima di effettuare l'aggiornamento ad una nuova versione.

15.6.1	 Utilizzo di TRAKTOR PRO-TRAKTOR SCRATCH PRO a fianco di versioni precedenti 
TRAKTOR PRO/TRAKTOR SCRATCH PRO utilizza una nuova cartella per salvare la sua 
Collection e le impostazioni. E' pertanto possibile eseguire TRAKTOR PRO/TRAKTOR 
SCRATCH PRO a fianco di TRAKTOR 3/TRAKTOR SCRATCH con Collection e file di 
settings distinti.

Non è possibile condividere la stessa Collection, le playlist o i settings fra TRAKTOR PRO/
TRAKTOR SCRATCH PRO e versioni precedenti di TRAKTOR/TRAKTOR SCRATCH.

15.6.2	Importare la tua Collection
Per importare il tuo vecchio file Collection, utilizza l'opzione Import Collection nel menu 
contestuale del Collection Tree Icon. Il processo è automatizzato e non richiede ulteriore 
interazione.

15.6.3	Importare le tue Playlist
Per importare le tue vecchie Playlist, utilizza l'opzione Import Collection nel menu            
contestuale del Playlist Tree Icon. Punta il browser al livello superiore di quello 
contenente le playlist che desideri importare. E' possibile ripetere il procedimento per le playlist  
situate in cartelle diverse.

! 
Si raccomanda di scrivere i tag di 
tutte le tue tracce in TRAKTOR 

3 prima di importarle in TRAKTOR PRO 
o TRAKTOR SCRATCH PRO.
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15.6.4	Importare i tuoi MIDI e Keyboard Mapping
Non è possibile importare assegnazioni MIDI e tastiera da versioni precedenti in TRAKTOR 
PRO o TRAKTOR SCRATCH PRO. Questo per via della totale ristrutturazione dell'architettura 
interna volta a supportare i bisogni legati al numero sempre crescente di controller  
hardware in commercio.

►► L'installazione di TRAKTOR è fornita di un grande numero di file di assegnazioni MIDI 
e tastiera che coprono la maggior parte dei controller in commercio.

►► Inoltre ulteriori file di settings sono disponibili per il download sul sito internet di 
TRAKTOR, accessibile tramite l'opzione Download nella finestra Help del Menu 
Applicazione.
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16	 Cosa c'è di nuovo in TRAKTOR PRO e TRAKTOR 
SCRATCH PRO

Questo capitolo è dedicato agli utenti di TRAKTOR 3 e TRAKTOR SCRATCH. Esso descrive 
i cambiamenti che si noteranno facendo l'aggiornamento a TRAKTOR PRO o TRAKTOR 
SCRATCH PRO, e le ragioni ed i benefici di questi cambiamenti.

16.1	 Interfaccia Utente

Probabilmente la nuova interfaccia utente di TRAKTOR è il cambiamento più immediata-
mente visibile.

16.1.1	 Global Section e Pannelli Avanzati
In TRAKTOR 3 una serie di pannelli specifici nella sezione Details controllavano le funzioni 
avanzate. I pannelli disponibili erano ordinati liberamente su 4 pagine. Frame colorati  
associavano i pannelli relativi ai Deck a questi ultimi.

Nel nuovo TRAKTOR ogni funzione riceve una posizione fissa all'interno dell'interfaccia. 
Funzioni correlate sono state raggruppate e vicendevolmente integrate per ridurne  
la complessità.

Le funzioni avanzate dei Deck sono situate negli Advanced Panels al di sotto di ciascun Deck. 
Funzioni Globali non in relazione con i deck sono situate nella Global Section al di sopra dei 
deck e sotto l'Header. La nuova interfaccia di TRAKTOR non ha pannelli di controllo basati 
sulla selezione del deck tramite focus all'interno della GUI (interfaccia grafica) ma il concetto 
di controllo basato su tale focus rimane comunque valido nel dominio MIDI e hotkey.

% 
Per motivi di convenienza in 
questo capitolo TRAKTOR 

PRO e TRAKTOR SCRATCH PRO sono 
entrambi racchiusi sotto il comune nome 
TRAKTOR.
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Global Section
La Global Section racchiude i seguenti pannelli: 

►► Master Volume: raggruppa le funzionalità dei precedenti Panel Details Master e Mode.

►► Master Clock: offre le funzionalità del precedente pannello Clock.

►► Audio Recorder: offre le funzionalità del precedente pannello Audio Recorder.

►► Effect Unit 1&2: offre funzionalità dei precedenti Details Panels Channel Effect e Master.

Advanced Section
La Advanced Section al di sotto di ciascun Deck racchiude i seguenti pannelli:

►► Move Panel: raggruppa le funzionalità dei precedenti Details Panels Jump, Loop Start, 
Loop End e Loop Move.

►► Cue Panel: raggruppa le funzionalità dei precedenti Details Panels Cue Edit, Cue List, 
Loop Set e Loop Slct.

►► Grid Panel: offre le funzionalità del precedente Detail Panel BPM.

Altri precedenti Details Panels
►► Page: due schede su ciascun lato della Global Section permettono di visualizzare o 

nascondere uno dei due pannelli di controllo disponibili.

►► Decks: Il nuovo TRAKTOR non utilizza il focus dei deck basato sul colore; l'assegnazione 
del Crossfader avviene direttamente nella sezione Crossfader.

►► Channel: le funzioni "Punch" e "Talk" sono state eliminate. Autogain è controllato in ma-
niera centralizzata in una opzione contenuta nelle preferenze, External Input può venire 
attivato tramite un pulsante di menu sottostante la lettera che contraddistingue il Deck.

►► File Info: è stato eliminato, dal momento che tutte le informazioni relative alla traccia 
sono indicate nei deck header ora di dimensioni maggiori.

►► Native Mix Recorder: questo formato di registrazione è stato eliminato nel nuovo 
TRAKTOR. Ulteriori dettagli nel capitolo 16.9 (Funzionalità di TRAKTOR 3 abbandonate)
Key: l'intonazione viene ora controllata direttamente dal mixer strip.

►► Tracking: i panneli di tracking vengono visualizzati nella waveform. 

►► Booh: l'uscita booth ed il controllo di volume sono stati eliminati.

% 
Le Effect Unit sono entità glo-
bali, ma possono essere atti-

vate individualmente per ciascun deck 
nella mixer strip di ciascun canale. 
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16.1.2	 Layout Manager
I LAYOUT DI TRAKTOR PRO sono organizzati centralmente dalle pagine di preferenze Layout. 
Da lì è possibile configurare il layout attualmente in uso ed inserirlo in una lista ordinata. E' 
possibile creare nuovi layout da un set di template predefiniti o come copie di layout esistenti.

I layout possono venire richiamati tramite assegnazioni MIDI o hotkey.

16.2	 Copertine

16.2.1	Importazione di Tag Standard
TRAKTOR PRO supporta le copertine. Le immagini contenute in tag metadata standard 
di ogni tipo supportato possono essere visualizzati in tre diverse posizioni dell'interfaccia: 
sotto il browser tree, come colonna della lista o negli header dei deck.

E' possibile aggiungere copertine in formato JPG a tutti i tipi di file supportati da TRAKTOR 
PRO, inoltre queste vengono salvate in tutti questi tipi di file.

16.2.2	Importazione JPG
L'artwork importato tramite importazione JPG viene ridimensionato a 200x200 pixel per 
assicurare tempi brevi in lettura. Per evitare di sovrascrivere le copertine generate da 
altre applicazioni, spesso molto più grandi, le copertine di TRAKTOR PRO sono visibili 
esclusivamente in TRAKTOR PRO e non riscritte nei tag standard delle tracce.

16.2.3	Crea Flick
L'ESCLUSIVA FUNZIONE DI CRATE FLICK DI TRAKTOR PRO permette la visualizzazione 
contemporanea di tutte le cover di una borsa dei dischi sotto forma di una unica lunga 
lista. Le copertine vengono copiate nella cache per garantirne lo scorrimento senza inter-
ruzioni anche per playlist molto grandi.

!
Il Layout Manager non è dis-
ponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

!
Il JPEG import non è disponibile 
in TRAKTOR LE.
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16.3	 Effetti

TRAKTOR PRO è fornito di molti nuovi esaltanti effetti. La potenza delle effect sec-
tion è stata aumentata in maniera massiccia ed allo stesso tempo semplificata. Questa  
operazione ha richiesto alcuni cambiamenti qui di seguito elencati.

16.3.1	Architettura Effetti
La Global Section ha due unità di effetti indipendenti che possono ospitare fino a 3 effetti 
in catena. Le Effect Unit vengono attivate individualmente nella mixer strip di ogni canale, 
ma condividono le stesse impostazioni per tutti i deck. E' possibile inserire ingressi ed 
uscite nei Deck o assegnarli ad uscite della scheda audio (Send Mode).

16.3.2	Filtri Aggiuntivi per Canale
TRAKTOR PRO offre un filtro individuale per ogni canale del mixer. Utilizzando questo 
filtro non occorre sacrificare una Effect Unit come in TRAKTOR 3. 

16.3.3	Modalità Advanced Control e Chained
E' possibile utilizzare le Effect Unit in modalità di controllo Advanced o Chained.

Advanced Control Mode
L'Advanced Control Mode ti dà accesso a tutti i parametri disponibili per l'effetto in ques-
tione. Dopo aver regolato l'effetto, è possibile salvare le impostazioni come nuovo default.

In Advanced Control Mode è possibile ottenere molto di più da un effetto che in modalità 
Chained Control.

Chained Control Mode
Il Chained Control Mode dà accesso a fino a 3 effetti in catena per ciascuna Unit. I controlli 
sono limitati ad un tasto ed un knob per effetto, più un controllo On e uno D/W globali.

Tramite la modalità Chained Control puoi assemblare interessanti livelli di effetti.

!
L'Advanced Control Mode non è 
disponibile in TRAKTOR DUO e 

	 TRAKTOR LE.

% 
Abilitando entrambe le Effect 
Unit su di un unico canale le 

due le Unità operano in catena. Se cias-
cuna Unit viene utilizzata in Chained 
Mode è possibile avere fino a 6 effetti 
più il channel filter per ogni canale!

!
Solo un effetto per effect unit in 
modalità chained è disponibile  

	 su TRAKTOR LE.
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Send Mode
E' anche possibile utilizzare indipendentemente ogni Effect Unit in modalità Insert o Send. 

In modalità Insert l'effetto è inserito nella catena del segnale di ciascun Deck di TRAKTOR, 
in Send Mode la Unit è direttamente alimentata da un ingresso della scheda audio ed invia 
il suo segnale direttamente da una uscita della scheda audio.

Questo garantisce un pieno controllo dell'Effect Unit tramite controlli di FX Send e FX 
Return del DJ Mixer Esterno pur mantenendo gli effetti in perfetto sync alle tracce ri-
prodotte da TRAKTOR.

16.3.4	Pre Selezione Effetti
La pagina Effects Preferences ti permette di scegliere e riordinare gli effetti che intendi 
utilizzare durante la performance. E' possibile attivare direttamente gli effetti pre selezionati 
tramite pulsanti MIDI o hotkeys. Ad installazione avvenuta, nella lista sono presenti tutti 
gli effetti Una volta trovati i tuoi effetti preferiti, è possibile rimuovere quelli inutilizzati 
dalla lista degli effetti pre selezionati.

16.3.5	Nuovi Effetti
TRAKTOR PRO è fornito di una serie di nuovi effetti orientati alla performance dal vivo 
descritti dettagliatamente nella sezione 15.5.

16.3.6	Modulazione Pulse
►► TRAKTOR PRO offre un nuovo ed innovativo tipo di modulazione per Filtri, Flanger e 

Phaser chiamato "Pulse". In questa modalità la modulazione viene controllata dai  
picchi del materiale audio stesso, producendo così suoni che si legano tra loro in  
maniera interessante.
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16.3.7	Comparazione con TRAKTOR 3

Successori di effetti di TRAKTOR 3
Gli effetti di TRAKTOR 3 sono stati adattati al nuovo contesto e rivisitati per migliorarne 
il suono e l'usabilità.

►► Flanger 		  > 	 Flanger, Flanger Flux & Flanger Pulse

►► Reverb 		  > 	 Reverb & Iceverb

►► Delay		  >	 Delay

►► Beatmasher 		  > 	 Beatmasher

►► XONE:92 Filters 	 > 	 Filter:92, Filter:92 LFO & Filter:92 Pulse

►► T2 Filters 		  > 	 Filter, Filter LFO & Filter Pulse

Cosa è possibile fare con TRAKTOR PRO che non poteva essere compiuto in TRAKTOR 3.
►► E' possibile mettere in catena fino a 3 effetti per Unit.

►► E' possibile utilizzare filtri passa bassi e passa alti aggiuntivi presenti in ciascuna 
mixer strip sopra gli altri effetti.

►► Le impostazioni correnti degli effetti possono venire salvate come nuovo default.

►► La pre-selezione degli effetti ti permette di riordinare e nascondere quelli inutilizzati.

►► L'attivazione di entrambe le Unit sullo stesso Deck permette al segnale di passare  
attraverso entrambe le Effect Unit.

Cosa si può fare in maniera diversa in TRAKTOR PRO
►► Per due effetti individuali del deck, attiva la Unit 1 per il deck A e la Unit 2 per il B.

►► Per un effetto sul master , attiva la Unit su entrambi i Deck.
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Cosa non è possibile fare con TRAKTOR PRO che poteva essere compiuto in TRAKTOR 3.
►► 3 o 4 deck - 3 o 4 effetti del deck (non filter)* indipendenti.

►► 2 deck - 2 effetti del deck indipendenti (non filter)* + 1 effetto indipendente sul master.

* I filtri sono ora disponibili in maniera indipendente su ogni canale.

16.4	 Browser

16.4.1	Playlist Attuale
La Current Playlist fissa di TRAKTOR 3 è stata sostituita con una dal concetto più flessibile, 
permettendo ad ogni playlist di venire utilizzata come Current Playlist. Questo cambiamento 
comporta una serie di conseguenze descritte qui di seguito.

Tracce suonate di recente.
Nonappena carichi una traccia in un deck essa compare nella History Playlist - La History 
è provvista di qualche colonna in più di una normale Playlist per contenere informazioni 
su quando e come queste tracce sono state eseguite.

►► Start Time: indica quando la traccia è stata eseguita.

►► Duration: mostra per quanto a lungo la traccia è stata suonata.

►► Deck: mostra su quale Deck la traccia è stata suonata.

Ad installazione avvenuta, la History viene assegnata alla seconda posizione delle  
Favorite Playlist.

Mettere in coda i brani.
In TRAKTOR 3 la Current Playlist poteva venire anche utilizzata per mettere in coda brani che 
dovevano venire suonati in seguito. Per fare ciò in TRAKTOR PRO puoi utilizzare una playlist 
qualsiasi. Di default uno dei Favorites è nominato Preparation e serve a questo scopo. Se trovi 
una traccia che desideri suonare in seguito, trascinala sulla playlist nominata Preparation.
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Autoplay
Autoplay si chiama ora "Cruise" e funzionerà da ogni tipo di playlist. La traccia da caricare 
successivamente viene presa dalla stessa playlist della traccia caricata per ultima.

16.4.2	Collection, Tags e Playlist
Tutti i tags inseriti in TRAKTOR PRO comprese copertine, Stripe, BPM, Cue Point e Loops 
vengono scritti istantaneamente in tutti i file supportati, compresi WAV ed AIFF. Pertanto 
la Collection di TRAKTOR PRO duplica solo le informazioni contenute nella traccia per 
ricerche più veloci, ma se smarrita, è sempre possibile generare nuovamente l'informazione 
dai tag delle tracce.

La funzione principale della Collection è quella di contenere le tue playlist. In TRAKTOR PRO 
le playlist non sono più salvate come file individuali. Questo comporta i seguenti vantaggi:

►► Tutte le playlist impiegano sempre i tag più recenti.

►► Le Playlist possono essere create e spostate all'interno di una struttura di cartelle 
virtuali.

►► Il ritrovamento delle tracce aggiorna tutte le copie presenti in ciascuna playlist.

►► La rimozione delle tracce dalla Collection comporta la rispettiva eliminazione dalle 
playlist.

L'aspetto negativo di questo concetto è che le playlist non vengono salvate di default come 
file individuali. Mentre tutti i metadata sono archiviati al sicuro all'interno delle tracce 
e possono essere ripristinati anche in seguito all'eliminazione o alla corruzione del file  
collection.nml, le playlist potrebbero andare perdute.

Per questo motivo è molto importante effettuare backup del tuo file collection.nml in  
aggiunta al backup generato automaticamente.
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16.4.3	Gestione Playlist

Creazione ed organizzazione.
In TRAKTOR PRO è possibile gestire le playlist in maniera più intuitiva di quanto fosse 
precedentemente possibile. Il trascinamento di una selezione di tracce dalla list window 
sull'icona della playlist genera una nuova playlist. E' possibile creare una struttura di  
cartelle all'interno del gruppo delle playlist ed organizzarla tramite drag&drop.

Navigazione ed Organizzazione.
Il flusso di lavoro è stato migliorato grazie alla possibilità di richiamare le tracce  
selezionate, l'ordine e la posizione di scorrimento individualmente per ciascuna playlist.

Il modo di organizzazione interno della Playlist è stato rielaborato ed il concetto di Locked 
Playlist abbandonato. Una playlist in TRAKTOR PRO è fornita di un ordine intrinseco che 
non viene perduto quando la playlist viene riordinata in base ad una delle intestazioni delle 
colonne. L'ordine originario può sempre essere ripristinato cliccando la colonna “#”. 

Ci sono solamente due modi di cambiare in modo permanente l'ordine di una playlist di 
TRAKTOR PRO.

►► Premendo il tasto "Consolidate", che rende permanente l'ordine ora visualizzato

►► Riorganizzando manualmente i brani all'interno della playlist tramite drag&drop. Questa 
operazione è permessa solamente se la playlist è stata prima riportata al suo ordine 
originario cliccando #-header o se è stata consolidata.

Questo comportamento è anche il modo utilizzato da iTunes per gestire l'ordine della 
Playlist, con la potente aggiunta dalla funzione Consolidate non disponibile su iTunes. 
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Ricerca Incrementale
Il motore di ricerca di TRAKTOR è passato dalla funzione di generazione di una nuova 
playlist speciale chiamata Search Results ad una di filtraggio dei brani della Collection.

Inoltre il filtro viene applicato in seguito all'inserimento di ogni carattere digitato  
cosicché i risultati di una ricerca appaiono in maniera progressiva a mano a mano che il testo  
viene inserito.

La stringa di ricerca viene conservata individualmente per ogni playlist. Una playlist  
filtrata dalla stringa "xyz" rimane filtrata in quel modo fino a che la stringa di ricerca venga  
appositamente cancellata.

Il Delete Button vicino alla stringa di ricerca permette di rimuovere in un colpo solo il 
filtro attuale.

16.4.4	Salvare e Caricare Impostazioni di TRAKTOR
TRAKTOR PRO è provvisto di una potente estensione del file Traktor Settings. Il nuovo 
file Settings ora include anche il precedente file .tks contenente Hotkey e assegnazioni 
MIDI. Questa funzionalità estesa è espressa dalla nuova estensione di file .tsi che sta per 
"Traktor Settings Information". 

Ora è possibile importare ed esportare i file *.tsi dalle preferenze. Le funzioni Import ed 
Export offrono un sistema di filtraggio per trasferire selettivamente solo una parte delle 
impostazioni. Questo permette di utilizzare i file settings per salvare un profilo contenente 
i layout preferiti, assegnazioni dei controlli e posizioni di default. Le opzioni di filtraggio 
disponibili sono:

►► Hotkey Settings

►► MIDI Mapping

►► GUI Layout

►► File Load and Write Paths

►► Broadcasting

►► Audio, MIDI Devices and OSC Settings

►► Effect Settings

►► All Other Preferences Settings

!
Salvare e caricare settings di 
TRAKTOR non è possibile in 

	 TRAKTOR LE.



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 192  

16.4.5	Nome e Destinazione della Root Directory Differente
Per permettere a TRAKTOR PRO di essere completamente funzionale con un file di Settings 
salvato su di un HD portatile, è necessario operare un paio di cambiamenti della posizione 
del root folder.

Di default tutti i file utilizzati da TRAKTOR PRO vengono ora salvati in una nuova posizione:

►► utente\Documenti\Native Instruments\Traktor (PC)

►► ~/Native Instruments/Traktor (MAC)

La root folder contiene i seguenti file:

►► collection.nml

►► Traktor Settings.tsi

►► Traktor.log

E le seguenti cartelle:

►► Backups

►► Coverart

►► History

►► Stripes

►► Transients

L'unica cartella salvata altrove è solamente la cartella Recordings. Essa si trova in:

►► Musica\Traktor (PC)

►► ~/Musica/Traktor (Mac)

E' possibile personalizzare il percorso della root folder nelle Preferences per salvare tutti i 
dati rilevanti di Traktor su di un supporto di archiviazione dati portatile. Momentaneamente 
TRAKTOR PRO richiede un riavvio in seguito alla modifica del percorso della root folder.
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16.5	 Transport

16.5.1	Looping
La funzione di Looping è stata totalmente rielaborata per migliorarne il funzionamento. 
Looping manuale ed automatico sono ora distinti e controllati da appositi pulsanti.

Manual Looping
Il looping manuale viene operato da due appositi pulsanti nominati In ed Out..

Atomatic Looping
Il looping automatico viene operato tramite il nuovo Loop Size Control che offre numer-
ose dimensioni di loop allo stesso tempo. E' possibile impostare i Loop istantaneamente  
cliccando sui pulsanti numerati, cambiarne le dimensioni cliccando su di un altro pulsante 
e rilasciarli cliccando sullo stesso pulsante ancora una volta.

Editing Avanzato del Loop
Oltre a questo editing di base, il Move Panel avanzato provvede tutte le restanti funzioni 
per modificare la posizione e le dimensioni del loop. Le modalità disponibili sono:

►► Beat Jump

►► Loop Move

►► Loop-In Move

►► Loop-Out Move
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16.5.2	Cue Point e Loop Management
TRAKTOR PRO cambia il modo di lavorare con i Cue Point ed i Loop salvati.

Unificazione di Loop e Cue Point
In TRAKTOR PRO i Cue Point ed i Loop sono gestiti all'interno della stessa lista. I Cue 
Point vengono considerati come Loop di lunghezza pari a zero. Questo permette di gestire 
i Cue Point ed i Loop nella stessa lista e con gli stessi controlli. Il pannello dedicato a 
queste funzioni è il pannello avanzato Cue.

TRAKTOR PRO semplifica il modo di gestire i Loop effettuando un spostamento su di un 
Loop o Cue Point nonappena li si seleziona. In questo modo puoi modificare il loop at-
tuale senza bisogno di una rappresentazione alternativa per differenziare il loop selezionato  
e quello corrente.

Salvare Cue Point e Loop. 
TRAKTOR PRO è in grado di salvare fino a 32 Cue Point o Loop per singola traccia. E' 
possibile gestirli dal pannello avanzato Cue. E' possibile navigare in ordine cronologico la 
lista dei 32 cue point e loop tramite i pulsanti next e previous adiacenti al text display.

Il Cue Point attuale viene salvato premendo il pulsante Store nel pannello Cue. Dopo aver 
salvato il Cue Point, la sua posizione, il nome ed il tipo, esso viene visualizzato ed è pos-
sibile modificarlo da lì.

Per eliminare un Cue Point, premi il Delete Button dopo averlo selezionato tramite pulsanti 
back e forward.

Per salvare un Loop, premi Store mentre il Loop è attivo. E' possibile eliminare dalla lista 
un Loop spostandosi su di esso e premendo il Delete Button.

!
Cue Point e Loop Management 
non sono disponibili  in  

	 TRAKTOR LE.
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Hot Cue Buttons
TRAKTOR PRO è dotato di 8 Cue Buttons numerati da 1 a 8. Questi Panels, diversamente 
da TRAKTOR 3, non sono legati alla posizione del cue point all'interno della traccia. Un 
Cue Point assegnato a Hoc Cue 1 rimarrà sempre assegnato ad esso anche se verrà salvato 
un Cue Point in un punto precedente della traccia.

Mappare Cue Point a pulsanti Hot Cue è un'operazione molto intuitiva - seleziona il Cue Point 
che desideri mappare, premi il pulsante Map e poi il pulsante al quale lo vuoi assegnare.

Navigazione Quantizzata
Una nuova modalità di navigazione viene introdotta in TRAKTOR PRO chiamata Quant. 
In questa modalità la maggior parte delle operazioni viene eseguita in maniera accurata 
sui beat così da poterli utilizzare per remixare una traccia in tempo reale.

Quantized Mode influenza solamente spostamenti durante il playback:

►► Spostamenti sui Cue Point assegnati agli Hot Cue Button.

►► Spostamenti su cue point e loop tramite click sullo Stripe display.

16.5.3	Sincronizzazione

Riferimento del Sync
TRAKTOR 3 utilizzava come riferimento il deck opposto orizzontalmente quando 
Sync veniva premuto. La sincronizzazione verticale o diagonale richiedeva l'utilizzo della 
funzione Master. TRAKTOR PRO abbandona questo approccio e utilizza sempre il Master 
Clock come riferimento del Sync.

Questa implica che il Master Clock sia sempre in sync con la traccia principale corrente. 
Si può ottenere questo lasciando che il Master Clock segua automaticamente il tempo 
del deck che momentaneamente presenta lo stato di Master Deck. Per abilitare questa  
modalità, accertati che il tasto Auto sia attivato nel Master Clock Panel (clicca sul 
metronomo sul bordo sinistro della Global Section).
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Il deck che è in esecuzione per il lasso di tempo più lungo sena interruzioni riceve lo stato 
di Master. E' possibile cambiare lo stato di master dei deck in ogni momento cliccando 
sul tasto Master di un altro deck. 

Cliccando sul pulsante Sync del Master Deck attuale, viene scelto come Master Deck 
il prossimo candidato migliore.

Sync degli Effetti
Gli effetti di TRAKTOR PRO utilizzano sempre il Master Clock come riferimento temporale. 
Questo unico riferimento temporale per tutti gli effetti rende possibile l'utilizzo di un'effetto 
su tutti i deck allo stesso tempo ed anche di utilizzarli come effetto master in modalità 
mixer esterno, cosa che non era possibile con TRAKTOR 3.

16.6	 Beat Matching

TRAKTOR PRO compie grandi passi in avanti nel fare corrispondere automaticamente i 
beat di due tracce. La base per questo beat matching automatico è il corretto rilevamento 
dei beat presenti nella musica.

16.6.1	Automatic Beat Grids
Importando una nuova traccia in TRAKTOR PRO vengono attivate di default le seguenti 
funzioni:

Analisi
Il materiale audio viene caricato e scannerizzato per dare vita ai seguenti risultati:

►► Stripe: rappresentazione visiva della intera traccia.

►► Auto Gain: impostazioni di gain ottimali per controllare la funzione di Auto Gain.

►► Transients: una lista che rappresenta i beat rilevati e la loro esatta posizione 
all'interno della traccia. Questa lista è necessaria per un corretto rilevamento dei 
beat e viene copiata nella cache all'interno di una sottocartella della root direc-
tory nominata "Transients".
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Le Preferenze offrono 2 opzioni per avviare l'Analysis: importando una traccia, o alternati-
vamente quando la si carica in un Deck. Nelle tracce non analizzate non è visibile alcuna 
Stripe (track overview) al momento del caricamento nel deck.

Rilevamento BPM
Il rilevamento dei BPM viene sempre eseguito quando si analizza una traccia. Il valore di 
BPM indicato al caricamento di una traccia non ancora analizzata viene calcolato sulla 
parte della traccia attualmente riprodotta, ed è meno preciso del rilevamento dei BPM che 
avviene durante l'analisi. 

E' possibile migliorare i risultati del rilevamento automatico dei BPM regolando il "Auto BPM 
Range" al rispettivo genere delle tracce. Valori di BPM fuori da quel range non vengono 
considerati ed invece verrà selezionato il valore più vicino all'interno del range selezionato.

Posizionamento automatico sulla Grid.
In TRAKTOR 3 era necessario impostare manualmente la posizione del Grid Marker. 
TRAKTOR PRO ora lo fa automaticamente. Il Grid Marker automatico viene posizionato 
all'inizio della traccia, e non necessariamente su un beat bensì allineato alla Beat Grid che 
corrisponde in maniera migliore ai beat rilevati per la traccia in questione. 

E' possibile disattivare questa operazione all'interno delle Preferences in "Auto BPM". Ha 
senso utilizzare BPM senza di un Grid Marker per tracce che hanno un tempo fluttuante.

Regolazione della Grid.
E' possibile testare e regolare la Beat Grid generata automaticamente nello stesso modo 
dei Beat Grid creati manualmente. Il metodo più rapido è quello di attivare il Beat Tick 
nel Master Panel e il pulsante Headphone Cue nel canale del mixer. Questa operazione 
introduce un tick udibile per ogni linea della griglia. Se i tick corrispondono ai beat della 
traccia, la griglia è impostata in maniera corretta.
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Qualità di BPM e BPM Locking.
TRAKTOR PRO non mostra la qualità dei BPM rilevati come in TRAKTOR 3. il pannello Grid 
Editing è provvisto di un Lock Button per proteggere una Beat Grid creata manualmente 
da una eventuale sovrascrittura.

Importare le Beat Grid da TRAKTOR 3
BPM e Beat Grid di TRAKTOR 3 vengono importate in TRAKTOR PRO effettuando il Lock 
di tutte le tracce che presentano una qualità di BPM del 100%. In TRAKTOR 3 una qualità 
di 100% preveniva il valore di BPM da eventuali modifiche dettate dal rilevamento, e per 
questo motivo vengono impostate su Lock in TRAKTOR PRO.

16.6.2	Sincronizzazione Permanente
La funzione Sync di TRAKTOR PRO è di default impostata su On. Per simulare il 
comportamento di sincronizzazione momentanea di TRAKTOR 3 è necessario premere 
due volte il pulsante Sync.

16.7	 Control

16.7.1	 Pagine MIDI diventano Modificatori MIDIT
RAKTOR PRO estende il concetto di TRAKTOR 3 RELATIVO alle pagine MIDI grazie 
all'introduzione di 8 modificatori MIDI programmabili.

Mentre una pagina MIDI offre ulteriori livelli di assegnazioni per tutti i controlli definiti 
su ogni pagina, i MIDI Modifiers vengono assegnati individualmente a ciascun controllo. 
Questa funzione offre maggiore flessibilità e riduce il carico di lavoro perchè non è neces-
sario duplicare i controlli non modificati come lo era quando si lavorava con le pagine MIDI.

Ogni assegnazione di Controller può inoltre definire due Modifier con un valore per ognuno di 
essi. Il comando viene eseguito solamente quando i Modifier presentano il valore predefinito.

E' possibile assegnare via MIDI i Controller stessi come fossero normali funzioni. 

!
Questa funzione non è disponi-
bile in TRAKTOR LE.
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16.7.2	Direct Mode dei Range Controller (TRAKTOR PRO)  

Esempio:
La lista di effetti preselezionati "Effect Select" è un esempio di Range Controller. Se si as-
segna tramite Learn l'"Effect Select" ad un pulsante e si seleziona il Control Type "Direct", 
il campo "Set to Value" indicherà tutti i valori della lista possibili. Scegliendone uno, il 
pulsante seleziona direttamente l'effetto ogni volta che viene premuto.

MIDI Out per tutti i parametri.
La funzionalità di MIDI Out è stata estesa a tutti i controller disponibili in TRAKTOR PRO. 
Sono anche disponibili Output MIDI per alcuni parametri che sono delle pure uscite, come 
il Deck Phase Meter, i Deck Level Meters e il Track End Warning time. 

16.7.3	Modalità CD
Il veterano CD Mode di TRAKTOR 3 è stato leggermente cambiato per una migliore usabilità 
in combinazione con i Controller MIDI. CD Mode ora agisce su tutte le funzioni di playback. 
Impostando TRAKTOR PRO su CD Mode, i tasti Play e Cue si comportano esattamente 
come su di un CDJ: arrestando il playback verrà eseguito un breve stutter loop finché non 
verrà premuto Cue per impostare un nuovo Cue Point.

E' possibile aggiustare la posizione dello stutter loop trascinando col mouse il Phase Meter 
o la Waveform o utilizzando la funzione Beat Jump in modalità Ultra Fine.

16.7.4	 JOG Control Type
Un nuovo Control Type è stato implementato per controllare funzioni incrementali come il 
Bend del tempo tramite encoder a corsa infinita. 

Prima d'ora assegnare il Pitch Bend ad un encoder a corsa infinita non era funzionale perchè 
l'encoder non invia un messaggio di "Pitch Bend Off" alla fine. Questa mancanza è stata 
risolta tramite il nuovo JOG Control Type per encoder a corsa infinita. Questo tipo di controllo 
invia un messaggio di "Reset" una volta che non vengono più ricevuti dati dal controller.

!
La modalità Direct Mode dei 
Range Controllers non è dis-

ponibile in TRAKTOR LE.

!
Il CD Mode non è disponibile in 
TRAKTOR DUO e TRAKTOR LE.

!
Il JOG Control Type non è dis-
ponibile in TRAKTOR LE.
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16.7.5	 Controllo Timecode ed Ingresso Esterno
In TRAKTOR PRO sono aumentate le dimensioni dei timecode Panels e li si è spostati nei 
Deck. La calibrazione viene ora effettuata tramite un pulsante dedicato nel pannello e non 
è combinata con l'assegnazione al deck come lo era in TRAKTOR 3.

Sia il Timecode Control che l'External Input Mode di un deck sono situati in un menu a 
pulsanti, accessibile tramite la freccia al di sotto della lettera del Deck.

I Timecode Panel stessi vengono aperti dal Layout Manager. Gli Input di Timecode fisici 
associati al Deck vengono selezionati dalla pagina Tracking Preferences.

16.8	 Ulteriori Funzionalità

16.8.1	Altezza della linea del Browser Ridimensionabile
E' possibile personalizzare manualmente l'altezza delle linee e le dimensioni dei caratteri 
del browser. Questo serve per visualizzare una porzione maggiore (o minore) delle copertine 
nella modalità visiva Flick View.

16.8.2	Setup Wizard
Avviando per la prima volta l'applicazione, un Wizard guiderà l'utente attraverso una serie 
di fondamentali scelte di configurazione. Tecnicamente l'installer fornisce una serie di file 
di settings di default dai quali il Wizard seleziona i più appropriati.

!
Il Timecode Control ed External 
Input non sono disponibili in  

	 TRAKTOR LE.
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16.9	 Funzionalità di TRAKTOR 3 abbandonate

16.9.1	Registratore MIX Nativo
Il Native Mix Recorder è stato eliminato in questa release. La registrazione del Mix è 
una funzione legata piuttosto ad una funzione studio/principianti che sarà ripresa  
successivamente - ma con una serie di caratteristiche più consistente ed altamente usabile.

16.9.2	Shop Beatport Integrato
La funzionalità del Beatport Shop integrato è stata del tutto abbandonata.

NI e Beatport inizieranno a fornire tag di metadata di Traktor come parte integrante di ogni 
traccia acquistata con il lancio di Traktor Pro. Un download manager lanciato di recente su 
beatport.com copre le funzionalità dello shop integrato. Entrambi i partner di conseguenza 
concentreranno i loro sforzi nel fornire una quantità superiore di contenuto di  matadata 
ai loro utenti anzichè mantenere una seconda vetrina all'interno di TRAKTOR. 

16.9.3	Funzione Indietro del Browser
La funzione Browse Back del browser è stata eliminata. TRAKTOR PRO richiama la 
selezione e la stringa di ricerca in maniera individuale per ogni playlist ed offre un pulsante 
dedicato per tornare indietro alla playlist contenente l'ultima traccia caricata.

16.9.4	Punch, Talk, Booth
Questo gruppo di funzioni che emulava azioni dei classici mixer è stata eliminata per via 
del suo scarso successo e per motivi sempificativi.
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17	 Risoluzione Problemi
Questo capitolo fornisce aiuto per risolvere i problemi più comuni che si verificano  
raramente durante i primi passi con TRAKTOR.

17.1	 TRAKTOR non si avvia

►► Controlla i requisiti di sistema di TRAKTOR. I requisiti di sistema minimi sono 
davvero il minimo col quale te la puoi cavare, e spesso non abbastanza per un  
utilizzo avanzato (per es. Key Lock ed Effetti). Aggiornare la tua configurazione RAM 
potrebbe salvarti un sacco di problemi.

►► Assicurati di essere in possesso dell'ultima versione di TRAKTOR disponibile.

►► Assicurati di non aver cliccato un collegamento ad una applicazione precedente.

►► Prova a riavviare il tuo computer. Scollega tutti i dispositivi audio e periferiche come 
stampanti, scanner e simili.

►► Prova a rinominare il file collection.nml nel Root Folder per riavviare TRAKTOR con 
una Collection nuova e poi re-importa la Collection rinominata.

17.2	 Le tracce vengono caricate ma non suonano!

Se le Waveform non si muovono nonostante tu abbia premuto Play, probabilmente 
c'è qualcosa che non va con il tuo Audio Setup.

Controlla quale sia la Selected Audio Device in TRAKTOR.
►► Apri TRAKTOR e vai su Preferences > Audio Setup > Audio Setup.

►► Assicurati di avere selezionato la scheda audio corretta. La lista a scorrimento Audio 
Device indica tutte le schede audio installate sul tuo computer.
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►► Se la tua scheda audio non compare all'interno della lista, è probabile che non sia 
installata o collegata in maniera corretta. Verifica i collegamenti meccanici e  
controlla la corretta installazione della scheda audio come descritto in seguito.

►► Potrebbe essere necessario deselezionare e selezionare nuovamente la tua scheda audio.

►► Se ciò non funziona, prova a selezionare la tua scheda audio, conferma con OK, chiudi 
e riavvia TRAKTOR.

Controlla l'Output Routing di TRAKTOR.
Potresti aver scelto la scheda audio giusta ma senza aver assegnato alcuna uscita.

►► Apri in TRAKTOR Preferences > Audio Setup > Output Routing.

►► Assicurati di aver selezionato il Mixing Mode adatto. Internal mixerà il segnale 
internamente e invierà in uscita il mix dal Master output ed il segnale di pre ascolto 
al Monitor output. External invierà individualmente ognuno dei deck su di un canale 
separato, per mixare con un mixer esterno. 

►► Verifica che la sezione dedicata a Monitor e Master (o Deck A and B in External Mixer 
Mode) indichi delle uscite valide della scheda audio collegata.

►► Potrebbe essere necessario deselezionare e selezionare nuovamente le uscite per re-
inizializzare l'assegnazione.

►► Se ciò non funziona, prova a selezionare la tua scheda audio, conferma con OK,  
chiudi e riavvia TRAKTOR.

Controlla l'Audio Control Panel in Windows
Per assicurarti della corretta installazione della tua scheda audio su di un computer 
Windows fai come segue:

►► Apri Avvio > Pannello di Controllo > Suoni e dispositivi audio > Audio”.

►► Su "Sound Playback > Default Device”, scorri la lista e assicurati che la tua scheda 
audio sia visibile all'interno della lista. Se così non fosse, potrebbe essere necessario 
installare nuovamente i driver per la tua scheda audio.
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Controllo della configurazione Audio/MIDI su Mac OS X
►► Per assicurarti della corretta installazione della tua scheda audio su di un Mac fai 

come segue:

►► Apri Macintosh HD > Applicazioni > Utility > Configurazione Audio Midi ” e clicca 
sulla scheda "Dispositivi Audio".

►► Come "Default Input", seleziona il menu a scorrimento ed assicurati che la tua scheda 
audio sia visibile all'interno della lista. Se così non fosse, potrebbe essere necessario 
installare nuovamente i driver per la tua scheda audio.

17.3	 Risoluzione Problemi TRAKTOR SCRATCH PRO

Se TRAKTOR SCRATCH PRO è installato correttamente, ma il Timecode non funziona, 
controlla le seguenti cose:

Hardware
►► I LED in ingresso di AUDIO 8 DJ lampeggiano quando suoni un disco contenente 

Timecode?

►► Se così non fosse, fai quanto segue per identificare la cause del problema.

►► Verifica che Audio 8 DJ sia collegata al tuo computer. 

►► Imposta il canale del mixer utilizzato per l'ingresso del Timecode su Phono per mon-
itorare il segnale che viene dal giradischi. Sei in grado di sentire rumore di Timecode?

►► Controlla nuovamente tutti i cavi e collegamenti compresi i cavi USB.

►► Prova a collegare un giradischi e a suonare un disco contenente il Timecode diretta-
mente in un ingresso della scheda audio escludendo il cavo Multicore.

►► Cambia l'Input Mode di Audio 8 DJ per inizializzare nuovamente il modo operativo.

►► Scollega e ricollega Audio 8 DJ per prevenire uno stato errato del dispositivo audio.

►► Prova ad utilizzare un hub USB 2.0 provvisto di alimentazione per escludere porte 
USB con alimentazione insufficiente sul tuo computer.

! 
Non puoi utilizzare porte USB 
1.0 o 1.1 con AUDIO 8 DJ.
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Routing e Driver
Vai su Preferenze > Audio Setup > Input Routing e verifica le assegnazioni degli ingressi 
dell'interfaccia ai canali in ingresso di TRAKTOR.

I LED meter dovrebbero ora indicare attività se su di un giradischi sta suonando un  
disco Timecode.

Se così non fosse, fai quanto segue per identificare la causa del problema.

►► AUDIO 8 DJ (o il tuo mixer supportato) è selezionato come scheda audio in Preferences 
> Audio Setup >Audio Setup?

►► Controlla il numero della versione di TRAKTOR SCRATCH PRO e del driver di AUDIO 
8 DJ ed accertati di stare utilizzando l'ultima versione disponibile.

►► Il driver del dispositivo audio è installato in maniera corretta? Ne non ne sei sicuro, 
installalo nuovamente. 

►► Chiudi TRAKTOR, scollega e collega nuovamente Audio 8 DJ e riavvia TRAKTOR per 
escludere un cattivo stato del dispositivo audio in connessione col software.

Assegnazione e calibrazione.
Controlla i cerchi di calibrazione presenti in ciascun deck nella Scope View. Lo scope deve 
assomigliare all'immagine che sta al suo fianco. 

Se gli scope dei deck non sono attualmente assegnati ai giradischi in uso fai come segue:

►► Scratch Control è attivato per tutti i Decks che devono venire controllati via Timecode? 
Clicca sulla piccola freccia al di sotto della lettera del Deck e seleziona questa opzione.

►► Controlla l'assegnazione del deck in Preferences Timecode Setup. Ogni Timecode Input 
dovrebbe venire assegnato ad un Deck.

►► Effettua nuovamente la calibrazione deselezionando e selezionando un'altra volta il 
tasto On negli Scratch Panels.
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17.4	 Crash di TRAKTOR

In caso si verifichi un crash durante l'esecuzione, sei pregato di contattare il team del 
NATIVE INSTRUMENTS Technical Support e di inviare loro il tuo crashlog. Puoi trovare il 
tuo crashlog nelle seguenti cartelle:

►► PC: \ Documenti\Native Instruments\Traktor\Crashlogs\

►► Mac: ~/Library/Logs/CrashReporter/
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18	 Ottenere Aiuto
Questo capitolo contiene collegamenti ad ulteriori risorse di supporto ed informazione.

18.1	 Documentazione Aggiuntiva

Per saperne di più riguardo a recenti cambiamenti ed aggiunte, sei pregato di consultare 
il file "Readme.txt" situato nella cartella di installazione di TRAKTOR.

18.2	 Aggiornamenti Software

TRAKTOR è costantemente in via di miglioramento. Sei pregato di accertarti di stare 
sempre utilizzando la versione più recente di TRAKTOR.. Dopo aver creato un Account 
Utente NATIVE INSTRUMENTS ed aver attivato Traktor, puoi comodamente scaricare nuovi 
aggiornamenti utilizzando l'applicazione di NATIVE INSTRUMENTS SERVICE CENTER. Per 
saperne di più su come scaricare aggiornamenti, sei pregato di fare riferimento alla Guida 
Rapida all'Avvio del SERVICE CENTER ed al manuale operativo del SERVICE CENTER.

18.3	 Supporto

Se si verificano problemi relativi al tuo prodotto NATIVE INSTRUMENTS che la 
documentazione fornita non è in grado di coprire, ci sono vari modi di ottenere aiuto:

Knowledge Base
Nel Knowledge Base puoi trovare risposte alle più comuni domande relative al supporto 
per tutti i prodotti NATIVE INSTRUMENTS:

www.native-instruments.com/knowledge

http://www.native-instruments.com/knowledge
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Supporto Tecnico
Puoi contattare il nostro Team di Technical Suppor tramite:

www.native-instruments.com/suppform

Team di Registration Support
Se si verificano problemi durante il procedimento di attivazione del prodotto sei pregato 
di contattare il nostro Registration Support Team:

www.native-instruments.com/regsuppfrm

User Forum
Nel NATIVE INSTRUMENTS User Forum puoi comunicare direttamente con altri utenti 
e con esperti di NATIVE INSTRUMENTS che moderano il forum:

www.native-instruments.com/forum/forumdisplay.php?f=105

Contatti
Per ulteriori informazioni su altri prodotti NATIVE INSTRUMENTS sei pregato di visitare 
la nostra homepage

www.native-instruments.com

http://www.native-instruments.com/suppform
http://www.native-instruments.com/regsuppfrm
http://www.native-instruments.com/forum/forumdisplay.php?f=105
http://www.native-instruments.com
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19	 Mappature Tastiera di Default
TRAKTOR viene installato con una varietà di assegnazioni per tastiera di default, trova nei 
prossimi capitoli le assegnazioni che sono caricate di default.

Clicca su Application Menu > Help > Downloads per aprire il sito dei Download di TRAKTOR 
sulla pagine del sito internet di NATIVE INSTRUMENTS. Qui puoi trovare ulteriori keyboard 
mappings, ed in più una grande varietà di MIDI mappings.

19.1	 Performance Layout di Traktor Pro

Trasporto

COMANDO DECK A DECK B

Play A Z

Cue S X

Beat Jump Indietro D / Avanti F Indietro C / Avanti V

Sync G B

Tempo Bend Indietro H / Avanti J Indietro N / Avanti M

Key Lock K ,
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Cue & Loop

COMANDO DECK A DECK B

Store (Salva) Cue Shift + 5 Shift + T

Hotcue 1 / 2 / 3 / 4 1 / 2 / 3 / 4 Q / W / E / R

Hotcue 5 / 6 / 7 / 8 Ctrl + 1 / 2 / 3 / 4 Ctrl + Q / W / E / R

Imposta un Loop di 
4 Beat

6 Y

Disattiva/Attiva Loop 7 U

Imposta Cue / Loop In 8 I

Imposta Loop Out 9 O

Lunghezza Loop dec. 0 / inc. P dec. ‘ / inc. è  

Sposta Loop
Shift Sinistra + dec. 0

Shift Destro 

Shift Sinistro + P

Shift Destro + è



TRAKTOR PRO / TRAKTOR SCRATCH PRO – 211  

Favourites & Navigazione

COMANDO GLOBAL

Seleziona Favourites 1 - 10 F1 - F10

Aggiungi Selezione ai 
Favourites 1 - 10

Shift + F1 - F10

Spostarsi attraverso i Favourites Freccia Sinistra / Freccia Destra

Scorri la Lista Freccia in Alto / Freccia in Basso

Cerca / Cancella Ricerca Ctrl (Cmd) + F

Spostati dalla Search a List Tab

Spostati sulla Traccia corrente. Shift + Enter

Carica nel Deck A Ctrl + Freccia Sinistra

Carica nel Deck B Ctrl + Freccia a Destra

Layout 

COMANDO GLOBAL

Seleziona Layout Prev. L / Next .

Dimensioni Deck Min. ò / Max -

Spostarsi attraverso i Favourites Freccia Sinistra / Freccia Destra

Scorri la Lista Freccia in Alto / Freccia in Basso

Cerca / Cancella Ricerca Ctrl (Cmd) + F

Spostati dalla Search a List Tab
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19.2	 Performance di Traktor Scratch Pro (aggiuntive)

Modalità di Scratch

COMANDO DECK A DECK B

Play / Internal Mode A Z

Absolute M S X

Relatie Mode Shift + S Shift + X

19.3	 Preparazione del Layout di Traktor (Scratch) Pro

Trasporto

COMANDO GLOBAL

Sposta il Focus 
sull'ultimo Deck.

Tab

Sposta il Focus 
sul prossimo Deck

Shift + Tab

Play A

Cue S

Cup Shift + A

Beat Jump Indietro D / Avanti F

Sync G

Tempo Bend Indietro H / Avanti J

Key Lock K
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Cue & Loops

COMANDO GLOBAL

Store (Salva) Cue Shift + 5

Elimina Cue Shift + Backspace

Hotcue 1 / 2 / 3 / 4 1 / 2 / 3 / 4

Hotcue 5 / 6 / 7 / 8 Q / W / E / R

Imposta un Loop di 4 Beat 6

Disattiva/Attiva Loop 7

Imposta Cue / Loop In 8

Imposta Loop Out 9

Lunghezza Loop Dec. 0 / Inc. ‘

Sposta Loop
Shift Sinistra + dec. 0

Shift Destro + ‘
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Modifica

COMANDO GLOBAL

Sposta Grid Marker Sinistra I / Destra O

Imposta BPM Dec. P / inc. { 

Auto Beatgrid B

Lock BPM Shift + L

Analizza Selezione Z

Modifica Selezione X

Riposizione Selezione C

Salva Collection Ctrl (Cmd)+ S

Aggiungi una List 
alla Collection

Ctrl (Cmd) + A

Favourites & Navigazione

COMANDO GLOBAL

Seleziona Favourites 1 - 10 F1 – F10

Aggiungi Selezione ai 
Favourites 1 - 10

Shift + F1 - F10

Spostarsi attraverso 
i Favourites

Freccia Sinistra / Freccia Destra

Scorri la Lista Freccia in Alto / Freccia in Basso

Cerca / Cancella Ricerca Ctrl (Cmd) + F

Spostati dalla Search a List Tab
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COMANDO GLOBAL

Spostati sulla Traccia 
corrente.

Shift + Enter

Carica nel Deck A Ctrl + Freccia Sinistra

Carica nel Deck B Ctrl + Freccia a Destra

Carica sul Deck in Focus Ctrl + Invio

Naviga nel Tree

In alto Shift + freccia in alto

In basso Shift + Freccia in Basso

Riduci Shift + Freccia a sinistra

Espandi Shift + Freccia a destra

Layout 

COMANDO GLOBAL

Seleziona Layout Prev. L / Next .

Dimensioni Deck Min. ò / Max. - (en) 

Spostarsi attraverso i 
Favourites

Freccia Sinistra / Freccia Destra

Scorri la Lista Freccia in Alto / Freccia in Basso

Cerca / Cancella Ricerca Ctrl (Cmd) + F

Spostati dalla Search a List Tab
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